
Professional Audio
Precision-engineered microphones and monitoring 
solutions to accurately capture and reproduce your audio.

The UTM-86 features an omnidirectional polar pattern and a frequency response 
optimized for voices and dialog. It can be used to deliver realistic and robust 
broadcast-quality sound for TV, live stage, theater, or any other applications where 
an inconspicuous lavalier microphone is needed.

SMH-1010CH/1020CH
Single- & Dual-Sided Professional Communication Headsets
SMH-1010CH single-sided and 1020CH dual-sided communication headsets are ideal for use with wired and 
wireless communications systems in TV or radio broadcast, communications systems, and sports applications.

SENAL UTM-86 Premium Lavalier Microphone

Professional Audio
Precision-engineered microphones and monitoring 
solutions to accurately capture and reproduce your audio.

SMH-1010CH/1020CH

Professional AudioProfessional AudioProfessional Audio
Precision-engineered microphones Precision-engineered microphones Precision-engineered microphones 
solutions to accurately solutions to accurately solutions to accurately 

SMH-1010CH single-sided and 1020CH dual-sided communication headsets are ideal for use with wired and 
wireless communications systems in TV or radio broadcast, communications systems, and sports applications.

 • CLEAR VOICE

• REPRODUCTION

• PRECISE POSITIONING

• NOISE REDUCTION

• COMFORT

• COMPATIBILITY

  •         DETACHABLE TWIST 

LOCKING CABLE DESIGN

• RUGGED DESIGN

 • COLLAPSIBLE

SMH-1010CH Single-Sided Headset ....................179.00

SMH-1020CH Dual-Sided Headset...................... 199.00

• Optimized for Speech
 The UTM-86 features an electret  
condenser element with a wide dynamic 
range, and a frequency response tailored 
to capture rich, low frequencies and a 
natural-sounding mid range.

• Low Noise
 The shielded cable protects against 

radio-frequency interference. Its insula-
tion and integrated strain relief minimize 
handling and cable noise.

• Miniature Size
  The small and unobtrusive capsule 
  with a head diameter of only 0.2" 

(5.5mm) makes these mics easy to  
conceal in costumes and props for  
onscreen and onstage use. 

• Included Accessories
  Includes a single tie clip, double tie clip, 

cable clip, magnetic clip with lanyard, 
viper clip, two foam windscreens, and a 
padded leatherette carry case.

Premium Lavalier Microphone

, double tie clip, 
cable clip, magnetic clip with lanyard, 
viper clip, two foam windscreens, and a 

SENAL UTM-86 Lavalier Microphone
UTM-86-HRS with 4-Pin Hirose Connector for Audio-Technica Wireless Transmitters . . . . . . $149.95

UTM-86-TA5 with TA5 Connector for Lectrosonics Wireless Transmitters . . . . . . . . . . . . . . . . . $149.95

UTM-86-35H with 3.5mm Connector for Sennheiser & Senal Wireless Transmitters  . . . . . . . $149.95

UTM-86-TA4 with TA4 Connector for Shure Wireless Transmitters. . . . . . . . . . . . . . . . . . . . . . . . $149.95

UTM-86-35N with 3.5mm Connector for Sony UWP Wireless Transmitters  . . . . . . . . . . . . . . . $149.95

Includes 

Padded

Carry Case

Single- & Dual-Sided Professional Communication Headsets
SMH-1010CH single-sided and 1020CH dual-sided communication headsets are ideal for use with wired and 
wireless communications systems in TV or radio broadcast, communications systems, and sports applications.

• COMPATIBILITY

DETACHABLE TWIST

LOCKING CABLE DESIGN

BROADCAST
& LOCATION

GAMING

STUDIO

Optional cables are available for use with many major wired and wireless 
systems, such as Telex and PortaCom. Headsets can also be used with 
broadcast consoles, mixers, and computers.

AUTO-MUTE
activates MUTE 
automatically

when mic is raised.
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TIPS FOR A KILLER VOCAL SOUND IN A HOME STUDIO

But let’s assume you’ve got a great talent 
in your midst. Heck, maybe it’s you—maybe 
you’re recording yourself, and you want the 
best sound you can get out of your home 
studio. Believe it or not, an expensive mic 
and a priceless preamp shouldn’t occupy 
the locus of your focus quite yet; plenty of 
great performances have been gleaned 
from a Shure SM58, which is about as wal-
let-friendly as a pro mic can get. 

First, work on the acoustics of your 
room. Most home studios are situated in 
a boxy room—and a boxy room exhibits all 
sorts of acoustical problems. From flut-
ter echo to unflattering room modes, the 
aspects of an untreated room can corrupt 
even the best mic chain. Comb filtering can 

seep into the vocal, canceling out vital mid-
range frequencies and emphasizing un-
flattering high-mids. Such an issue really 
narrows your options in the mix; distortion 
and complex reverberation can help bring 
some life to the sound, but these processes 
can signify genres that might not be in line 
with the mix itself.

No, better to fix the issue at the source.

Hearing this, you might think, “I’ll get 
myself one of those reflection filters I see 
in the trades!” or, “I’ll deaden up my room 
deader than a dead guy who’s dead.” 

Careful! Don’t go overboard! An over-
abundance of treatment can have a nega-
tive effect. Not all room absorbers are fash-

ioned out of the same material; say you put 
up 703 fiberglass panels all over your room. 
Depending on the density of these panels, 
some frequen-
cies would wind 
up more imped-
ed than others; 
some frequencies 
would be overly 
present in the re-
flections bounc-
ing back into the 
mic. The result? 
Not a flat sound, 
and definitely not 
an easy sound 
to work with in a 
mixing context. 

Tips for A Killer Vocal Sound in a Home Studio
by Nick Messitte

G etting a good vocal sound in your home studio is not a matter of snagging yourself a great mic and a fantastic mic chain. If 
it were that simple, more people of means would be securing killer sounds at home. There’s a lot more at play, starting, of 
course, with the vocalist. One hopes that the singer is, if not a dynamo, at least interesting. If things don’t work well at the 
cource, you’ve got little hope for a great sound down the road.
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On to reflection filters, which, though 
helpful in some circumstances, can only get 
you so far; they often expose the top of the 
capsule to your room reflections, and some-
times generate unwanted reflections of their 
own (the cheaper ones tend to, anyway). 

For the price of the best reflection fil-
ters, it’s often better to pick up a room-
treatment bundle from, say, Primacoustic 
or Auralex. Then, treat the surfaces that 
face the microphone directly, including on 
the ceiling. If you record with a cardioid mic 
(and in a home studio, chances are that you 
do), try deadening up what’s in front of the 
mic, and leaving the space behind the cable 
relatively live. It can often give a more bal-
anced result. 

Next let’s concentrate on mic technique 
for the home studio. Since your room is 
probably not akin to something like Ocean 
Way Studios, it pays to minimize the room 
in the recording as much as you can. Try 
getting closer to the mic to “overpower” 
the room, if you will. Doing so will induce 
the proximity effect—the closer the singer 
stands to the mic, the more low and low-
midrange content you’ll find in the resulting 
recording—but a little proximity effect never 
hurt anyone, and it can be taken out with 
EQ either during the recording or in the mix. 

Of course, if your computer has a noisy 
fan, if your hard drives make whirring 
sounds, or if you’ve got the A/C running, 
that’ll show up in the recording. Try to use 
components that don’t make noise, such as 
solid-state hard drives. If that’s not an op-
tion, there’s always RX Elements for noise 
reduction in post, which works quite well. 

And yes, shut off your AC. If necessary—if 
it’s audible—shut off your fridge too!  

If your room is quiet and treated, and you 
want to mitigate some of that proximity ef-
fect, move the singer away from the mic. If 
your room is noisy, and if there’s a specific 
frequency bothering you, try to amend the 
issue with EQ. Various hardware equalizers 
are more than up to the task. Of course, if 
you’ve got something like a Universal Audio 
Apollo, you can nick the troublesome fre-
quency out of the signal with one of their 
Unison-enabled EQs on the way in.  

Now, if you find the singer is overly sibi-
lant on the esses, rotate the capsule so that 
its front isn’t pointed squarely at the sing-
er’s mouth. Experiment with the best “di-
agonal positioning,” and you’ll find a sound 
that’s bright without being overly sibilated. 

Okay. We’ve spent some time on room 
treatment and mic technique, so now we 
can move on to the part you really care 
about—the gear. 

… And just like that, we’ve run out of 
space! 

Just kidding! But, as we draw to a close, 
it’s important to note there are millions of 
apposite microphones, and no single mic 
will work on every vocalist. When audition-

ing a microphone (in a place like our Su-
perStore, for instance) it’s important to ask 
some questions. Are you mostly recording 
one specific person (say, yourself)? If so, it 
pays to bring that person in to a testing en-
vironment and try out a bunch of mics. 

Disregard the price tag as you listen; go 
for what sounds the most appropriate on 
the sound source. Try to narrow your focus 
on specific parts of the frequency spec-
trum: how robust do the low-mids sound 
on this vocalist? How brilliant (or harsh) are 
the highs? Pick the one that works, within 
the budget you have, and don’t worry about 
name brands. 

On to the mic pre: if you’ve got yourself 
an all-in-one interface from Universal Au-
dio, Antelope, Apogee, MOTU, or another 
brand, you already have a preamp that’s 
clean enough for the job. If you want some-
thing with more mojo, consider preamps 
from Rupert Neve Designs, Warm Audio, 
BAE, API, and many others. 

In recent years, companies like Slate Dig-
ital and Antelope have started to offer pack-
ages that model the hardware and software 
of both mics and preamps. Indeed, you can 
get yourself a virtual mic chain from either 
company that, to many ears, rivals the origi-
nal hardware equipment. 

The possibilities are virtually endless. 
They also aren’t strictly necessary—great 
records have been made with an SM58 and 
a good, clean audio interface. Much more 
important are the room and the talent. Sort 
those out, and you’re more than halfway 
there. ■
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LARGE DIAPHRAGM CONDENSER MICROPHONES

INCLUDED  
ACCESSORIES' KEY:

6C = 6-Pin Cable
CC = Carry Case

DC = Dust Cover
HC = Hard Case

LB = Leather Bag
MF = Microfiber Cloth

MS = Mic Stand
PF = Pop Filter

PS = Power Supply
SB = Stereo Bar

SM = Shockmount
TA = Threaded Adapter

UC = USB Cable
WC = Wood Case

WS = Windscreen
XC = XLR Cable

Large Diaphragm Condenser Microphones
A go-to mic choice for tracking vocals, voice overs, string instruments such as acoustic 
guitars and violins, percussion, and more, B&H carries a wide variety of large diaphragm 
condensers to suit a variety of needs and budgets. Available selections provide polar 
patterns ranging from supercardioid (very narrow pickup path) to omnidirectional 
(360-degree pickup), while many can handle SPL levels as high as 150 dB for use on 
louder sound sources. Many selections include stands, cases, and cables and come in a 
wide variety of finishes.

Brand AKG Antelope Aston Audio-Technica Behringer Blue CAD Lewitt MXL Microtech Gefell Polsen

Model P420 C214 Edge Solo Origin AT2020 AT2035 AT4040 C-1 BlueBird SL Spark SL E100S LCT-440-Pure 770 M 930 PCR-65

Diaphragm Size 1” 1” 1.3” 1” 0.63” 0.96” — 0.63" — — 1” 1” — 1” 1”

Polar Pattern Multi Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Super Cardioid Cardioid Cardioid Cardioid Cardioid

Freq. Response 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 40 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 40 Hz-18 kHz 20 Hz-20 kHz 30 Hz-20 kHz 40 Hz-18 kHz 20 Hz-20 kHz

Dynamic Range — — — — 124 dB 136 dB 133 dB — 126 dB 119 dB — — — 135 dB —

S/N Ratio 79 dB 81 dB — 76 dB 74 dB 82 dB 82 dB — 82 dB 73 dB — 87 dB 74 dB — —

Pad -20 dB -20 dB N -10 dB N -10 dB -10 dB — -20 dB -20 dB -10 db — -10 db N N

HP/LC Filter Y Y N Y N Y Y N Y Y Y N N N N

Max SPL 155 dB 156 dB — 127 dB 144 dB 148 dB 145 dB 136dB 138 dB 136 dB 150 dB 140 dB 137 dB — 125 dB

Included Acc. SM, HC SM, HC, WS SM, CC — SM SM, TA, PP SM, CC SM, CC SM, HC SM, HC SM, HC CC, WS SM, HC WC, MS SM, MS

Color Black Black Black Silver Black Black Black Silver Blue Red Black Black Black Bronze Silver

SKU AKP420B AKC214  ANESMM ASTORIGIN AUAT2020 AUAT2035 AUAT4040 BEC1 BLBSLM BLSSL CAE100S LELCT440PURE MX770 MI211151 POPCR65

Price 199.00 399.00 695.00 299.99 99.00 149.00 299.00 49.99 299.99 199.99 499.00 269.00 76.45 1,293.50 79.99

Brand Mojave Neumann Rode sE Electronics Senal Shure Studio Projects Warm Audio

Model MA-50 U 87 Ai TLM103 TLM-102 NT1A NT1 Kit NT2A Studio Pkg X1 Studio Bundle SC-550X SCM-660 KSM32/SL C1 WA-14 WA-87

Diaphragm Size 1” – – – 1” 1" 1” 1” – 1.3" 0.75” 1.06” 1” 1”

Polar Pattern Cardioid Multi Cardioid Cardioid Cardioid Cardioid Multi Cardioid Cardioid Multi/Variable Cardioid Cardioid Multi Multi

Freq. Response 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 30 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz

Dynamic Range – 131 dB 131 dB — 132 dB — 140 dB – 140 dB – – – – –

S/N Ratio – 87 dB 87 dB 82 dB 132 dB — 87 dB – 79 dB 60 dB 81 dB 77 dB – –

Pad N -10 dB N N N — -5 dB, -10 dB -10 B -10 dB -10 dB -15 dB -10 dB, -20 dB -10 dB, -20 dB -10 dB

HP/LC Filter N N N N N Y Y Y Y Y N N N Y

Max SPL 125 dB 117 dB 138 dB 144 dB 137 dB 132 dB 147 dB 125 dB 140 dB 140 dB 148 dB 131 dB 138 dB 125 dB

Included Acc. SM, CC CC WC, SM SM PF, XC, DC, DVD SM, DC PF, XC, DC, DVD SM, PF SM, CC, PF SM, CC SM, SM, HC SM, CC, WS SM, HC

Color Black Nickel Nickel Black Silver-Gray Nickel Nickel Black Black Black Champagne Silver-Gray Black Black

SKU MOMA50 NEU87AI NETLM103A NETLM102MB RONT1ACRS RONT1KIT RONT2ASSP SEX1SSTUDIOB SESC550X SESCM660 SHKSM32SL STC1 WA14 WA87

Price 495.00 3,200.00 1,300.00 699.00 229.00 269.00 399.00 Call or Log-On 99.99 199.99 549.00 249.99 499.00 599.00
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Small Diaphragm Condenser Microphones
A mic locker standard that is at home in front of a variety of string or acoustic instruments, 
choirs, drum overheads, and more, small diaphragm condensers are both excellent on their own 
and integral companion mics to their big brother, the large diaphragm condenser.  
Available selections provide polar patterns ranging from hypercardioid (very narrow pickup path) 
or omnidirectional (360-degree pickup), with certain models handling up to 155 dB of SPL. Many 
selections include stand mounts and cases, and like large diaphragm condensers, they are 
available in a variety of finishes.

INCLUDED  
ACCESSORIES' KEY:

6C = 6-Pin Cable
CC = Carry Case

DC = Dust Cover
HC = Hard Case

LB = Leather Bag
MS = Mic Stand

PF = Pop Filter
PS = Power Supply

SA = Stand Adapter
SB = Stereo Bar

SM = Shockmount
TA = Threaded Adapter

UC = USB Cable
WC = Wood Case

WS = Windscreen
XC = XLR Cable

Brand Neumann Polsen Rode Samson Schoeps Senal Sennheiser Shure Studio Projects

Model SKM184MT KM 185 MT SDC-2150 M3 M5 NT3 NT5 C02 Colette SCI-3212 E614 MKH 50 SM137 KSM137/SL C4

Polar Pattern Cardioid Hypercardioid Cardioid Cardioid Cardioid Cardioid Cardioid Cardioid Super- 
cardioid Multi/Variable Super- 

cardioid
Super- 
cardioid Cardioid Cardioid Multi

Freq. Response 20 Hz-20 kHz 20 Hz-20 kHz 50 Hz-18 kHz 40 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 40 Hz-20 kHz 40 Hz-20 kHz 30 Hz-18 kHz 40 Hz-20 kHz 40 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz

Dynamic Range 122 dB – — 121 dB – 128 dB 128 dB 112 dB – — – – 123 dB 131 dB –

S/N Ratio 78 dB 70 dB — 73 dB – 77 dB 78 dB – 79 dB — – 12 dB 75 dB 80 dB 78 dB

Pad N N N -20 db -10 dB N N N N N — N -10 dB -15 dB 20 db 15 db -10 dB, -20 dB

HP/LC Filter N N N Y N N N N N — N Y N Y Y

Max SPL 142 dB 125 dB 125 dB 142 dB 140 dB 140 dB 143 dB 134 dB 128 dB 135 dB – 134 dB 137 dB 145 dB 140 dB

Included Acc. MS, WS, CC WS, SM MC MS, WS, CC MS, WS WS, CC MS, WS, CC SM, WS, CC MS, WS, CC SM, WS MS, CC SM, WS MS, WS, CC WS

Color Black Matte Black — Black Black Silver-Gray Silver-Gray Nickel Gray Nickel Black Black Black Nickel Silver-Gray

SKU NESKM184MT NEKM185MT POSDC2150 ROM3 ROM5MP RONT3 RONT5 SAC02 SCCMC641S SESCI3212 SEE614 SEMKH50 SHSM137 SHKSM137SL STC4

Price 1,500.00 849.00 39.95 149.00 199.00 269.00 429.00 Log-On 1,655.00 59.95 199.95 1,200.00 179.00 299.00 349.99

Brand AMT AKG Audio-Technica Audix Behringer Blue CAD DPA Earthworks

Model M40 C1000S P170 Pro 37 AT4053b AT2021 SCX1/HC MB5050 C-2 -C-4 Hummingbird 1700VP SMK4060 P30 Periscope

Polar Pattern Hemispherical Hypercardioid 
Cardioid Cardioid Cardioid Hypercardioid Cardioid Hypercardioid Cardioid Cardioid Cardioid Cardioid Cardioid,  

Omnidirectional
Omni- 

directional Hypercardioid

Freq. Response 20 Hz-20 kHz 50 Hz-20 kHz 30 Hz-20 kHz 30 Hz-15 kHz 20 Hz-20 kHz 30 Hz-20 kHz 40 Hz-20 kHz 50 Hz-19 kHz 20 Hz-20 kHz 20 Hz-20 kHz 20 Hz-20 kHz 40 Hz-20 kHz 20 Hz-20 kHz 9 Hz-30 kHz

Dynamic Range — — — 112 dB 129 dB 126 dB 116 dB — 140 dB — – – — 72 dB

S/N Ratio — 73 dB 75 dB 65 dB 78 dB 75 dB 20 dB — 75 dB — 85.5 dB – 71 dB –

Pad N -10 dB -20 dB N -10 dB N N N -10 dB -10 dB N -10 dB, -20 dB N –

HP/LC Filter N Y N N Y N N N N — N Y — –

Max SPL 114 dB — 155 dB 141 dB 145 dB 145 dB 130 dB — 140 dB 136 dB 130 dB 110 dB 134 dB 142 dB

Included Acc. HC WS, CC MS SM, WS, CC MS, WS, CC MS, CC None SA, WS, XC SA, WS, SB, CC SM, WS, CC SM, WS SM Kit HC, SM

Color Gold Nickel Black Black Black Black Black Black Black Nickel Black Gray Black — Black

SKU AMM40 AKC1000SN AKP170B AUPRO37 AUAT4053B AUAT2021 AUSCX1HC AUMB5050 BEC2Q BEC4 BLASDCM CA1700VP DPSMKSC4060 EAP30HCB

Price 471.00 199.00 99.00 169.00 599.00 79.00 499.00 549.00 59.99 59.99 299.99 599.00 999.95 669.00
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USB & IOS MICROPHONES

NT-USB
USB Microphone

  » 16-Bit/48 kHz Resolution Capture
  » Cardioid Polar Pattern
  » 1/8” Headphone Monitoring Jack
  » Direct Mix Control » iPad Compatible
  » Includes Pop Shield & Tripod Desk Stand
  » Includes Ring Mount & 20’ USB Cable
  » Includes Storage Pouch

(RORODNTUSB).................................................................................. 169.00

Blackgold  Wireless Microphone 
and Audio Recorder (16GB)

  » Syncs Audio to iPhone via Bluetooth 2.1
  » Syncs Audio with iPhone Video
  » 1" Gold-Plated Condenser Capsule
  » Records up to 24-Bit/96 kHz
  » Cardioid Polar Pattern
  » Internal Memory of 16GB
  » Rechargeable LiPo Battery
  » iOS App for Recording, Mixing & Sharing

(MIM540020301) ............................................................................... 299.00

G-Track Pro  USB Microphone 
with Built-In Audio Interface 

  » Large Diaphragm USB Condenser Microphone
  » Record Vocals/Instruments Simultaneously
  » Onboard 24-Bit/96 kHz Audio Interface
  » Cardioid, Figure-8, Omnidirectional
  » 1/4" Instrument Input
  » 1/8" Headphone Output with Level
  » Onboard Mixer with Level Controls
  » Zero-Latency Monitoring

(SAGM1UPROSE) ............................................. 129.99 

ProCast Mio
USB & XLR Studio Condenser Mic.

  » USB & XLR Output
  » Supercardioid Polar Pattern
  » Headphone Output
  » Phantom or USB Bus Powered
  »  Mic Clip, Tripod Desk Stand  

& USB Cable
  » Windows & Mac OS

(MIPROCASTMIO) ................................................................................. 99.00

Yeticaster
Professional 

Broadcast Bundle
  »  Yeti Microphone  
(without Desktop Stand)

  » Radius III Shockmount
  » Compass Desktop Boom Arm
  » USB Cable
  » 3/8" to 5/8" Adapter

(BLYETICASTER) ................................................................................. 199.99

AT2020USB+
Cardioid Condenser USB Mic

  » 16-Bit Audio at 44.1/48 kHz Sample Rate
  » Zero-Latency Monitoring
  » High-Output Internal Headphone Amplifier
  » Mix Control Blends Input with DAW Audio
  » Off-Axis Rejection for Clean Recordings
  » Mac and Windows Compatible
  » Includes Desk and Stand Mounts

(AUAT2020USBP) ............................................................................... 149.00

Yeti
USB Microphone (Blackout) 

  » 16-Bit/48 kHz Resolution
  » 4 Selectable Polar Patterns
  » 1/8" Headphone Monitoring Jack
  » Instant Mute 
  » Latency-Free Monitoring
  » Desktop Stand
  » FUSB Cable
  » Mac & Windows Compatible

(BLPQ3CUSBMC)..................................Call or Log-On

UB-440
Professional USB Mic

  » Cardioid Condenser Element
  » 16-Bit/48 kHz Recording Resolution
  » Integrated Preamp with Variable Gain
  » Headphone Monitor Out with Gain Control
  » Selectable 10 dB Pad
  » Selectable High-Pass Filter at 80Hz
  » Compatible with Windows, Mac & iOS
  » Includes Stand, Mount & USB Cable

(SEUB440) .............................................. 129.99

Podcaster
USB Broadcast Microphone

  »  USB Connection Provides Direct Connection  
to PCs without Additional Hardware

  » Built-In Headphone Input and Amplifier
  » Includes Stand Mount
  »  Cardioid Polar Pattern, 

Minimizing Off-Axis Noise  
and Feedback

(ROPODCASTER) ................................................................................ 229.00

RC-77-U  USB Retro
Condenser Mic

  » 1.25" Large Diaphragm
  » No Drivers or Power Supply Needed
  » Delivers Clean & Natural Sound
  » Mac and Windows Compatible
  »  Includes Desktop Mic Stand,  

USB Cable & Carry Pouch
  » Headphone Volume Knob

(PORC77U) ............................................................. 69.95

USB Retro

69.95

ad Compatible
Includes Pop Shield & Tripod Desk Stand

169.00

MOTIV MV51  Digital Large 
Diaphragm Condenser Microphone (Silver)

  » For Audio & Video Conferencing
  »  Works with iOS, Android,  
Mac & Windows

  » 5 x DSP Preset Modes
  » Headphone Monitoring
  » Onboard Touch-Panel Controls
  » Integrated Stand
  » Includes USB & Lightning Cables

(SHMV51A) ........................................................................................ 199.00

MOTIV MV5   
Digital Condenser Microphone (Gray)

  »  For Mac, Windows, iOS &  
Android Devices

  »  Suitable for Music, Podcasting  
& Skype

  » Built-In Real-Time Headphone Monitor
  » Removable Desktop Stand
  » Includes a Micro-B to USB Cable
  » Includes Lightning Cable

(SHMV5ALTG) ....................................................................................... 99.00

HypeMiC  USB Cardioid 
Condenser Mic 

  » Up to 24-Bit / 96kHz Resolution Capture
  » Cardioid Polar Pattern
  » 3 Analog Compression Modes
  » 3.5mm Headphone Monitoring Jack
  » Zero-Latency Monitoring
  » Gain and Mute Control
  » Multicolor LEDs
  » Includes USB and Lightning Cables

(APHYPEMIC) ....................................................................349.00

MK4
Digital Cardioid Condenser Mic

  » Large Diaphragm Condenser Microphone
  » Built-In Apogee PureDigital ADC & Preamp
  » Up to 24-Bit/96 kHz
  » Cardioid Polar Pattern
  » 20 Hz to 20 kHz Frequency Response
  » Includes Microphone Clamp & Pouch
  » Suitable for Voice, Guitar, Amps & Drums
  » Includes Lightning/USB Cable & Mount

(SEMK4DIGITAL)................................................................................. 399.95

Up to 24-Bit / 96kHz Resolution Capture

....................................................................349.00199.99

USB Microphone (Blackout) 

USB & XLR Studio Condenser Mic.

Yeti Nano  Multi-Pattern USB 
Condenser Microphone 

  » Up to 24-Bit/48 kHz Resolution
  » Cardioid & Omni Polar Patterns
  » 20 Hz to 20 kHz Frequency Response
  » 3.5mm Stereo Headphone Output
  » Zero-Latency Monitoring
  » Mic Mute & Adjustable Headphone Volume
  » Built-In Cable Management
  » Integrated Mounting Thread

(BLYNPUSBMSG) ..............................................99.99
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Procaster
Broadcast Quality Dynamic Mic

  » Tailored for Vocal Capturing
  » Cardioid Polar Pattern
  » Internal Shock Mounting
  » Internal Pop Filter
  » Durable All-Metal Construction

(ROPROCASTER) ...........................................................229.00

BCD-1
Broadcast Dynamic Microphone

  »  High-Quality Dynamic Mic Built for  
Broadcast and Voice-Over Productions

  » Excellent Side Rejection
  » Built-In Isolation Shockmount
  » Cardioid Polar Pattern    » Tuned Filter
  » Includes Windscreen

(MXBCD1) .................................... Call or Log-On

WA-84  Small Diaphragm 
Condenser Mic

  »  CineMag USA Output 
Transformer

  »  Class-A Design + 
Fairchild FET

  »  Polystyrene and 
Wima Capacitors

(WA84CB) ................... 399.00

SM7B
Cardioid Dynamic 

Announcer Microphone

  »  For Professional Voice-Over Applications
  »  Flat, Wide-Range Frequency Response
  » Air Suspension Shock Isolation
  » Built-In Pop Filter
  » Cardioid Polar Pattern

(SHSM7B) ...........................................399.00

RE20
Cardioid Dynamic Voice-Over Mic

  » Tailored Response for Vocals
  » Rugged, Steel Construction with Low Handling Noise
  » Supercardioid Polar Pattern
  » Internal Windscreen, Internal Blast and Wind Filter
  » Bass Tilt-Down Switch    » Flat Frequency Response
  » Studio Condenser-Like Performance

(ELRE20) ......................................................Call or Log-On 

PR 40 Dynamic Cardioid
Studio Microphone

  » Large Dynamic Element
  » Steel Housing
  » Internal Sorbothane Shockmount
  » Cardioid Pickup Pattern
  » Ideal for Vocals and Kick Drums
  » Assembled in the USA

(HEPR40) .................................................Call or Log-On

Stealth
4-Voice Dynamic Microphone

  »  For Vocals, Guitars & More
  » Cardioid Polar Pattern
  » 4 Switchable Voicings
  » 1 Guitar, 1 Vintage & 2 Vocals Settings
  » Built-In Class-A Preamp
  » Active Mode Uses 48V for Class-A Preamp
  » Passive Mode Bypasses Preamp

(ASASTSTEALTH) ......................................................... 399.99

RIBBON MICROPHONES

K2  Variable Pattern 
Studio Tube Condenser Mic

  »  Large 1" Capsule with Gold Sputtered Diaphragm 
and Internal Shock Mounting

  » Ultralow Noise
  » Wide Dynamic Range
  »  Continuously Variable Polar Patterns, from Omni 

through Cardioid to Figure-8
  » Dedicated Power Supply

(ROK2) ................................................................... 699.00

WA-251  Large Diaphragm 
Tube Condenser Mic

  »  Three Selectable Polar Patterns
  » Cardioid, Omnidirectional & Figure-8
  » Custom Brass CK12-Style Capsule
  » JJ 12AY7 Vacuum Tube
  » CineMag USA Output Transformer
  » Low Noise & Reduced Phase Shift
  » High Maximum SPL of 132 dB

(WA251) .........................................................................799.00

CV-12
Condenser Mic

  » Dual 32mm Gold Sputtered Capsules
  » Hand-Selected 6072A Tube Output Stage
  » Variable Polar Patterns - 9 Stages
  » Pad Attenuation Switch: -10 dB
  » Low Frequency Roll-Off: 80 Hz
  » External Power Supply
  » Custom Retro Shockmount

(AVCV12) ...................................................499.00

Fat Head
Ribbon Mic

  » Stereo Matched Pair
  » Stock Transformer
  » Figure-8 Polar Pattern
  » High Sensitivity & Detail
  » Hand-Tuned Ribbon Element
  » Balanced Audio Input Signal

In Brown/Gold (CAFHBPBGR) ........................................................... 399.00

TUBE MICROPHONES

DYNAMIC MICROPHONES

RSM-5
Ribbon Microphone

  »  2-Micron Aluminum Ribbon Transducer
  » High SPL Handling
  » Figure-8 Polar Pattern
  »  Unique, Compact Shape for Easy, 

Unobtrusive Mic Placement Anywhere
  »  Smooth, Natural Extended Low and High Ends,

(NARSM5) ................................................................79.99

Cardioid Dynamic

 R-10
Large-Element Ribbon Mic

  » Figure-8 Polar Pattern    » High Maximum SPL
  » 2.5-Micron Aluminum Ribbon
  » 30 Hz to 15 kHz Frequency Response
  » 3-Layer Windscreen System
  » Internal Shockmount System
  » Wired to Reject Electromagnetic Noise

(ROR10) ................................................................ 499.00

Ember  Cardioid Condenser 
Microphone 

  » Hand-Tuned Condenser Capsule
  » Cardioid Polar Pattern
  » Optimal Off-Axis Rejection
  » Open, Detailed Sound
  » 38 Hz to 20 kHz Frequency Response
  » High-Output Electronics

(BLEMBER) ........................................................................99.99

PodMic  Dynamic Podcasting Mic

  »  Optimized for Podcasting & Broadcasting
  » End-Address, XLR Mic Tailored for Speech
  » Dynamic Capsule Minimizes Room Noise
  » Internal Pop Filter Reduces Plosives
  » Integrated Shockmount Reduces Vibrations
  » Rugged Solid-Brass Construction
  » Swing Mount for Easy Positioning

(ROPODMIC) ........................................................................................ 99.00
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HANDHELD PERFORMANCE & HEADSET MICROPHONES

SM58-LC
Vocal Microphone 

  » High-Quality Live Vocal Microphone
  » Dynamic Cardioid
  » Internal Shockmount
  » Built-In Spherical Wind and Pop Filter
  » Frequency Response: 50 Hz to 15 kHz
  » Includes Storage Pouch and Mic Clip

(SHSM58LC) ...............................................................99.00

SM58S Microphone with Switch (SHSM58S) .........104.00

SM31FH Fitness Headset
Condenser Microphone

  »  Designed for Fitness  
Instructors

  »  Hydrophobic Fabric  
Protects Mic

  » Flexible Gooseneck
  » Cardioid Polar Pattern
  » Includes Windscreen

(SHSM31FHTQG) .................................................................................. 99.00

UEM-155-TA4F-BE
Omni Earset Microphone

  » Miniature Omni Earset Microphone
  » Optimized for Speech and Vocals
  » For Shure Transmitters
  » Slim and Flexible Boom Arm
  » Comfortable Ear Grip

with TA4F for Shure Transmitters (Beige) (SEU155TA4FBE) ............ 99.00
with Connector for Sennheiser (Beige) (SEUE15535HBE) ............... 99.00
with Connector for Sennheiser (Black) (SEUE15535HBK) ............... 99.00

KMS 105 
Live Vocal Condenser Mic

  » K 105 Supercardioid Capsule
  » Low Self-Noise » Transformerless
  » Good Pop Shielding without Side Effects
  » Includes Pouch for Transporting Mic
  »  Includes Nylon Bag
  » Matching Stand Clamp

Nickel (NEKMS105NI) ...........................................699.00
Black (NEKMS105BK) ...........................................699.00

e 865
Handheld Condenser Microphone

  » For Live Sound and Recording
  » Supercardioid Polar Pattern
  » 48V Phantom Power
  » Rejects Feedback
  » 40 Hz to 20 kHz Frequency Response
  » All-Metal Housing

(SEE865) ................................................................. 249.95

e835S
Handheld Condenser Microphone

  » Cardioid Polar Pattern
  » Dynamic Element
  » 40 Hz to 16 kHz Frequency Response
  » Hum-Compensating Coil
  » Low Handling Noise » Silent On/Off Switch
  » XLR 3-Pin Connector » Durable Metal Construction

(SEE835S) ..................................................................99.95

E6 Flex Omnidirectional
Earset Microphone 
(Wired XLR, Beige)

  » Cable with Standard XLR Connector
  » Slim Springy Ear Grips of E6
  » Flexible Boom of E6i
  » 2mm Diameter Duramax Cable
  » For Speech & Vocals
  » Beige

(COE6XOP6L2) ................................................................................... 379.00

SE10T Omnidirectional
Headworn Microphone

  » Micro-Miniature Condenser with 3mm Capsule
  » Omnidirectional Pickup Pattern
  » Fits Left or Right Ear 
  » Moisture-Resistant Coating
  » Detachable Cable
  » Four Cable Adapters for Wireless Transmitters
  » Includes 3 Windscreens, Clothing Cable Clip & Carry Case

(SASE10T) ...........................................................................Call or Log-On

HDM-16-S  Handheld Dynamic 
Performance Mic 

  »  Optimized for Vocals and Speech
  »  Wide Frequency Response with 

Impressive Sensitivity
  » Supercardioid Polar Pattern 
  » Rugged and Portable
  » Integrated On/Off Switch
  » Includes 16' XLR Cable and Mic Clip and Carry Pouch

(POHDM16S) ................................................................... 49.99

PRO 8-HEX
Condenser Headworn Microphone

  »  Professional Quality Vocal Pickup  
with Hands-Free Operation

  »  Low Visibility Headband  
Provides Stable, Comfortable Fit

  »  Pivot-Mounted Flexible Mic  
Boom Descends from Left or Right Side

  » 7.2'  Cable Attached
(AUPRO8HEX) ...................................................................................... 79.00

enCORE 300  Condenser 
Handheld Vocal Microphone

  » For Stage and Studio Vocal Performance
  » Open, Detailed, and Present Sound
  » Cardioid Polar Pattern
  » Hand-Tuned Condenser Capsule
  » Rugged, Tour-Tough Construction
  » 40 Hz to 20 kHz Frequency Response
  » 48V Phantom Power

(BLENC300BLK) ...............................................................199.99

 .................................................................................. 99.00

Micro-Miniature Condenser with 3mm Capsule

Four Cable Adapters for Wireless Transmitters
Includes 3 Windscreens, Clothing Cable Clip & Carry Case

HANDHELD PERFORMANCE

HEADSET MICROPHONES

Boom Descends from Left or Right Side

BETA87A
Supercardioid 

Handheld Condenser Microphone

  »  Supercardioid Polar Pattern Remains Uniform  
Throughout the Frequency Range

  » Wide Dynamic Range (113 dB) and Low Distortion
  » Phantom-Powered Voltages from 11 to 52 Volts
  » Frequency Response: 50 Hz to 18 kHz
  » Cartridge Shockmount System

(SHBETA87A) ...........................................................249.00

XM8500  Dynamic 
Cardioid Vocal Mic

  » Cardioid Polar Pattern » Dynamic Transducer
  » 50 Hz - 15 kHz Frequency Response
  » Smooth Mid-Frequency Presence Rise
  » Ultra-Low Distortion for a Super Clean Sound
  » Internal Shockmount System
  » Microphone Stand Adapter Included

(BEXM8500) .................................................................... 19.99

Omni Earset Microphone

TX-M2
Handheld Wireless Mic

  »  35 Hz to 20 kHz Frequency Range
  » Range up to 328'
  » One-Touch Pairing
  » Mute Switch, Low Handling Noise
  » 128-Bit Encryption
  » Bottom-Mounted Diversity Antenna
  » 2.4 GHz Fixed Frequency Agile Technology

(ROTXM2) .....................................................................299.00

HS2  Lightweight Headset 
Microphone Black/Small

  » Low-Profile Ergonomic Design
  » Ultralightweight Construction
  »  Adjustable Stainless Steel 

Boom Arm
  »  Hypoallergenic 

Silicone Ear Strips
  » Durable Ceramic-Painted Finish   » Available in Small or Large

(ROHS2BS) ........................................................................................ 299.00

Low-Profile Ergonomic Design
Ultralightweight Construction

djustable Stainless Steel 
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U857QL
Gooseneck Microphone with 
Cardioid Micropone Capsule (18")

  »  Ultra Flexible Gooseneck 
  » UniSteep Filter
  » Interchangeable Elements
  » UniGuard Shielding

(AUU857QL) .....................................................................199.00

BOUNDARY / HANGING / GOOSENECK MICROPHONES

PRO-44 Hemi-Cardioid
Condenser Boundary Microphone

  » Low Profile for Minimum Visibility
  » Wide-Range Condenser Element 
  » Rugged Design and Construction
  »  Self-Contained Electronics Eliminate  
Need for External Power Modules

  » Low-Mass Diaphragm for Superior Performance

(AUPRO44) .......................................................................................... 99.00

RE-90H
Hanging Choir Microphone

  »  Cardioid, Electret Condenser Hanging  
Microphone

  » Shielded Preamplifier
  »  Wide Frequency and Sensitivity  
Response

(ELRE90H) ...................................................219.95

CVB-B/O Centraverse
Omnidirectional Boundary 

Condenser Microphone

  » Omnidirectional Polar Pattern
  » 70 Hz to 16 kHz Frequency Range
  » Attached XLR Cable
  » Suitable for Low-Profile Situations
  » Built-In RF Shielding Technology

(SHCVBBO) ................................................99.00

Voice Tracker II
Array Microphone

  » Feedback Rejecting AEC Technology
  » Ideal for Voice Recognition
  » Listening Beam Technology
  »  Coverage throughout  
a Large Room

  » Optional USB Power Adapter » Mac & Windows Compatible
(ACVTIIAM) ........................................................................................ 342.00
Voice Tracker I Array Microphone (ACVTIAM) ................Call or Log-On

AC-404 
Portable USB Conferencing Microphone

  » Low-Profile Design
  » 180-Degree Coverage
  »  No Drivers Needed,  

Plug-and-Play
  » 3 Capsule Boundary Design
  » Mac & Windows Compatible

(MXAC404) .......................................................................................... 69.99

MX412DC  12" Desktop
Cardioid Gooseneck Microphone

  » Locking Flange Mount 
  » Interchangeable Cartridges 
  » Balanced, Transformerless Output 
  » Wide Dynamic Range & Frequency Response 
  »  Shockmount That Provides  
over 20 dB Isolation

(SHMX412DC) ............................................. 288.00

PDMIKC5  Tabletop Condenser 
Microphone

  » Adjustable Gooseneck
  » Cardioid Polar Patter
  » On/Off Broadcasting Switch
  » 40 Hz to 16 kHz

(PYPDMIKC5) ....................................................................................... 29.99

onics Eliminate  

Wide Dynamic Range & Frequency Response 

288.00

Voice Tracker II

Feedback Rejecting AEC Technology

U7
Omnidirectional USB Boundary Microphone

  »  Tabletop Condenser Microphone
  » Designed for Capturing Speech
  » For Home and Office Use
  » Omnidirectional Polar Pattern
  » Low-Profile Design
  » Plug-and-Play Operation

(CAU7) ................................................................................................ 79.00

3 Capsule Boundary Design
Mac & Windows Compatible

PRO 45
Cardioid Condenser Hanging Mic

  » Perfect for Suspension over Choirs and Orchestras
  » Wide-Range Condenser Element with Hi-SPL Handling  
  » Low-Mass Diaphragm for Superior Performance
  » Flat, Smooth Frequency Response
  » 25' XLR Cable Permanently Attached 

Black (AUPRO45)................................................................................ 99.00
White (AUPRO45W) ............................................................................ 99.00

Cardioid Condenser Hanging Mic

Perfect for Suspension over Choirs and Orchestras
Wide-Range Condenser Element with Hi-SPL Handling  
Low-Mass Diaphragm for Superior Performance

................................................................................ 99.00
99.00

MX202W/C
Cardioid Hanging Condenser Mic

  » Wide Dynamic Range
  » Balanced, Transformerless Output
  » Interchangeable Cartridges 
  » Supplied with Stand-Mount Adapter

White (SHMX202WC) ................................................. 89.00

Isomax 2
All-Purpose Microphone

  »  With Standard 3-pin XLR Connector for  
Hardwired Application

  » Black   
  »  Miniature and Versatile
  » 50' Cable with 3-Pin XLR Connection
  » Hypercardioid

(COCMHCB) ....................................................................................... 209.00

HM 1000 
Ceiling Hanging Module  

for CK Series Microphone Capsules

  » Hangs CK Capsules
  » 33' (10m) Specially Treated Cable
  » Spring Steel Hanging Clamp
  » Female Output Stage

(AKHM1000) ...................................................................................... 169.00

BOUNDARY MICROPHONES

GOOSENECK MICROPHONES

HANGING MICROPHONES

CM12C 
Hanging Choir Microphone (Black)

  » Condenser Element
  » Cardioid Polar Pattern
  » Multistage Windscreen
  » Steel Hanger with 30' XLR Cable

(SACM12C) .......................................................................................... 99.99 

UB1 Omnidirectional
USB Boundary Microphone

  » Surface-Mount Condenser Microphone
  » Miniature, Low-Profile Design
  » Omnidirectional Polar Pattern
  »  Records 16-Bit Audio at 44.1 

or 48 kHz
  » Plug-and-Play Operation
  » Compatible with Mac and Windows

(SAUB1) .............................................................................Call or Log-On

for CK Series Microphone Capsules
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MIC STANDS / BROADCAST ARMS / POP FILTERS

Starbird SB-1
Studio Boom 
Stand

  » Boom Arm Telescopes from 55 to 98"
  » Stand Height Range: 63 to 102"
  » T.A.F. Pneumatic Auto-Lift System
  » VariBal Counter Ballast System
  » Three Retractable Legs
  » BoomStop Safety Lock
  » Large Triad TC Studio Casters
  » Aluminum Construction

(TRSB1)............................................................ 989.00

goSTAND
Portable Microphone Stand

  »  Designed to  
Fold Down &  
Fit in Your Bag

  »  58" High When  
Fully Extended

  »  Folds Down to  
Less than 18" 

(AIGSPMS)...........................................................49.00

PSA-1
Studio Boom Arm 
for Broadcast Microphones

  » 32” Horizontal Reach
  »  33” Vertical 
Reach

  »  Touch-Fastener  
Cable Wraps

  » Desk Clamp Included
  » Desk-Insert Hardware

(ROPSA1) ............................................................99.00

210/9
Tripod Microphone 
Stand with Telescoping 
Boom

  »  Stable and Sturdy Steel  
Material with Zinc  
Die-Cast Base

  »  2-Piece Telescopic  
Boom Arm

(KM2109B) .........................................Call or Log-On

ProBoom Ultima LP
Adjustable Mic Boom

  »  Mount Microphones to a Table
  »  Ideal for Announcers, 

Interviews & DJs
  » 12" Fixed Horizontal Arm
  » 30" Reach
  » 6 lb Weight Rating
  »  Low 

Profile
  » Integrated Wire Channeling

(OCULPMB) ........................................Call or Log-On

MS-5130
Round Base 
Microphone Stand

  »  Telescoping Shaft with  
Ergonomic Clutch

  » Weighted Round Base
  » Nonslip Rubber Feet
  » Durable Steel Construction

(AUMS5130) ........................................................19.49

JS-DMS50
Tabletop Mic Stand

  »  Height Adjustable  
from 8" to 12.25"

  »  Scratch-Resistant,  
Powder Coated Finish

  »  Nonslip Rubber Ring  
on Bottom of Base

  »  Solid Die-Cast  
Round Base

(ULJSDMS50) ......................................................14.99

DS7200B
Adjustable Height Desktop  
Mic Stand (Black)

  »  Removable Shaft  
Extends 9 to 13"

  » Die-Cast Steel Clutch
  »  Black-Rubberized  

Nonslip Base
  » 5/8"-27 Solid-Threaded End
  » For Tabletop Uses and More

(ONDS7200B) .....................................Call or Log-On

MBS5000
Broadcast/Webcast 
Boom Arm with 
XLR Cable

  » Durable Articulating Boom Arm
  » Ergonomic Three-Prong Knobs
  » Quiet and Flexible Positioning
  » Preinstalled 10' XLR Cable
  » 19.5" Vertical & Horizontal Arm Length
  » C-Clamp and Flange-Style Mount

(ONMBS5000) ......................................................41.95

RF-5P-B
Reflection Filter (Metal)

  »  Compact  
Microphone  
Isolation Solution

  »  Absorbs Unwanted  
Room Noise &  
Reflections

  » 5-Panel Perforated Aluminum Screen
  » Adjust Side Panels for Varied Isolation
  » High-Density Pyramidal Acoustic Foam

(AURF5PB) ....................................................... 149.00

MS-5230F
Tripod Microphone  
Stand with Fixed Boom 

  » Multi-Angle Boom Arm
  »  Telescoping Shaft with 

Ergonomic Clutch
  » Reinforced Tripod Base
  » Nonslip Feet
  » Durable Steel Construction
  » Portable, Collapsible Design

(AUMS5230F) ......................................................21.99
Other Configurations Available

TT-6220
Telescoping Tabletop 
Microphone Stand 

  »  Telescoping Shaft for 
Adjustable Height

  » Weighted Round Base
  » Five Nonslip Rubber Feet
  » Microphone Cable Guide
  » Durable Steel Construction

(AUTT6220B)........................................................12.00

BAI-2X
Two-Section Broadcast Arm 
with Internal Springs

  »  Internal Springs for Clean  
& Sleek Look

  » Supports Mics up to 5 lb
  » 5/8"-27 Standard Mic Thread
  » Fits Mic Clips and Shockmounts
  » Extends to 40"/Rotates 360°
  » 14" Riser
  » Integrated XLR Cable

(AUBAI2X) ......................................................... 119.99

ISO-ARMOR-2 
Microphone Isolation Chamber

  »  Reduces Ambient Noise & 
Room Reflections

  »  Yields a More Dry,  
Direct Sound

  »  Fits Microphone Diameters  
up to 2.3"

  » Perforated Aluminum Shell
  » Built-In Nylon Pop Filter Screen
  » Integrated Shockmount Adapter

(AUISOARMOR2) ................................................. 99.99

Desk Clamp Included
Desk-Insert Hardware

Octo-842S  Front-
Address Pop Filter

  »  Reduces Pops from  
Vocal Plosives

  »  Use for Voice-Over,  
Narration and More

  »  Rubber O-Rings  
Keep the Filter On-Axis

  »  Adjust Mic Distance  
from 1.25 to 1.5"

  » Dual Acoustex Pop Screens

(THPF842S) .........................................................55.00

Stand with Fixed Boom 

21.99

Tripod Microphone
Stand with Telescoping

Call or Log-On

Built-In Nylon Pop Filter Screen
Integrated Shockmount Adapter

19.5" Vertical & Horizontal Arm Length

MIC STANDS

BROADCAST ARMS

FLOOR & TABLE STANDS

POP & REFLECTION FILTERS

Sound Shield
Compact Folding Vocal 
Reflection Filter

  »  Compact Microphone  
Isolation Solution

  »  Absorbs Unwanted  
Ambient Reflections

  » Folding, Curved Metal Panels
  » High-Quality Acoustic Foam
  » Mounts Directly on Mic Stands
  » Lightweight for Easy Transport

(MASNDSHLDCMC) ..............................................59.00

5/8"-27 Standard Mic Thread
Fits Mic Clips and Shockmounts

or Announcers, 
Interviews & DJs
12" Fixed Horizontal Arm
30" Reach
6 lb Weight Rating

Folding, Curved Metal Panels

Boom Arm Telescopes from 55 to 98"
Stand Height Range: 63 to 102"
T.A.F. Pneumatic Auto-Lift System
VariBal Counter Ballast System
Three Retractable Legs
BoomStop Safety Lock
Large Triad TC Studio Casters
Aluminum Construction
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Pearstone IMA-1030
Switchable In-Line 

Attenuator

(PEIMA1030)............................ 24.99 

Neutrik NA3MM
XLR Male to 

XLR Male Adapter

(NENA3MM) ............................... 9.22

TRITON AUDIO FetHead
In-Line Microphone 

Preamp

(TRFETHEAD) ........................... 89.95

B&H’s selection of in-line accessories 
provides a variety of solutions to 
common everyday issues found in 
studios or ENG scenarios. Ranging from 
in-line attenuators to phase switches, 
gender changers, ground lifts, and 
more, our in-line accessories section 
has the solution you’re looking for.

CLIPS

SHOCKMOUNTS

CLAMPS, MOUNTS & BRACKETS

THREAD ADAPTERS

IN-LINE MIC ACCESSORIES

To view a full listing 
of all Microphone 

Accessories

or visit our website
BandH.com/w15295

SCAN THIS CODE

®

Whether you need a clip for your 
handheld dynamic, small diaphragm 
condenser, or shotgun mic, B&H’s 
selection will provide you with what 
you’re looking for. Ranging from rubber 
to plastic and clothespin style, we 
have a variety of clip options to select 
from.

Ultimate Support JS-MC1
Clothespin-Style Plastic 
Microphone Clip

(ULJSMC1) ................................ 2.99

QuikLok MP892
Small Rubber Mic Clip 
for Wired Microphones

(QUMP892) ................................ 1.99

Shure A25DM
Stand Adapter for 
SM58/57/87A & Beta 87A

(SHA25DM) ................................ 4.95

Auray SHM-SCM1
Suspension Shockmount 
for Large Condenser Mics

(AUSHMSCM1) ......................... 49.95

Onstage MY-410
Studio Microphone 
Shockmount

(ONMY410) .............................. 20.95

Shure A55M
Isolation and Swivel 
Shock Stopper Mic Mount

(SHA55M) ................................ 21.99

Onstage MA100
3/8" Male to 5/8" 

Female Screw Adapter

(ONMA100) ................................ 3.95

Auray Combo
Male to Female Reversible 

Thread Adapter

(AUADCOMBOS) ......................... 4.95

K&M 217
3/8" Female Thread, 

5/8"-27 Male Thread

(KMTAZCTD)............................... 2.49

Prevent your mic from being plagued by 
vibrations from your stand or mount by 
incorporating shockmounts from B&H’s 
wide selection. Regardless of what kind 
of mic you’re using, whether it’s a large 
diaphragm condenser, a small dia-
phragm condenser, a dynamic or cam-
era-mounted shotgun mic, our website 
has a vast array to suit your needs.

K&M 23510
Stereo  
Microphone Bar

(KM23510) .............................. 21.99

Stage Ninja Scorpion
Gooseneck Mount

(STMIC12CB) ........................... 34.99

Onstage TM01
Microphone Table & 
Stand Clamp

(ONTM01) ............... Call or Log-On

Whether you’re capturing audio in 
the studio, in ENG environments, or 
working with live sound, it’s inevitable 
that you’re going to have to attach one 
piece of equipment to another. B&H 
stocks a large selection of clamps, 
mounts, and brackets, ranging from 
the common to the unique, ensuring 
that your accessory needs are covered.

Don’t let mismatched threads keep you 
from connecting your gear to stands or 
cameras. Regardless of whether you’re 
trying to connect a mic to a stand or 
an accessory to your camera’s shoe 
mount, B&H’s ample thread adapter 
options will help keep your gear 
connected.
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Channel - Master
Preamp and Input Processor

  »  Designed for Studio, Stage & Broadcast
  » Ultra-Wide Bandwidth RPA Tube Preamp » Built-In Aural Exciter
  » Big Bottom Bass Enhancer » Reference-Quality Internal Clock
  » Patented Wave Dependent Compressor
  »  Parametric EQ, De-Esser, & Gate    » Front-Panel Instrument Input
  » Front-Panel Instrument Input » Insert Send-and-Return Jacks

(APCHANNEL) .................................................................................... 999.00

m101 
Microphone Preamp with Ribbon Mic Mode

  »  Fully Balanced,  
Transformerless,  
Single-Channel  
Microphone Preamp 
with Optimized DI Instrument Input

  » Built-in Switchable 75Hz, 12dB/8ve High-Pass Filter
  » Precision 12-Position, Gold Contact, Rotary Switch Gain Control
  » 10 to 75dB Gain Range, 10dB Output Trim Controls

(GRM101) .......................................................................................... 765.00

RNP8380 
Really Nice Preamp

  »  Two-Channel Microphone 
Preamplifier

  » 1/4" and XLR Inputs
  »  Pristine Class-A 

Preamps
  » Innovative Circuit Design
  » Repeatable Gain Switch  » Accurate Signal-Level Metering
  » Front-Panel Unbalanced DI Inputs

(FMRNP) ........................................................................................... 475.00

Portico 5017
DI/Pre/Comp Mobile 

Channel with Variphase

  » Blend DI and Mic Channel
  » Two-Channel Operation
  » Silk Control
  » Mic Gain from 0 to 66 dB
  » DI Gain from 0 to 30 dB  » Mic Polarity Invert Button
  » +48V Phantom Power  » Phase Sweep Control
  » Internal Jumper for Routing Compressor

(RU5017MOBILE) ............................................................................1,045.00

 SOLO/610  Classic Vacuum Tube 
Microphone Preamplifier and DI Box

  »  Classic Putnam 610 Console  
Microphone Preamplifier and DI

  »  Lengendary All-Tube Sound at 
a Project Studio Price

  »  Gain, Level, and Impedance 
Selection for Max Tonal Variety

  »  Rugged Construction: Steel  
Chassis in a Portable Design for Studio, Desktop. or Stage

(UNS610).............................................................................Call or Log-On

MIC100 ULTRAGAIN PRO
Tube Mic Pre and Direct Box

  »   Tube Mic/Line Preamp with  
Integrated Limiter 

  » 12AX7 Vacuum Tube 
  »  Phase Reverse Switch, 20dB Pad
  »  +48v Phantom Power, Wide-Range  
Input Gain and Output Level Adjustment

  »  Balanced I/O on 1/4” TRS Phone and XLR Connectors
(BEMIC100) ......................................................................................... 45.99

TubePre v2
Tube Preamplifier/DI Box

  » Single Channel
  » Preamp and DI
  » Solid-State Preamp
  » 12AX7 Vacuum Tube Stage
  » Balanced and Unbalanced I/O » Phantom Power
  » High-Pass Filter » Phase Reverse
  » Backlit VU Meter » Rugged and Compact Enclosure

(PRTUBEPREV2) ................................................................................. 129.95

BlueTube DP v2
Mic/Instrument Tube Preamp 

  » 2 Channel
  »  Preamp  

and DI
  » Solid-State Preamp » 12AX7 Vacuum-Tube Stage
  » Phantom Power » High-Pass Filters
  » Phase Reverse » Backlit VU Meters
  » Rugged and Compact Enclosure

(PRBTDPV2) ...................................................................................... 229.95

Tube MP
Preamplifier

  » Single-Channel Tube-Based
  » Hand-Selected 12AX7A Vacuum Tube
  » Variable Input & Output Gain Control
  » Ideal as a Tube DI Box
  » XLR & 1/4" Connections
  » Exceptionally Low Noise
  » A Staple in Many Studios
  » Inexpensive, Professional Performance

(ARTUBEMP) ........................................................................................ 55.00

286s
Mic Preamp/Channel Strip

  » Single Channel
  » 4 Processors
  » Compressor

  » De-Esser
  » Enhancer
  » Expander/Gate

  » Phantom Power
  » Insert Jack
  » Meters

(DB286S) ........................................................................................... 219.00

Tube MP Studio V3
Tube Microphone Preamp

  »  V3 Technology with Presets That  
Allow You to Select between  
Preamp Settings Designed for  
Guitars, Keyboards, Drums,  
Vocals, and more

  »  OPL (Output Protection Limiter)  
Accurately Controls and Maintains the Output Peak Signal

(ARTMPSV3) ........................................................................Call or Log-On

GO XLR
Online Broadcaster Platform 
with Mixer and Effects

  »  All-In-One Desktop Rig 
for Broadcasters

  »  Four-Channel Mixer 
for USB Audio Mixing

  » Motorized Faders with LCD Strips
  » Premium Midas Microphone Preamp
  » Built-In Studio Quality Effects

(TCGOXLR) ......................................................................................... 399.99

PRE-73 JR  1073-Style Microphone 
Preamp/Direct Box 

  »  Vintage-Style 
Class-A Electronics

  »  20 to 70 dB Gain 
Switch Range

  » Switchable Phantom Power
  » High-Impedance Instrument Input
  » Combo XLR/TRS Input Jack
  » Separate XLR and TRS Output Jacks

(GOPRE73JR) ..................................................................................... 249.99

WA73-EQ  Single-Channel Mic 
Preamplifier and Equalizer

  »  Mic, Line, and Instrument Inputs
  » Insert Send and Return
  » Balanced XLR and 1/4" Outputs
  » Up to 80 dB of Gain   » Carnhill Transformers
  » Switchable Input Impedance   » Selectable High-Pass Filter
  » Inductor-Based, 3-Band EQ   » Ground-Lift Switch

(WA73EQ) .......................................................................................... 799.00

Input Gain and Output Level Adjustment

Pro ISA ONE
Microphone Preamp

  » Single Channel
  » Transformer Based
  » Insert Point
  » Headphone Output
  »  Based on the 
Original ISA 110

  » Features Classic Vintage Topology
  » Includes Lundahl L1538 Transformer and a Custom Zobel Network

(FOISAONE) ....................................................................................... 539.99

MIC PREAMPS / CHANNEL STRIPS

California Residents   *See our website for Prop 65 warning

Switchable Phantom Power
High-Impedance Instrument Input Motorized Faders with LCD Strips
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WA76 
Discrete FET Compressor

  » Single-Channel Limiting Amplifier » Ultrafast Attack Time
  » "All Buttons In" Feature » CineMag Input / Output Transformers
  » Class-A Line-Level Output Amplifier » Gain Reduction or Output Meter

(WAWA76) ......................................................................................... 599.00

RNC1773 
Really Nice Compressor
  »  Stereo Compressor  

in 1/3 Rack Size
  »  High-Fidelity Audio  

Path and Compression
  »  Normal and Super  

Nice Modes » 5 Parameter Controls
  » Attack and Release Controls » 2 x 1/4" Input/Outputs
  » 1 x 1/4" TRS Sidechain Insert » Aluminum and Steel Enclosure

(FMRNC) ........................................................................................... 175.00

COMPOSER PRO-XL MDX2600 V2
Dual-Channel Dynamics Processor

  » Two Independent or Linkable Channels
  » Expander/Gate, Compressor & Peak Limiter
  » Integrated De-Esser & Dynamic Enhancer
  » Selectable Tube Simulation
  » Balanced XLR & 1/4" I/O   » 1/4" Sidechain Sends & Returns

(BEMDX2600V2) ................................................................................. 139.99

266xs
Compressor/Gate

  » Dual Channel » Stereo or Dual Mono
  » Classic dbx "Auto" Mode
  » Side Chain Insert
  » Separate LED Displays

(DB266XS) ......................................................................................... 169.00

SL33b 
Stereo Program Limiter

  »  Threshold 
Control

  »  Output Level 
Control

  »  1/8" Stereo /  
RCA Inputs & Outputs

  » Automatic Program Limiting » Stereo Compressor/Limiter

(ROSL33B) ........................................................................................... 63.00

KT-2A  Single-Channel 
Leveling Amplifier and Compressor 

  »  Single Channel
  »  Smooth,  

Musical  
Compression » Based on Classic LA-2A Design

  » Full Tube Complement » Midas Input and Output Transformers
  » Pre-Emphasis Trimmer for Sidechain Path » Vintage-Style VU Metering
  » Balanced Connections & Stereo Link Jack

(KLKT2A) ........................................................................................... 399.99

EQP-KT
Single-Channel 2-Band Equalizer 

  »  Class-A Discrete Circuitry » Balanced XLR In/Output Connectors
  » 12AX7 & 12AU7 Vacuum Tubes » MIDAS In/Output Transformers
  » Switchable Frequency Selectors » Independent Boost/Cut Controls
  » Bypass Feature for A/B Comparison » Universal Power Supply

(KLEQPKT) ......................................................................................... 299.99

Distressor EL8X-S
Analog Knee Compressor (Stereo Pair) 

  » Stereo Configuration » British Mode with Image Link
  » Classic Knee Sound » Programmable Analog Distortion & Warmth
  » 384 Possible Settings » Eight Compression Curves
  » Advanced Side-Chain EQ » True Bypass

(EMEL8XSSTRPR) ...........................................................................3,259.00

MINIFBQ FBQ800
Compact 9-Band Graphic Equalizer

  »  FBQ Feedback  
Detection system

  »   Low-Cut Filter  
Removes Unwanted Frequencies » Accurate 6-Segment LED Meters

  » Illuminated Faders, Potentiometers and Illuminated Switches
  »  All Mini Series Models Can Be Stacked on Top of Each Other to Create 
an Ultra-Compact Signal Processor Solution

(BEFBQ800) ......................................................................................... 69.99

231s Dual-Channel
31-Band Graphic Equalizer

  » Dual Channel, 2 x 31 Band
  » 1/3 Octave » Switchable Boost / Cut Range
  » 20mm Sliders » 4-Segment LED Ladders

(DB231S) ........................................................................................... 219.00

HQ231  Dual-Channel 31-Band 
Equalizer with 20mm Faders

  »  FDC  Feedback Detection Circuit  » Dual-Channel 31-Band 
Graphic Equalizer  » Output Level VU Metering  » Constant-Q 
Filtering  » Center-Detented Frequency Band Sliders

  »  Independent Level and Bypass Controls

(ARHQ231)......................................................................................... 339.00

COMPRESSORS

EQUALIZERS

PPEQ100
Dual 10-Band Stereo Equalizer

  » Dual 10-Band EQ with Blue LEDs
  » Four Audio Source Line Input » 4 RCA Line Inputs
  » 2 RCA Line Outputs » Removable Rackmount Brackets
  » VFD Spectrum Graphic Display Screen

(PYPPEQ100) ....................................................................................... 76.99

MQX-2310
Stereo 31-Band Graphic Equalizer

  » 31-Band 1/3 Octave Graphic Equalizer
  » Precision Wein-Bridge Filters » Variable High-Pass Filter
  » Selectable Boost/Cut Range of 6dB or 15dB

(ASMQX2310) .................................................................................... 399.00

Pro VLA II
Compressor/Leveler

  » Dual Channel
  » Tube Gain Stage
  » +4dBu/-10dBV Switch

(ARPROVLAII) ......................................................................Call or Log-On

Fusion
Analog Stereo Outboard Processor

  » 2-Channel Processing » Custom-Designed Transformer
  » Harmonic Enhancement, 2-Band Shelving EQ
  » HF Compressor, Stereo Image Controls
  » Input & Output Trim Controls » Adjustable High-Pass Filter

(SOFUSION) ....................................................................................2,495.00
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DN-300R
Solid-State SD and USB Audio Recorder

  »  For Conferences, Clubs & Houses of Worship
  » Record to SD and USB Simultaneously
  » Balanced XLR and Unbalanced RCA I/O
  » WAV and MP3 Recording » Record at up to 24-Bit/48 kHz
  » Multiple Record and Playback Modes » Headphone Output

(DEDN300R) ...................................................................................... 199.00

UREC7 Professional
Rack-Mountable USB/SD Recording Deck

  » USB Flash Drive / SD Card (up to 32 GB), RCA & 1/8’’ (MP3) Inputs
  » RCA (Line Out) Output » USB 2.0 Compatible
  » Frequency Response: 20Hz-20KHz ±3dB
  » Plays .mp3, .wav & .wma Files from USB Drives and SD Cards
  » 20Hz-20KHz ±3dB Frequency Response

(TEUREC7) ........................................................................................... 65.62

VIRTUALIZER 3D FX2000
3D Multi-Engine Effects

  » 71 Algorithms with True RSM Stereo and 3D Effects
  » Wave-Adaptive Virtual Room Reverb Algorithms
  » Multiple Modulation, Dynamic, Psychoacoustic, and EQ Algorithms
  »  11 Effect-Combinations with Selectable Serial / Parallel  
Configuration » Extensive MIDI Implementation

(BEFX2000) ....................................................................................... 139.99

SDR-4000 Dual Digital
USB / SD Audio Recorder & Player

  » Dual Digital Recording to SD & USB Drive
  » Dual Playback » SD Card Slot & USB Port
  » RCA & XLR Connectors
  » 1/4” Headphone Jack on Front Panel
  » Toggled Output » Slim 1 RU Chassis

(VOSDR4000) .......................................................................Call or Log-On

MX-200
Multi-Effects Processor 

  » 16 Legendary Lexicon Reverbs » Dual-Processor Design
  » dbx Dynamics » USB "Hardware Plug-In" Feature
  »  Four Routing Configurations: Dual Mono, Cascade, Dual Stereo 

(Parallel) and Mono Split » 99 Factory and 99 User Programs
  » MX-Edit Editor / Librarian Software

(LEMX200) ......................................................................................... 219.00

LiveTrak L-12
12-Channel Digital Mixer & Multitrack Recorder 

 » Built-In 22-Track SD Recorder
 » USB Audio Interface 
(iOS Compatible)

 » 8 Mono + 2 Stereo Inputs
 » Channels 1-2 Offer Hi-Z Inputs
 » Phantom Power and -26 dB Pad
 » 8 Channels of Compression » Channel Strip with 3-Band EQ
 » Low-Cut Filter and 16 Digital Effects
 » 5 Headphone Outputs with Individual Mix

(ZOZL12) ............................................................................................ 599.99

Track SD Recorder

Channels 1-2 Offer Hi-Z Inputs
Phantom Power and -26 dB Pad

DP-24SD
Digital Portastudio

  » Record up to 8 Tracks Simultaneously » 19 Faders
  » Records to SD/SDHC Cards
  »  24-Bit/48 kHz  
Resolution

  » Up to 24-Track Playback
  » 8 Combo XLR/TRS Mic Inputs
  » Built-In Mixing & Mastering Effects

(TADP24SD) ....................................................................................... 499.99
DP-32SD 32-Track Digital Portastudio (TADP32SD) ..................... 599.99

ecords to SD/SDHC Cards

p to 24-Track Playback
8 Combo XLR/TRS Mic Inputs
Built-In Mixing & Mastering Effects

AIRA VT-4
Voice Transformer

  » Real-Time Vocal Processing
  »  For Music, Podcasts,  

Web Streaming
  » Dedicated Pitch & Formant Sliders
  » Reverb and Mix Balance Sliders
  » Eight Memory Settings
  » XLR/TRS Combo Jack with +48V » Stereo or Wet/Dry Outputs
  » Built-In USB Audio Interface » USB or Battery Powered

(ROVT4)............................................................................................. 229.99

Dedicated Pitch & Formant Sliders
Reverb and Mix Balance Sliders

DP-03SD
Digital Portastudio 8-Track Recorder

  » 8 x Track Faders & 1 x Master Fader
  » Records to SD/SDHC Cards
  »  2 x Built-In Stereo  

Condenser Mics
  » 2 x XLR Mic/Line Inputs
  »  2 x 1/4" Inputs » Records 2 Tracks  

Simultaneously
  » Built-In EQ, Compression, Reverb » Includes 4GB SD Card

(TADP03SD) .........................................................................Call or Log-On

DP-006
6-Track Digital Pocketstudio

  » Dual Omnidirectional Microphones
  » Records WAV Files at 16-Bit/44.1 kHz
  » Two Unbalanced 1/4" TS Inputs
  » Mini-USB 2.0 Output
  »  Integrated Metronome 
and Tuner

  » Includes 2GB SD Card
  » 8 Hours of Operation on 4 AA Batteries

(TADP006) ...........................................................................Call or Log-On

SD-20M
4-Track Solid-State Recorder

  »  Stereo or Four-Track Recording » 2x XLR-1/4" Combo Mic/Line 
Input Jacks » Switchable +48V Phantom Power

  » 2x RCA Line Inputs » Low-Cut Filter with 40/80/120 Hz Levels
  »  Dual Recording Function » AA Battery Backup » Media Slot 

Supports Cards up to 128GB » Compact 1U Rack-Mountable Chassis
(TASD20M) ........................................................................................ 299.99

8 x Track Faders & 1 x Master Fader

ecords 2 Tracks  

Dual Omnidirectional Microphones
ecords WAV Files at 16-Bit/44.1 kHz

M100 Stereo Effects
Processor with Reverb, Delay, and More

  »  For Studio and Stage Applications » Stereo or Mono
  » 16 Well-Regarded TC Electronic Effects
  »  Reverb, Chorus, Delay, Phaser, and More
  » Tap/Select Button, and Parameter Knob
  » Impedance-Balanced Outputs » 24-Bit/48 kHz AD/DA

(TCMEP) .............................................................................................. 99.99

H7600 Stereo, Multi-Effects
Processor with Analog and Digital I/O

  » Postproduction and Broadcast Essentials - The Complex Made Simple
  » Midi Virtual Racks- Stacked Effects with Instant Program Change
  » Ultrashifter - The Apex of Pitch Manipulation
  » Copious Sampling with Time Compression/Expansion

(EVH7600) ......................................................................................3,995.00

KP3+
Dynamic Effects/Sampler

  » Manipulate Effects in Real Time
  » XY Touchpad » 150 Effects
  » 4 Sample Banks
  » 8 Program Memories
  » Hold Function » USB MIDI
  »  Store Samples on SD/SDHC Cards
  » Mac OS X » Windows XP/Vista/7/8

(KOKP3PLUS) .................................................................................... 269.50
mini Kaoss Pad 2S (KOMINIKP2S) ........................................Call or Log-On

Dynamic Effects/Sampler

Manipulate Effects in Real Time
ects

USB MIDI
e Samples on SD/SDHC Cards

indows XP/Vista/7/8

R8
Digital Recorder/Interface/Controller/Sampler 

  » 8-Track Recorder
  » Writes to SD Cards
  » 16- or 24-Bit WAV files
  » Integrated Stereo Mics
  » High-Definition USB Interface
  » Full Mixing and Transport Controls
  » 8-Voice Pad Sampler and Sequencer
  » XLR/TRS Combo Inputs with 48V Phantom

(ZOR8) ............................................................................................... 299.99

High-Definition USB Interface
Full Mixing and Transport Controls
8-Voice Pad Sampler and Sequencer

DIGITAL RECODERS / EFFECTS PROCESSORS
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DN-300CMKII
CD/Media Player with Tempo Control 1 RU

  » Plays CD & MP3 Files » Includes IR Remote
  » Random, Repeat & Power-on-Play Modes
  » Supports Removable USB Thumb Drive
  » 10-Key Direct Track Access Buttons
  » XLR & RCA Line Outputs » 1U Rack-Mountable

(DEDN300CMKII) ................................................................................ 199.00

CD-RW900MKII
Professional CD Recorder

  » High-Performance AKM Codec » Digital and Analog I/O
  » Gapless Live Recording » Various Track Division Functions
  » 4-Second RAM Buffer Prevents Skipping
  » Auto Start / Stop Record at Preset Level
  » Fade-In / Fade-Out Recording Function

(TACDRW900MK2) ............................................................................. 399.99

CD-500B
Single-Rackspace CD Player (Balanced)

  » Slot-Loading Mechanism » MP3 and WAV CD Support
  » Stereo XLR & RCA Outputs » Optical & Coaxial Digital Outputs
  » XLR AES/EBU Digital Output » Random and Program Play
  » Wired and Wireless Control Options » Relay Capability
  » Headphone Jack

(TACD500B) .........................................................................Call or Log-On

CD-400U  CD/SD/USB 
Player with Bluetooth and AM/FM Tuner

  » CD-DA, MP3, WMA, and WAV Compatibility
  » Built-In Bluetooth Receiver » SD/SDHC Card Slot and USB Port
  » CD/Tuner-to-USB/SD Dubbing » XLR and RCA Outputs
  » 3.5mm Stereo Aux Input » 1/4" Stereo Headphone Jack
  » Transport and Play Mode Controls » Includes Remote Control

(TACD400U) ....................................................................................... 399.99

CD-A580
Cassette, USB & CD Player/Recorder

  »  Shuffle, Program, All & Single Playback » Cassette Deck, CD 
Player & MP3 Player » Plays Back CDs, Cassettes & MP3s

  »  Record from CD to MP3 & Tape, Tape to MP3 and Line Input to 
Tape & MP3 » Supports CDs, CD-RWs & Data CDs

(TACDA580) .........................................................................Call or Log-On

PMD-300CP
Dual Cassette Deck with USB

  » Convert Tapes to MP3 » Normal and High-Speed Dubbing
  » Dynamic Noise Reduction » Supports Normal and CrO2 Tapes
  » Stereo RCA Inputs and Outputs » USB Output to Computer

(MAPMD300CP) ................................................................................. 149.00

RM-IRD
Internet Radio Player

  » Access to 20,000 Stations and Podcasts
  » Connects to Router via Ethernet or Wi-Fi
  » Easy Setup and Navigation » 2.7" Display » USB Port
  » IR Remote Control » FM with RDS (Radio Data System)
  » Fits into 1 RU Space

(GARMIRD) ........................................................................................ 349.99

TAPE 2 PC USB
Cassette-to-MP3 Converter

  »  Mac/Windows  
Compatible

  » USB 1.1 Connection
  » Dual Cassette Deck
  » Metal / CrO2 Tape Type Selector
  » Converter Software Included » Requires Internet Connection
  » Display Shows Audio Meters and Record and Dubbing Status

(IOTAPE2PC) ...................................................................................... 129.99

PT649D Rackmountable Dual 
Cassette Player 

  »  Normal/High-Speed  
Copy Function

  »  Two Speed Direct- 
Dubbing From Cassette

  » Dynamic Noise Suppression  » Supports CrO2 Tapes
  » Metal and CrO2 Tape Selector  » RCA Inputs and Outputs
  » Rack Mounting Hardware Included 

(PYPT649D) ......................................................................................... 85.48

Tape Express+ 
Portable Tape-to-MP3 Converter

  »  Convert Your Cassette  
Tapes to Digital Files

  »  Comes with EZ Vinyl / Tape  
Converter Software

  » Battery or USB Powered
  »  Load Music Files to Your Mobile Player
  » 1/8” Audio Output » Plays Chrome or Normal Tapes

(IOTEH)................................................................................................ 35.59

our Mobile Player

DN-500BDMKII  1 RU Professional 
Blu-ray Disc and Media Player

  » Supports Blu-ray, DVD, and CD Discs
  » Control over IR Remote, RS-232C, or IP » OLED Display
  » On-Screen Display Hiding Mode
  » Panel Lock and IR Remote Lock
  » Discrete 7.1 Analog Surround Sound Outs

(DED500BDMKII) ................................................................................ 399.00

DN-300BR
1 RU Bluetooth Receiver

  » Stereo Bluetooth 4.0 with aptX Support » Up to 100' Range
  »  Includes 2-Pin Euroblock Connector » Includes Removable 

Bluetooth Antenna » 1 x Stereo XLR / 1 x Stereo RCA
  » Pairs up to Eight Devices
  » Front-Mounted Output Level Knob

(DEDN300BR) .................................................................................... 149.00

CD-200BT
Rackmount CD Player / Bluetooth Receiver 

  »  Bluetooth 3.0 » Register Multiple Bluetooth Devices
  » CD Drive Designed by TEAC » 10-Second Shockproof Memory
  » Plays CDs, CD-Rs, CD-RWs » Plays WAV, MP2, MP3 Data CDs
  » 3.5mm Stereo AUX Input » Coaxial & Optical Digital Output

(TACD200BT) .......................................................................Call or Log-On

CAS1500
Cassette Player & Recorder 

  » Durable ABS Construction
  » Cassette Playback / Recording
  » Integrated Mic and Speaker
  » 2.5mm/3.5mm Remote Mic Inputs
  » 500mW Amplifier  » Volume Control
  » Large, Sturdy Buttons
  » Dual 1/4" Headphone Jacks
  » AC or Battery Power

(CACAS1500) ....................................................................................... 58.76

2.5mm/3.5mm Remote Mic Inputs
olume Control

DN-500CB
CD/USB/Bluetooth Player with Remote

  » Bluetooth 4.0 Paring with 8 Devices
  » Built-In CD Player » USB Port for Flash Drive Playback
  »  MP3, CD-DA, CD-ROM Compatibility » 3.5mm AUX Input for 

Portable Player » 10-Button Direct Track Access
  » RCA & XLR Outputs » Wireless IR Remote Included

(DEDN500CB) .................................................................................... 299.00

DIGITAL RECODERS / EFFECTS PROCESSORS
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Isolation Pad  for Studio Monitor

This monitor speaker isolation pad is made from high-density acoustic foam that is designed to decouple your monitor’s speaker from its 
resting surface by absorbing the monitor’s vibrations. This stops reverberation through the desk or speaker stands. Removing these unwelcome 
vibrations results in greater depth of field, tighter low-end and transient response, and a higher level of detail across the frequency spectrum.

Brand JBL M-AUDIO MACKIE NEUMAN PIONEER DJ PRESONUS TANNOY YAMAHA

Model 305P MKII 308P MKII  AV42 CR3 KH 120 DM-40BT ERIS E5 REVEAL 402 HS5

Pair/Single Single Single Pair Pair Single Pair Single Single Single
Woofer Size 5" 8" 4" 3" 5.25" 4" 5.25" 4" 5"
Power Output 41W 56W 20W 50W 160W 2 x 21W 70W 50W 70W
Input Connector XLR, 1/4" XLR, 1/4" RCA, 1/8" 1/4" & 1/8" TRS, RCA XLR 1/8", RCA, Bluetooth XLR, RCA, 1/4" XLR, 1/4", 1/8" XLR, 1/4"
Volume Control No No Yes Yes No Yes No No No
Headphone Jack No No Yes Yes No Yes No No No
Item Code JB305PMKII JB308PMKII MAAV42XUS MA204402900 NEKH120A PIDM40BTB PRERISE5 TAR402 YAHS5

Price 149.00 249.00 149.00 99.99 699.00 199.00 149.95 139.99 199.99

Brand ADAM ALESIS AVANTONE PRO BEHRINGER FOCAL FOSTEX GENELEC KRK

Model A7X ELEVATE 5 MKII MIXCUBE CLA-10A  
Chris Lord-Alge MS40 TRIO11 BE 6301NE  8010 8030C ROKIT 5 G4

Pair/Single Single Pair Pair Pair Pair Single Single Single Single Single
Woofer Size 7" 5"   – 7" 4" 10" 4" 3" 5" 5.25"
Power Output 150W 40W 60W 200W 40W 550W 20W 25W 100W 55W
Input Connector XLR, RCA 1/4" XLR, TRS XLR, RCA RCA, 1/8”, S/PDIF, Toslink XLR, RCA 1/4" XLR XLR TRS / XLR Combo
Volume Control YES Yes Yes — Yes No Yes No No No
Headphone Jack NO Yes — — Yes No No No No No
Item Code ADA7X ALELEVT5MKII AVABM AVCLA10A BEMS40 FOTRIO11BE FO6301NE GE8010AP GE8030CP KRRP5G4

Price 749.99 149.00 479.00 999.00 179.99 3,999.00 Call or Log-On 295.00 695.00 179.00

Small 7.5 x 11.25” 
(AUIPS) ................... 15.00
Medium 10.25 x 14.5” 
(AUIPM) .................. 16.00

Large 12.75 x 12.75” (AUIPL) ...17.00

Studio Monitors
Monitoring is one of the most important purchases you can make 
for your studio, and B&H offers a large selection to cater to just 
about every scenario and taste. Choose from a variety of active 
(self-powered) or passive (requiring an external amplifier) monitors 
with woofers ranging from 3 to 8”. Available models also provide 
connectivity for RCA, 1/4”, 1/8” XLR, SpeakON, or binding post 
sources, with many models providing integrated volume control.

STUDIO MONITORS
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Monitor Isolation Pads
for Pair of Speakers

Sometimes easy solutions provide benefits  
that far outweigh the cost. In this instance,  
isolating one’s monitors from what they are  
standing on, be it speaker stands or the  
meter bridge of a console, can provide an  
instant improvement in bass response  
and stereo imaging.

(AUMPS) .............................................................................................................................................. Call or Log-On

LMS-355
Studio Monitor Stands

Constructed from steel tubing and a 9” steel plate, these stands are designed  
to support studio monitors at the optimal listening position in professional and  
home recording studios. An ergonomic locking knob secures the stand, and a  
locking pin is inserted into six pre-drilled holes to allow the height of each  
monitor to be adjusted between 35 and 58.5”. The three-leg design has a base  
spread of 23” for stability and a geometry that allows for the stand to fit around  
corners and beside studio furniture. They come with both interchangeable  
rubber feet for hardwood floors as well as metal spike feet for carpeted floors.

(AULMS335) .......................................................................................................................................................... 79.99

IPRS-M Stabilizing Isolation Pad
for Studio Monitors

  » Steel Plate Prevents Speaker Recoil
  » Nonslip Neoprene Holds Speaker in Place
  » Prevents Resonant Coupling
  » Greater Detail across Frequency Spectrum
  » Tighter Low-End and Transient Response
  » Greater Depth of Field » Improved Stereo Imaging
  » 3/4" Down-Fire or Up-Fire Profile » 10.25 x 12.75"

Medium, Single (AUIPRSM) .................................................................................................................................... 69.99

Constructed from steel tubing and a 9” steel plate, these stands are designed  
to support studio monitors at the optimal listening position in professional and  
home recording studios. An ergonomic locking knob secures the stand, and a  

monitor to be adjusted between 35 and 58.5”. The three-leg design has a base  
spread of 23” for stability and a geometry that allows for the stand to fit around  

rubber feet for hardwood floors as well as metal spike feet for carpeted floors.

oved Stereo Imaging

Big Knob Passive
Studio Monitor Controller

  » Two by Two Monitor Controller
  » 2x Sources and 2x Monitor Pairs
  » Classic Big Knob Volume Control
  » Mono, Mute, and Dim Functions
  » Pristine Audio Quality
  » Passive Audio Path » Sturdy Design
  » No Power Supply Needed

(MABKPSMC) ......................................................................................................................................................... 69.99

Big Knob Studio
Monitor Controller and Interface

  » 3x Sources and 2x Monitor Pairs
  » Classic Big Knob Volume Control
  » Independent Trim on All Sources
  » Mono, Mute, and Dim Functions
  » 2x2 USB Recording Interface
  » 24-Bit/192 kHz Recording and Playback
  » Compatible with Windows & Mac Computers
  » Sturdy Design » Includes Tracktion Recording Software

(MABKSMC) .........................................................................................................................................................219.99

ISO-PUCK
Modular Solution for Acoustic Isolation

  » For Monitors, Amplifiers, DJ Gear & More
  » Portable Solution for Decoupling Needs
  » Provides Isolation and Decoupling
  » Improves Focus & Reduces Image Smearing
  » For Use in Studios & on the Stage
  » Suction Cup Design to Improve Isolation
  » 20 lb Weight Capacity per Puck

Pair (ISOPUCK) ...................................................................................................................................................... 59.99

MB5MiniStand
Studio Monitor Speaker Stands (Pair)

  » Wood-Grain Style Finish
  » Heavy-Duty Construction
  » Fit Large Bookshelf Speakers
  » 8" Height
  » Integrated Feet
  » Quad Support for Security and Strength
  » Include Mounting Hardware

Pair (TEMB5MINISTA) ............................................................................................................................................. 49.00

Level Pilot
Analog Stereo Volume Control

  »  Precision Analog Stereo Volume Control at Your Fingertips
  » Stylish Aluminum Construction
  »  Slip-Free Finish and Tight Grip  
Rubberized Bottom Plate

  » Standard XLR Connection
  » No Power Supply Required
  » Quad-Core Cabling for Minimal Clutter

(TCLP) ................................................................................................................................................................... 79.99

ecision Analog Stereo Volume Control at Your Fingertips
Stylish Aluminum Construction

ree Finish and Tight Grip  

M-Patch 2 
Passive Stereo Controller and Switch Box

  » Passive Volume Attenuation
  » Main Inputs: Two Combo XLR-1/4"
  » Aux Inputs: Stereo RCA and 1/8" TRS
  » Outputs: Two Pairs of Balanced XLR
  » Dedicated Volume Knobs for Main and Aux
  » Mono/Stereo Switch and Mute Button
  » Separate Headphone Output with Volume
  » Includes Power Supply for Headphone Amp
  » Includes Rack/Desktop Mounting Hardware

(JBMPATCH2).......................................................................................................................................................134.00

PMC-II
Passive Monitor Controller

  » Precision Oversized Volume Knob
  » For Professional and Consumer Equipment
  » Passive Design Doesn't Affect Sound
  » Balanced XLR/TRS Combo Inputs
  » Balanced XLR Outputs
  » 1/8" TRS Mini Stereo Inputs & Outputs
  » Mute Button » Mono Button » Durable Steel Housing with Wood Panels

(SEPMCII) .............................................................................................................................................................. 99.95

STUDIO MONITORS
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HEADPHONES

HD 280 Pro
Circumaural Monitor Headphones

  » Dynamic, Closed-Back Design
  » Circumaural / Sound Isolating: -32 dB
  » Leatherette Cushions
  » Swiveling Earcups
  » Padded, Adjustable Headband
  » Frequency Response: 8 Hz to 25 kHz
  » Standard 3.5mm Plug with 1/4" Adapter

(SEHD280PQ) ....................................................................................... 99.95

HD 600
Professional Stereo Headphone

  » Open, Dynamic, Circumaural Design
  » Audiophile Sound Reproduction
  » Frequency Response: 12 Hz to 39.5 kHz
  » Acoustic Silk Attenuation
  » Highly Conductive OFC Copper Cable
  » Lightweight Aluminum Voice Coils
  » Works with Portable Audio Devices
  » Compatible w/ SACD, DVD-A & CD Players
  » Includes 1/8 to 1/4" Adapter

*(SEHD600) ....................................................................................... 299.00

HN-7506
Headphones

  » Provides High-Noise Isolation
  » Features Sony MDR-7506 Drivers
  »  Reduces Outside Noise  
up to 45 dB

  »  Customized Internal  
Earpiece Baffling

  »  Includes Screw-On  
1/4" Adapter

(REHN7506) ...................................... 309.99

Circumaural Monitor Headphones

HN-7506

SIH 2
Stereo Isolation Headphones

  » For Live Stage and Recorded Music
  » Padded Cushions & Headband
  » 50mm Dynamic Drivers
  »  20 Hz to 20 kHz Freq. Response
  »  Reduces Overall Noise Levels  
by 25 dB » Protects Hearing  
from Potential Damage

  » 1/4" & 3.5mm Connections

(VISIH2)............................................................................................... 79.99

SRH440   Professional
Around-Ear Stereo Headphones

  » Closed-Back Design
  » Foldable Construction
  » Swivel Earcups
  » Replaceable Around-Ear Cushions
  »  Single-Sided Coiled, 
Detachable Cable

  » 3.5mm Plug with 1/4" Adapter
  » Carrying Bag Included

(SHSRH440) ............................................99.00

K 240 Professional Semi-Open
Stereo Headphones

  » Semi-Open, Circumaural Design
  » Self-Adjusting Headband
  » Patented Varimotion Speakers
  » Thick Around-Ear Cushions
  » Single-Sided Detachable Cable
  » Standard Stereo Mini Plug
  » 1/4” Adapter Included

(AKK240STUDIO) .................................................................................. 69.00 ..................................................................................

HPC-A30   Closed-Back  
Studio Monitor Headphones

  » Studio, Field, Mobile & DJ Applications
  » 50mm Drivers » Pivoting Ear Cups
  » Closed-Back for Isolation
  » Collapsible for Easy Storage
  » Padded Adjustable Headband
  » Single-Sided 9.8' Cable
  » Includes 1/4" Adapter
  » Output Optimized for Mobile Devices

(POHPCA30) ........................................................................................ 29.99

KNS 8400 Closed-Back
Around-Ear Stereo Headphones

  » Adjustable, Padded Spring Steel Headband
  » 40mm Neodymium Drivers
  » Thick Around-Ear Cushions
  » Swivel Earcups
  » In-Line Volume Control
  » Detachable Single-Sided OFC Cable
  » Foldable Design, Carrying Case Included 

(KRKNS8400)...............................Call or Log-On

SMH-1000 Professional
Field & Studio Monitor Headphones

  » Closed-Back, Over-Ear Circumaural Design
  » Rugged Design for Field and Studio Use
  » EQ Curve for Pro Field and Studio Use
  » Collapsible for Easy Storage
  » Soft Replaceable Ear Cushions
  » 10’ Coiled, 3’ Straight Cables Included
  » 1/4” Gold-Plated Adapter Included

(SESMH1000) .........................................74.99

K175
On-Ear, Closed-Back Headphones

  » For Mixing and Monitoring Applications
  » 40mm Transducers
  » 18 Hz to 26 kHz Frequency Range
  » Provides Articulated Bass Response
  » Supra-Aural Design
  » Foldable Earcups with 3-Piece Hinges
  » Includes Coiled Cable and Carry Bag

(AKK175CBHP)................................................................................... 129.00

Closed-Back, Over-Ear Circumaural Design

ATH-M50x
Monitor Headphones

  » 45mm Neodymium Drivers
  » Circumaural, Sound-Isolating Design
  » 90-Degree Swiveling Earcups
  » Single-Ear Monitoring
  » Detachable Single-Sided Cable
  » Includes Straight, Coiled & Short Cable
  » Includes Pouch & Screw-On 1/4” Adapter

(AUATHM50XB) .................................................................................. 149.00

MDR-7506
Headphones

  » 40mm Neodymium Drivers
  »  Closed-Ear Design for Clear, 

High-Quality Sound Reproduction
  » Swiveling Earcups
  » Single-Sided Cable
  » Coiled Cable
  » Protective Storage Soft Case

(SOMDR7506) ......................................................................Call or Log-On

MDR-V6
Stereo Studio Headphones

  » Closed Earcup Design
  » Around-Ear Cushions
  » Padded, Adjustable Headband
  » 3.5mm Plug with 1/4" Adapter
  »  Flexible Coiled Cable  

with 10' Extension

(SOMDRV6) ......................................................................................... 98.00

Stereo Studio Headphones

HPS3000  High-Performance  
Studio Headphones

  » For Studio Use
  » Clear Bass & Transparent Highs
  » 40mm Cobalt Drivers
  » Oval-Shaped Earcups
  » 20 Hz to 20 kHz Frequency Response
  » Single-Sided 6.6' Cable
  » Oxygen-Free Copper Wires for Clarity
  » 1/4" Adapter Included

(BEHPS3000) ....................................................................................... 19.99

TH-02
Studio Headphones

  » Closed-Back Design
  » Designed for Balanced Response
  » 50mm Drivers
  » 32-Ohm Impedance
  » Collapsible Folding Mechanism
  » Padded Headband and Ear Pads
  » Comes with 1/4" Adapter

(TATH02B) ........................................................................................... 17.55

Stereo Isolation Headphones Professional Stereo Headphone

99.00

California Residents   *See our website for Prop 65 warning
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Powerplay HA8000 V2 Headphone
Mixing & Distribution Amplifier

  » For Stage and Studio Applications
  » 8 Independent Stereo Amplifier Sections
  » 2 x Main Stereo Inputs   »  8 Independent Direct Inputs
  » 8-Digit LED Output Meter per Channel
  » Mono/Stereo Switch per Channel
  » TRS Front & Rear Phones Connector

(BEHA8000V2) ................................................................................... 149.99

PM50s
Personal Monitor Amplifier

  »  Personal Monitor Amplifier with  
Microphone Pass-Through

  »  Separate Volume Controls for  
Monitor Feed & Microphone Input

  » Pair of Headphone Outputs
  »  Small Footprint Makes the Unit  

Easy To Use in Difficult Situations

(ROPM50S) ..........................................................................Call or Log-On

HP4
Headphone Distribution Amplifier

  » Four High Power Headphone Outputs
  » Convenient Controls
  »  Separate Volume 

Control, Monitor 
Mute Switch,  
and Mono Switch

  » Modular Add-On    »  4 Channels

(PRHP4) ............................................................................................ 129.95

  4 Channels

HPA-4X2 Reference
Headphone Amp

  » For Pro & Project Studio Applications
  » Durable & Compact Design
  » 1x 1/4” TRS Stereo Input
  » 4 Channels    »  Stereo RCA Inputs
  » 4x 1/4” Stereo Headphone Outputs
  »  Link Feature Daisy-Chains Multiple Units
  » Independent Amp Circuits per Channel    »  Stereo / Mono Switch

(POHPA4X2) ......................................................................................... 39.99
HMA-41 4-Channel Stereo Headphone Amplifier (POHMA41) ................. 29.95 

Headphone Amp

eature Daisy-Chains Multiple Units

E10K USB DAC
Headphone Amplifier
  » Handles PCM Files up to 24-bit/96 kHz
  » Selectable Bass Boost

(FIE10K) ..............................................................................................75.99

Extra Deep Earpads
  » For Senal SMH-1000 & SMH-500 Headphones

  » For Sony MDR-7506 & MDR-V6 Headphones

Pair (AUEDMDR7506) ........................................... 24.95

Headphone Holder 
with Padded Cradle

  » Holds One Pair of Full-Sized Headphones
  » For Horizontal and Vertical Surfaces

(AUCOHH1) .......................................................................................... 19.99

Universal Headphone Case
  »  Rigid EVA Plastic Molding, Soft Interior Nylon 

Fabric, Abrasion-Resistant Nylon Shell

(AUUHC725) .......................................................... 19.95

19.99

1/4” Stereo Adapter
(Screw-On)

  » Male 1/8 to Male 1/4” » Gold-Plated Construction

(PEAMPS3S) ............................................................................2.99

Bass Traveler 
Portable 2-Channel Headphone Amplifier

  » For Two Sets of Headphones
  » Battery-Powered Headphone Amplifier
  » Up to 8 Hour Playback
  » Powers 16- to 100-Ohm Headphones
  » Boost Settings Optimize Sound
  » Compatible with In-Line Remote Controls
  » Micro-USB Charging Cable Included

(MABASSTRAVLR) ................................................................................ 29.00

Handles PCM Files up to 24-bit/96 kHz

PHA40
Stereo Headphone Amplifier

  » Compact and Lightweight Design
  »  Up to 4 Users to Listen to the  

Same Audio Signal 
  » 4 Channels
  » 1/4” Stereo Jacks
  » Individual Level Controls
  » Power LED    »  Power Supply Included

(PYPHA40) ........................................................................................... 19.00

Compact and Lightweight Design
p to 4 Users to Listen to the  

  Power Supply Included

HP12U  12-Channel
Headphone Amplifier with USB

  » 6 x Stereo Output Channels
  » 2 x Headphone Outputs per Channel
  » 2 x Stereo Input Channels  »  Selectable Source Input
  » Volume Control on Each Channel
  » Built-In USB Computer Port

(AKHP12U) ........................................................................................ 149.00

HeadAmp4
Stereo Headphone Amplifier

  » High-Quality Headphone Amplifier
  » Stackable Metal Construction
  »  4 Channels with up to Two  
Users per Channel 

  »  Both 1/4” and 1/8” Connectors  
Are Available for All Ins/Outs 

  » Four Level Control Knobs on the Front Panel

(ARHEADAMP4) ....................................................................Call or Log-On

High-Quality Headphone Amplifier

s  

 QH4
Portable Headphone Amplifier & DAC

  » 4-Channel Stereo Headphone Amplifier
  » 4 Stereo 1/4" Headphone Outputs
  » 4 Discrete Stereo Amplifiers
  » 564mW Per Channel
  »  Separate Volume Control on  
Each Channel

  » Stereo 3.5mm Auxiliary Input & Output
  » Suitable for Studios & Portable Studios

(SAQH4) .............................................................................................. 69.99

m900
Compact, Portable Headphone Amp, DAC, 
and Preamp

  »  Digital Inputs: USB, S/PDIF, TOSLINK
  »  Supports up to 192 kHz 

(TOSLINK: 96 kHz)
  »  Two 0 Ω Headphone Outputs
  » Stereo RCA: Monitoring Control
  » High- and Low-Power Modes
  » DAC Filter Settings for Custom Playback

(GRA900) ........................................................................................... 545.00

HA-400
Headphone Amplifier

  » 4 Independent Stereo Outputs
  » Level Control per Channel
  » Ultracompact
  » Power-On LED
  »  DC 12V Adapter  
Included

(BEHA400) ........................................................................................... 24.99

Headphone Amplifier

4 Independent Stereo Outputs
Level Control per Channel

Storage Pouch  for SMH 
Series Headphones

  » For Safe Storage and Transport
  » High-Quality Leatherette Material

(SESMHPOUCH) ......................................................................................9.99

, TOSLINK
4-Channel Stereo Headphone Amplifier

Stereo 3.5mm Auxiliary Input & Output

HM-4 
4-Way Headphone Amplifier

  »  Distribute Signal to Multiple Headphones
  » 1 x 1/4" TRS Stereo Input
  »  4 x 1/4" TRS Stereo  

Headphone Outputs
  »  Level Control Per Output
  » Power Status Indicator
  »  Compact Heavy-Gauge 

Steel Chassis
(MAHM4) ............................................................................................. 39.99

For all Headphone Amps, 
DACS & Accessories
 SCAN THIS
or visit BandH.com/w15335

HEADPHONE AMPLIFIERS / DACS / ACCESSORIES

Distribute Signal to Multiple Headphones
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AUDIO INTERFACES

U-PHORIA UMC404HD
USB 2.0 Audio/MIDI Interface

  » 4 Inputs/4 Outputs » MIDAS-Designed Microphone Preamps
  » 48V Phantom Power » 24-Bit/192 kHz
  » Headphone Out, Zero-Latency Monitoring
  » Analog Inserts and MIDI I/O » Status, Signal, and Clip LEDs

(BEUMC404HD) .................................................................................. 149.99

USBPre 2
Microphone Interface for Computer 

  » 2-Channel USB Interface
  »  Precision Mic Preamps  

with 48V Phantom 
Limiters, High-Pass  
Filters, and 15dB Pad

  » Dynamic Range Greater than 114dB
  » Flat 10Hz to 40kHz (@ 96 kHz SR) Audio Bandwidth

(SOUSBPRE2) .................................................................................... 895.00

MOTIV MVi
Digital Audio Interface

  »  For Mac, Windows, iPhone,  
iPod, iPad, and Android

  » Single-Channel Class-A Preamp
  » XLR + 1/4" Combo Input »  5 DSP Presets
  »  Phantom Power »  Touch-Panel Control »   Headphone Output
  » 24-Bit/48 kHz »  Micro-USB Type-B to USB Cable
  » Micro-USB Type-B to Lightning Cable

(SHMVIALTG) ....................................................................................... 99.00

Komplete Audio 6
USB 2.0 Digital Audio Interface

  » 6 Inputs / 6 Outputs
  » 2 Microphone Preamps
  » MIDI I/O
  » S/PDIF I/O
  » Phantom Power
  » Zero-Latency Direct Monitoring
  » Includes Software

(NAKA6) ............................................................................................ 239.00

XU-1648
XLR to USB Interface

  » XLR Input to USB Output
  » Microphone Input Level Adjustment
  » Switchable 48V Phantom Power
  » Monitoring with Balance Adjustment
  » 1/8” Headphone Output with Level Control
  » Zero-Latency Monitoring » Peak Level Indicator
  » Rugged Metal Chassis » USB Cable Included

(SEU1648) ........................................................................................... 89.00

1/8” Headphone Output with Level Control
eak Level Indicator

USB Cable Included

SERIES 102i
USB Audio/MIDI Interface

  » 10 Inputs and 2 Outputs
  »  2 Low-Noise Ultra-HDDA  
Mic Preamplifiers

  »  Optical S/MUX for  
8-Channel Expansion

  »  Two 1/4" Outputs + Dual Headphones Out » High-Speed USB 
2.0 Computer Interface » 24-Bit / 192 kHz » Reverb, Comp, 
4-Band EQ, Phase Invert » Flexible DSP Input/Output Mixer

(TAS102I) .......................................................................................... 399.99

Studio 24c
2x2 USB Type-C Audio/MIDI Interface

  »  Bus-Powered USB  
Type-C Interface

  »  XMAX-L Solid-State  
Mic Preamps

  »  Up to 24-Bit / 192 kHz Resolution » 2 x XLR-1/4" Mic 
Instrument/Line Inputs » 2 x Balanced 1/4" Main Outputs

  » Dedicated Headphone & Main Output Levels
  » Rear-Panel MIDI I/O » Includes DAW Software & Plug-In Suite

(PRSTUDIO24C) ................................................................................. 149.95

XLR-USB-48
XLR to USB Audio Interface

  » Connects XLR Mic to USB
  » Selectable 48V Phantom Power
  »  Plug-and-Play with  

No Drivers Needed
  »  1/8" Headphone Output  

with Level Control
  » USB Cable Included

(POXLRUSB48) ..................................................................................... 44.99

AudioFuse
14x14 Audio Interface

  » 14 Inputs and 14 Outputs
  » Two Line/Instrument Inputs
  » Two Analog Inserts
  » ADAT, S/PDIF, and Wordclock
  » Two Phono RIAA Preamps with Ground
  » Two DiscretePRO Microphone Preamps
  » 24-Bit / 192 kHz » 3-Port USB Hub
  » PC, Mac, iOS, Android, and Linux

Gray (ARAFSG) ................................................................................... 599.00

Icicle
USB Microphone Interface

  »  The Icicle USB converter and mic preamp  
lets you connect your XLR microphone  
directly to your computer via USB. 

  »  With 48V phantom power, you can even  
connect premium studio condenser mics.

(BLICICLE) .......................................................................59.99

Studio 1824c
18x20 USB Type-C Audio/MIDI Interface

  »  USB Type-C Computer Interface » XMAX Class-A Microphone 
Preamps » Up to 24-Bit / 192 kHz Resolution » 8 x XLR-1/4" 
Combo Inputs » 8 x 1/4" TRS Line Outs, Stereo Main Outs

  »  2 x 1/4" Stereo Headphone Jacks » Dedicated Headphone & 
Main Output Levels » ADAT, S/PDIF & MIDI I/O, Wordclock Out

(PRSTUDI1824C) ................................................................................ 499.95

AXE I/O  Audio Interface with 
Advanced Guitar Tone Shaping

  »  Font-Panel 1/4" Hi-Z 
In and Amp Out

  »  2 Combo XLR/1/4" 
Mic Instrument 
Inputs » 4 TRS Balanced Line Outputs » +48V Phantom Power

  » Reference-Quality Headphone Output » MIDI Input and Output
  » 2 Configurable Inputs for Pedals
  » Monitor/Master/Headphone Volume Controls

(IKIPINTAXEIO) ................................................................................... 349.99

wo Phono RIAA Preamps with Ground
wo DiscretePRO Microphone Preamps

iRig Pre
Microphone Interface

  »  Connect Any Type of Mic to  
iOS Device

  »  Compatible with iPhone 
iPod Touch/iPad

  » 3.5mm Headphone Output for Monitoring
  » Built-In Connector Cable
  » Gain Control
  » Includes 2 Free Apps

(IKIRIGPRE) ......................................................................................... 39.99

M-Track 2X2
USB Audio Interface

  » 2 Inputs / 2 Outputs
  » Combo XLR/TRS Mic/Line Input
  » Instrument Input
  » Headphone Output
  » Zero-Latency Monitoring
  »  Standard USB and  

USB Type-C Connection Cables
  » Phantom Power »  24-Bit/192 kHz Resolution

(MAMTRACK2X2) .................................................................Call or Log-On

Combo XLR/TRS Mic/Line Input

USB Type-C Connection Cables

Cello
22-Input, 4-Output USB 2.0 Interface  
for Mac and PC

  »  2 x Mic inputs
  » 2 x Balanced Line Inputs
  » 16ch of ADAT Digital Input
  » 2 x Balanced Outputs
  » SPDIF Digital Output
  »  Class Compliant USB 2.0 Interface to MAC/PC
  » MIDI in / MIDI Out » Talkback Mic Built In

(JOCELLO) ......................................................................................1,125.00

22-Input, 4-Output USB 2.0 Interface 

 Class Compliant USB 2.0 Interface to MAC/PC
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Scarlett 6i6
USB Audio Interface (2nd Generation) 

  »  4 Redesigned Inputs
  »  2 Balanced Outs,  

4 Line Outs
  » MIDI and S/PIDF I/Os
  » Independent Headphone Outputs » 48V Phantom Power
  »  24-Bit/192 kHz with Lower Latency » Software Bundle & Ableton 

Live Lite » Includes Pro Tools | First with Extras
  » Downloadable iOS Remote Control App » Mac OS X & Windows

(FOS6I62G) ........................................................................................ 269.99

4pre Compact
Hybrid FireWire/USB Audio Interface

  » 4 Microphone Preamps
  » 6 Inputs / 8 Outputs
  » 8-Bus Digital Mixer
  » Digital I/O
  » Phantom Power
  » Time Code Support » 24-Bit / 96kHz
  » Standalone Operation » Mac OS X » Windows Vista/7

(MA4PRE) .......................................................................................... 449.00

Sono   USB Audio Interface 
For Electric Guitar Players
  » For Live, Studio & Rehearsal Use
  »  High Speed USB 2.0 Computer  

 Interface » 3-Knob Tone  
Stack & 12AX7 Tube

  » Authentic Amp/Cab Sim via Two Notes
  »  Feed the PA at Live Gigs » Silently Practice  

with Headphones » ADAT In: Record up to 10 Channels
  » XLR-1/4" Inputs with +48V Phantom Power

(AUSONO) .......................................................................................... 449.00

UltraLite-mk 4
18x22 USB Audio Interface with DSP

  » 192 kHz/24-Bit Recording
  »  18 Inputs, 22 

Outputs
  »  8 Analog Audio 

Inputs & Outputs
  » 8 Line Outputs, Main Outs & Headphones
  » S/PDIF, Optical, MIDI I/O » Onboard 32-Bit DSP
  » 48-Channel Mixer with Onboard Metering

(MAULMK4) ....................................................................................... 595.00

iTrack Solo (Lightning) USB 2.0 
Audio Interface for Compatible iPad, Mac & PC
  »  2 Inputs/2 Outputs
  » Microphone Preamplifier
  »  XLR/TS Microphone/ 

Instrument Input
  » RCA Unbalanced Monitor Outputs
  »  Direct Monitor Switch, LED Signal Halos » Up to 24-bit/96 kHz 

Audio Resolution » Ableton Live Lite Software
  » Focusrite Scarlett Plug-In Editing Suite » Mac OS X, Windows 7

*(FOMOIS0010) ................................................................................. 129.99

Arrow
2x4 Thunderbolt 3 Audio Interface

  » High-Speed Thunderbolt 3 Interface
  » Unison Mic Preamps
  » 192 kHz / 24-Bit
  » 2x Combination XLR-1/4" Inputs
  » 1/4" Instrument Inputs
  » 2x 1/4" Monitor Outputs
  »  1/4" Headphone Output » Bus Powered  
over Thunderbolt 3 » Near-Zero Latency Performance

(UNARROW) ....................................................................................... 499.00

Babyface Pro
USB Bus-Powered Audio Interface

  » 12 Analog Inputs, 12 Analog Outputs
  » 3.5mm and 6.3mm Headphone Outputs
  » TOSLINK I/O    » FPGA Chip for DSP
  » Integrated XLR Socket
  » SteadyClock Jitter Reduction
  » MIDI I/O via Included Breakout Cable
  » Class Compliant for Mac, PC, Linux & iPad

(RMBFP) ........................................................................................... 749.00

12 Analog Inputs, 12 Analog Outputs
3.5mm and 6.3mm Headphone Outputs

FPGA Chip for DSP

MIDI I/O via Included Breakout Cable
Class Compliant for Mac, PC, Linux & iPad

VRS8 8-Channel Interface  
with Included Software

  »  8-Channel Interface with Linear Response » 124 dB Dynamic 
Range » Offers 0.7 ms Latency across Platforms

  » AKM AK5578 Converter Chips » XTC Clocking
  »  Preamp & Microphone Emulations » Included 1-Year Everything 

Bundle » Software Compatible with Mac & Windows
  » Operates in VST, AU & AAX Formats

(SLSDVRS8K04) ..............................................................................1,999.00

RODECaster Pro
Studio-Quality USB Audio Interface

  » Podcast Studio in a Box
  »  4 Broadcast-Quality XLR  
Mic Inputs, +48V

  » 8 Faders to Control Audio Levels
  »  Onboard & USB Multitrack  
Recording » Mix-Minus for Phone  
Call Interviews » APHEX Processing for Rich & Warm Voice

  » 4 Headphone Outputs » 8 Programmable Pads for Instant Sound FX

(RORDECSTRPRO) .............................................................................. 599.00

AXR4T  28x24 Thunderbolt 
Audio Interface with RND Silk Circuitry

  »  384 kHz / 32-Bit Thunderbolt 2 » 4 x 1/4"-XLR Inputs for  
Mic/Line/Hi-Z » Rupert Neve Silk Processing on Preamps

  » Add Subtle Saturation to Front-Panel Ins » AES & ADAT Optical I/O
  »  2 System Expansion Ports » Internal SSPLL Clocking » BNC 

Wordclock I/O » Low Latency via SSP3 DSP Chip

(STAXR4T) ......................................................................................2,799.99

Element 24  10x12 Thunderbolt
Audio I/O Box for Mac

  »  High-Quality  
AD/DA Conversion

  » 24-Bit / 192 kHz
  »  Boutique-Quality  

Microphone Preamps
  » 2x Analog Inputs & 4x Analog Outputs
  »  Wordclock Input and Output » Thunderbolt Connection to 

Mac » Includes Apogee Control Software

(APELEMENT24) ................................................................................. 595.00

Duet  USB Audio Interface for iPad, 
Mac & Windows 10

  »  2 Inputs / 4 Outputs
  » 2 High-Gain Microphone Preamps
  » Phantom Power
  » Soft Limit
  » Full Color OLED Screen
  » Multifunction Controller Knob
  » Maestro 2 Software for Mac and iOS
  » Includes PC-Compatible Maestro Software

(APDUETMACIOS) ............................................................................... 649.00

Microphone Preamps

Rubix22
2x2 USB Audio Interface

  » 2 Inputs / 2 Outputs
  »  2 Low-Noise Mic Preamps,  

48V Phantom
  » Hi-Z Input for Guitar
  » 24-Bit/192 kHz Resolution
  » Powered via USB » Includes Ableton Live Lite
  » MIDI I/Os » Mac OS, Windows & iPad Compatible

(RORUBIX22) ..................................................................................... 149.99
Rubix24 2x4 USB Audio Interface (RORUBIX24) ........................... 199.99

2x2 USB Audio Interface

Scarlett 2i2
USB Audio Interface (2nd Generation)

  »  2 Scarlett Inputs and 
2 Outputs

  » Powered via USB
  » Line/Instrument Switches » Independent Headphone Output
  » 48V Phantom Power » 24-Bit/192 kHz » Direct Monitoring
  » Included Internal Mixer Software » Included Software Bundle

*(FOS2I22G) ...................................................................................... 159.99
Scarlett 2i2 with Recording Accessories Kit (FOS2I2K2) ............. 259.95

High-Speed Thunderbolt 3 Interface

RCA Unbalanced Monitor Outputs

For Electric Guitar Players
For Live, Studio & Rehearsal Use

Authentic Amp/Cab Sim via Two Notes
Silently Practice  

AUDIO INTERFACES

California Residents   *See our website for Prop 65 warning

Studio-Quality USB Audio Interface

8 Faders to Control Audio Levels

Mix-Minus for Phone  

26c
2x4 USB Type-C Audio/MIDI Interface

  »  Bus-Powered USB 
Type-C Interface

  »  XMAX-L 
Solid-State 
Microphone Preamps

  » Up to 24-Bit / 192 kHz Resolution
  » Two XLR-1/4" Mic/Instrument/Line Inputs
  » Four Balanced 1/4" Line Outputs

(PRSTUDIO26C) ................................................................................. 199.95

Microphone Preamps
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KEYBOARD CONTROLLERS

Brand Model # of
Keys

Keyboard
Type Aftertouch Arpegiator Rotary 

Encoders Faders Includes 
Software Grid Button 

Encoders Pads Transport iOS
Dock

CV/
Gate

MIDI
I/O SKU Price

Acorn Instruments Masterkey 61 61 Synth Action ✓ ✓ ✓ ✓ (ACMK61) 99.00

Alesis Vortex Wireless 37 Synth Action ✓ ✓ ✓ ✓ ✓ ✓ (ALVORTEXWIR2) 299.00

Akai MPK mini MKII 25 Synth Action ✓ ✓  ✓ ✓  ✓ (AKMPKMINIWHI) 99.00

Akai LPK25 25 Synth Action ✓ (AKLPK25) Call or 
Log-On

Akai MPK mini 2 25 Synth Action ✓ ✓ ✓ (AKMPKMINI2) 99.00

Akai APC Key 25  25 Synth Action ✓ ✓ ✓ (AKAPCKEY25) Call or 
Log-On

Alesis V25 25 Synth Action ✓ ✓ ✓ (ALV25) 84.95

Arturia Key Step 32 Slim Key ✓ ✓ (ARKSCS) 119.00

Arturia MiniLab Mk II 25 Synth Action ✓ ✓ ✓ ✓ ✓ (ARMINILABMK2) 99.00

CME Xkey37 LE 37 Velocity-Sensitive ✓ ✓ (CMXKEY37LE) 179.00

CME Xkey-Silver 25 Synth Action ✓ (CMXKEY25AI) 199.99

IK Multimedia iRig KEYS Pro 37 37 Synth Action ✓ ✓ (IKIRIGKEYPRI) Call or 
Log-On

Kawai VPC1 88 Hammer Action ✓ (KAVPC1) 1,849.00

Keith McMillen QuNexus  25 Smart Senso ✓ ✓ (KEK708) 179.00

Keith McMillen K-Board Pro 4 48 Smart Sensor ✓ ✓ (KEK919) 599.00

Korg naoKEY Studio 25 Push Button ✓ ✓ ✓ ✓ (KONANOKEYST) Call or 
Log-On

M-Audio Oxygen 25 IV 25 Synth Action ✓ ✓ ✓ (MAOG25) Call or 
Log-On

M-Audio Oxygen 49 IV 49 Synth Action ✓ ✓ ✓ (MAOG49) Call or 
Log-On

Native Instruments KoMplete Kontrol S61 25 Synth Action ✓ ✓  ✓ ✓ ✓ (NA24797) 729.00

Native Instruments KoMplete Kontrol S88 MK2 88 Hammer Action ✓ ✓  ✓ ✓ ✓ (NAKKS88MK2) 1,039.00

Nektar Technology GX49 49 Synth Action ✓ ✓ ✓ (NEGX49) 99.99

Nektar Technology Impact LX25 25 Synth Action ✓ ✓ ✓ ✓ (NEIMPACTLX25) 99.99

Nektar Technology Panorama P6 61 Semi-Weighted ✓ ✓ ✓ ✓ ✓ (NEPANORAMAP6) Call or 
Log-On

Novation Launchkey MK2 49 49 Synth Action ✓ ✓ ✓ ✓ ✓ (NOLNCKY49MK2) 199.99

Novation Launchkey-Mini MK2 25 Synth Action ✓ ✓ ✓ (NOLNCHKYMNK2) 99.99

Roli Seaboard Block  25 Keywave ✓ ✓ (ROL001142) 299.95

Roli Seaboard RISE 25 25 Keywave ✓ ✓ (ROSBR25) 799.95

StudioLogic SL73 73 Hammer Action ✓ (STSL73STUDIO) 499.95

Keyboard Controllers
B&H stocks a wide variety of keyboard controllers for 
hands-on control of your virtual instruments or 
external synth hardware. Available in 25 to 88 
key  variations, with keybeds ranging from synth 
action (spring loaded) to semi-weighted / weighted, 
many models also feature rotary and button encoders, 
faders, transports controls, and pads. MIDI I/O ranges from traditional 
5-pin DIN connections to USB.

California Residents   *See our website for Prop 65 warning

B&H stocks a wide variety of keyboard controllers for 

action (spring loaded) to semi-weighted / weighted, 
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Touché MIDI / CV  
USB Control Surface with Lié Software 

  »  Expressive and Intuitive Controller
  » 4 x Independent Expression Shifting
  » Force Feedback and Sensitivity Settings
  » 4 CV/Gate Outputs + MIDI Input & Output
  » Configurable CV Signal Curve
  » Configurable MIDI CC Messages
  » Lié Software - Editor & Preset Manager
  » Includes UVI Workstation Plug-In

(EXXPETOUCHE1) ............................................................................... 399.00

BeatStep Pro
MIDI/Analog Controller and Sequencer
  »  16x Projects with 
16x2 Melodic 
Sequences

  »  16x Drum Sequences 
& Controller Maps

  » 16x Touch-Sensitive Rotary Encoders
  »  16x MIDI Controller & Sequencer Presets
  »  16x Velocity- and Pressure-Sensitive Pads

(ARBSP) ............................................................................................ 249.00
Beatstep Controller & Sequencer (ARBEATSTEP) ........................ 99.00

Platform Nano  DAW Control 
Surface with Motorized Fader

  »  USB 2.0 High-Speed  
Connectivity

  »  Compact, Durable &  
Portable » Touch-Sensitive  
Motorized Fader

  » 5 x Rotary Encoder Knobs
  »  Channel, Function & Transport Buttons » Backlit LCD & Illumi-

nated Buttons » Multi-Segment LEDs for Time & Values
(ICPLTFRMNANO) ............................................................................... 199.99

Artist Mix
Touch-Sensitive Fader Control Surface

  »  8 Touch-Sensitive 
Motorized Faders

  »  8 Touch- 
Sensitive Rotary Encoders

  » 8 Knob Select/On Keys
  » Solo/Mute/Transport Keys   »  Record/Automation Keys
  » 8 OLED Displays   »  Footswitch Jack

(AVMCMIX) ........................................................................................ 995.00

Sensitive Rotary Encoders
8 Knob Select/On Keys

nanoKONTROL2
Slim-Line USB MIDI Controller

  » 8 Faders
  » 8 Knobs
  » 24 Switches
  » Transport Controls
  » Marker, Cycle, Track Buttons
  » iPad Support » Software Instrument Licenses
  » Mac OS X, Windows XP/Vista/7

(KONKC2W) .........................................................................Call or Log-On

Launch Control XL
Controller for Ableton Live (Black)

  » Total Integration with Ableton Live
  » 24 Knobs w/Multicolor Indicators
  » 16 Multicolor Buttons + 8 Faders
  » Ableton Live and Loopmaster Samples
  » Customize via Included Software Editor
  » USB-MIDI Compliant + HUI Compliant
  »  USB Bus Powered » Mac, Windows » Free Plug-Ins from Sound 
Collective » Performance Lessons from Melodics

(NOVLPD10)....................................................................................... 159.99

RAVEN MTZ
43" Multitouch Control Screen 

for Pro Audio Applications

  »   Control Faders, Pans, 
Plug-Ins & More

  » No-Bezel Display
  » 1 .5" Deep, 

Low-Profile Design
  » HD Resolution (1920 x 1080)
  » 10-Touch Display and Gestural Control

(SLRAVENMTZ)................................................................................2,999.00

Ableton Live and Loopmaster Samples
Customize via Included Software Editor
USB-MIDI Compliant + HUI Compliant

Maschine Jam
Production and Performance System
  » 8x8 Multicolor Click-Pad Matrix
  »  Note Input, Step Sequencer, 
Pattern Jam   »  Sequence 8 Sounds 
Simultaneously   »  Eight Dual-Touch 
Smart Strips   »  Play Melodies 
and Chords   »  One-Touch Pattern 
and Scene Sequencing   »  Over 8GB of Maschine Library Content

  » Komplete 11 Select with 25GB of Content

(NAMJ) .............................................................................................. 299.00

Console 1 MKII
Hardware & Software Mixer

  » Works with UAD Plug-Ins
  »  Controls Apollo Console  

Software   »  Works with  
Softube Plug-Ins

  »  Analog Modeling and  
Hands-On Control   »  Emulated SSL 4000 E-Series Channel Strip

  » Improved LEDs over Original   »  AAX, VST, AU Plug-In Formats
  » Mac & Windows Compatible

(SOCNSOLE1MK2) .............................................................................. 549.00

FaderPort PV2
Single-Fader USB Control Surface

  » Touch-Sensitive 100mm Motorized Fader
  » Large 360-Degree Push-Button Encoder
  » Transport & Automation Controls
  » Solo, Mute & Marker Controls
  » Record-Enable, Pan & Loop Controls
  » Supports Control Link & Parameter Follow
  » Native Studio One, HUI & Mackie Control
  » USB 2.0 Interface, Mac & Windows
  » Includes Studio One Artist

(PRFPV2)........................................................................................... 199.95

APC40 mkII Ableton Live 
Performance Controller 

  » Perfect Integration with Ableton Live
  » 5 x 8 Clip-Launch Matrix
  » 9 Faders
  » 8 Control Knobs
  » Assignable A/B Crossfader
  »  Downloadable Music  

Creation Software
  » Mac OS X   »  Windows

(AKAPC40MK2) .................................................................................. 299.00

X-TOUCH ONE
Universal Control Surface

  » Hands-On DAW Control with Overlays
  » HUI & Mackie Control Protocols
  »  Touch-Sensitive 100mm Motorized  

Fader   »  LCD Scribble Strips for  
Track Display   »  Rotary Control 
with LED Collar

  » Jog/Shuttle Wheel + Transport Controls
  » 8-Segment LED Meter   »  34 Dedicated Illuminated Buttons

(BEXTOUCH)....................................................................................... 479.99

Hands-On DAW Control with Overlays

ouch-Sensitive 100mm Motorized  

Jog/Shuttle Wheel + Transport Controls

Lightpad Block M  Wireless 
Illuminated Tactile Control Surface

  » Versatile "Space-Age" Touch Controller
  » Grid Modes: 2x2, 4x4 & 5x5
  » Redesigned Surface
  »  Five Dimensions of  

Touch (5D Touch)
  » Strike, Glide, Slide, Press & Lift
  »  Wireless MIDI over Bluetooth   »  Record and Perform Drum and 

Melody Loops   »  Add Live and Loop Blocks for Control
(ROL001591) ..................................................................................... 199.95

Versatile "Space-Age" Touch Controller

Strike, Glide, Slide, Press & Lift

Force   Standalone Music 
Production/DJ Performance 

  » Standalone - No Computer Needed
  »  Full-Color Multitouch  

Display: 7" » M64 Velocity- 
Sensitive Pads (8x8 Grid)

  »  8 Q-Link Encoders with  
OLED Displays

  » 6 Track Types for Audio, MIDI, CV
  »  Advanced Performance Modes » M16GB of Storage with 10GB 

Content » M2 Mic/Inst/Line Inputs and 4 Outputs
(AKFORCEXUS) ................................................................................1,499.00

Standalone - No Computer Needed

6 Track Types for Audio, MIDI, CV

4 CV/Gate Outputs + MIDI Input & Output

Push 2
USB Software Controller

  »  Completely Redesigned  
Hardware Interface

  »  11 Touch-Sensitive 
Encoders

  » Live 9 Intro Software
  » 64 Velocity- and Pressure-Sensitive Pads
  » 2 Assignable Footswitch Inputs » Mac & Windows

(ABAP2USBSWC) ............................................................................... 799.00

64 Velocity- and Pressure-Sensitive Pads

CONTROLLERS

California Residents   *See our website for Prop 65 warning

Touch-Sensitive  
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MUSIC SOFTWARE

For a full listing of all 
Music Software
 SCAN THIS
or visit BandH.com/w15296

If you’re going to create, compose, pro-
gram, mix, or master music on a com-
puter, you’ll need music production 
software. Any piece of said software 
is usually referred to as a DAW (digital 
audio workstation), and different DAWs 
have different inherent usages. One 
might be more suited for the recording, 
mixing, and editing processes (think Avid 
Pro Tools or Steinberg Cubase), while 
another might be more geared towards 
the manipulation and instantaneous 
creation of electronic music, either for 
live performances or for programmatic 
recordings (Ableton Live and Propeller-
head’s Reason come to mind). Others 
still are often used in the composing 
and mixing of film (Motu’s Digital Per-
former). Whether you choose to use the 
aforementioned DAWs or something like 
FL Studio or Bitwig Studio, the decision 
is ultimately a personal one; whichever 
DAW you utilize will shape your work-
flow, enable certain parameters while 
curtailing others, and affect your overall 
creative output. So make sure the DAW 
you go with gives you what you want in 
terms of track count, rewire capability, 
MIDI import/export options, hardware 
connectivity (MIDI and analog), and sys-
tem compatibility.

MUSIC PRODUCTION SOFTWARE

If you are working under a budget and 
your track requires an analog-style 
synthesizer or symphony orchestra, 
you’ll want to stock up on virtual 
instruments. Native Instruments has 
products to suit any occasion, most 
notably within their Kontakt engine, 
which can trigger orchestral libraries 
from developers such as Spitfire Audio, 
Chris Hein, and more. Moreover, their 
Massive synth gives you both micro and 
macro control over sounds for EDM, 
hip hop, and other genres. Kontakt, 
Massive, and many more are available 
in their Komplete bundle. Also, be sure 
to check out Spectrasonic’s Omnisphere 
2 and KV331 Audio’s SynthMaster, both 
of which give you an array of cinematic 
sounds. For the analog purists out 
there, u-he has quite a few vintage synth 
recreations, including ACE, Bazille, and 
Diva. If it’s a comprehensive slate of 
bass timbres you’re after, Spectrasonic’s 
Trillian more than fits the bill. Finally, 
for drum programming, we carry 
FXpansion’s BFD and Geist, the former 
being a superstar for acoustic drum 
triggering, the latter giving you a prime 
selection of sampled hits.

VIRTUAL INSTRUMENT PLUG-INS

For equalizers, check out the FabFilter Pro 
Q 2, which is a linear phase EQ plug-in with 
mid capabilities, 24 assignable bands, an 
intuitive interface, and a bevy of bells and 
whistles. As for dynamics processors, B&H 
has a virtual ton of bundles (Waves, UAD, 
and McDSP are all excellent) and single 
downloads to boot (The elysia mpressor and 
alpha compressor come to mind, as do the 
Pro C, Pro L, and Pro MB from FabFilter). To 
introduce some dirt, grit, and character into 
your signal, try out a channel strip for a vin-
tage combination of EQ and compression; 
the BOZ DIGITAL +10 db and Softube Tube-
Tech Classic Channel are both excellent for 
this purpose. Onto the ambiance: Waves 
and UAD have several reverb modules, the 
Lexicon PCM Native Reverb Bundle, which 
gives you seven models of classic Lexicon 
digital verbs. Your DAW’s onboard delay 
will usually add the space that echo can 
provide, but if character is your goal, check 
out Waves’ H-Delay and Boz Digital Lab’s 
Imperial Delay, both of which have extend-
ed features to mangle up your signal in a 
most pleasing manner. For pitch correction, 
try the Melodyne 4—the only plug-in to be 
name-dropped in a pop song. Guitar ampli-
fier/cabinet emulations are also worth pur-
suing: IK Multimedia’s AmpliTube and Posi-
tive Grid’s BIAS are great places to start.

VIRTUAL PROCESSOR PLUG-INS



297www.BandH.com

PRO AUDIO

Kaossilator Pro+ Dynamic Phrase
Synthesizer/Loop Recorder

  » Freely Playable Synthesizer
  »  XY Touchpad » Play Notes &  

Manipulate Sound in Real Time
  » Gate Arpeggiator » USB MIDI
  » 4 Infinitely Stackable Loop Banks
  » 250 Sounds » Choice of 35 Scales
  » Mac OS X » Windows XP/Vista/7/8

(KOKOPP) .......................................................................................... 309.50
mini Kaoss Pad 2S (KOMINIKP2S) ....................................Call or Log-On

Volca Modular
Micro Modular Synthesizer

  »  West Coast Style Synthesis
  » Analog Synthesis Engine
  »  Single Part, 3-Note  

Polyphony » 2 VCO, 2 EG,  
2 LPG, Digital Effect

  » 8 Individual Modules
  » 50 Patch Points » 16-Step Sequencer with 16 Patterns
  » Sync I/O and CV Control Inputs (2) » Includes 6 x AA Batteries

(KOVOLCAMODUL) .............................................................................. 199.99

Synthesizer/Loop Recorder

Choice of 35 Scales
indows XP/Vista/7/8

PO-33  KO Pocket Operator  
Micro Sampler

  » 40 Seconds of Sample Memory
  » Built-In Microphone for Recording
  » 8 Melodic Slots and 8 Drum Slots
  »  16 Effects » 16-Step Sequencer  
with 16 Patterns

  » Built-In Speaker and 3.5mm Audio I/O
  »  Jam Sync with Audio Through » Easy Data Backup, Restore, and 
Transfer » Folding Stand » Powered via Two AAA Batteries

(TE010AS033) ...................................................................................... 89.00

Theremini
Synthesizer Module

  »  Pitch Correction with Selectable Scales » Built-In Tuner  
for Learning Pitch » 32 Wavetable-Based Presets

  »  Built-In Speaker and Two 1/4” Outputs » Single-Pitch CV  
Output with Range » Adjustable Stereo Ping-Pong Delay

  » 3/8” Mic Stand and Camera Stand Adapter
 » User-Selectable Scale and Root Note
  » Removable Pitch Antenna

(MOTHEREMINI) ................................................................................. 319.00

Theremini
Synthesizer Module

ection with Selectable Scales » Built-In Tuner  
 32 Wavetable-Based Presets

er and Two 1/4” Outputs » Single-Pitch CV  
 Adjustable Stereo Ping-Pong Delay

3/8” Mic Stand and Camera Stand Adapter
-Selectable Scale and Root Note

319.00

Mother-32
Semi-Modular Analog Synthesizer

  »  100% Analog  
Sound Engine

  »  VCO with Square  
and Saw Waveforms

  »  LFO with Square and  
Triangle Waveforms

  » Classic Moog Filter: Switchable LP/HP
  » Records Note, Glide, Gate Length, Accent

(MOM32) ........................................................................................... 599.00

Semi-Modular Analog Synthesizer

Analog Heat
Tabletop Stereo Analog Sound Processor with 
DAW Integration

  »  Analog Distortion, Filter, & EQ
  »  Eight Stereo Analog 

Distortion Circuits
  » 2-Band Stereo EQ
  » Stereo Analog Multimode Filter
  » Envelope Generator / Follower » 128 User Presets
  » Assignable LFO » 2-In / 2-Out USB Audio Interface

(ELHFX1) ............................................................................................759.00

DJS-1000  Standalone  
DJ Sampler (Black) 

  » 24-Bit/44.1 kHz Compatibility
  » 7" Full-Color LCD Touchscreen
  » Step Sequencer
  » 16 x Multicolor Performance Pads
  » Touch Strip Effects
  » USB Ports: Type-A & Type-B
  » Pro DJ Link LAN Connection » Live Sampling with Auto-Sync
  » Loopmasters Sample Library: 2500 Samples

(PIDJS1000) ........................................................................Call or Log-On

Circuit Mono Station
Paraphonic Analog Synthesizer and Sequencer

  » Based on the Novation Bass Station II
  » Three Sequencer Tracks
  » 4 x 8 Grid of RGB Sequencer Pads
  » CV, Gate, and Modulation Outputs
  » Monophonic and Paraphonic Modes
  » Audio Filter Input for Processing
  »  Individually Controlled Oscillators » Includes Circuit Components 
Software » Includes Ableton Live Lite 9

*(NOCIRCUITMON) ............................................................................. 499.99

SKULPT
Virtual Analog Synthesizer (Black)

  » 4 Discrete Polyphonic Voices
  » 32 Oscillators (8 per Voice)
  » 2-Pole Morphable Filter
  » 2 LFO's, 3 Envelopes
  »  8 Modulation Slots,  
37 Destinations

  »  128-Note Sequencer, Arpeggiator » Delay and Waveshaping Distor-
tion FX » Runs on 6 AA Batteries » MIDI I/O and MIDI Over USB

(MOMDLSKULPT) ............................................................................... 299.00

4 Discrete Polyphonic Voices
32 Oscillators (8 per Voice)

Joue Essential Pack  Modular MIDI MPE 
Controller with 5 Modules
  » Includes Joué Board with 5 Magic Modules
  »  Scaler, Fretboard, Pads,  
Area, & Strips

  »  Highly Sensitive Polyphonic  
Sensor » Captures Very  
Subtle Pressure Changes » Multidimensional Polyphonic Expression

  »  Holds Up to Three Optional Modules » Joué Editor for Module Con-
figuration » USB Type-C Powered » Includes USB Type-C Cable

(JOESSENTIALP).................................................................................. 479.00

Digitone  8-Voice 
Digital FM Synthesizer and Sequencer

  » 4x Synth Tracks » 4 x MIDI Tracks
  » Multimode Filter per Voice
  » Base-Width Filter per Voice
  » Overdrive per Voice
  » 2x Assignable LFOs per Voice
  » Chorus, Delay, and Reverb Send Effects
  » High-Speed USB 2.0 Port » MIDI In, Out, Thru, and DIN Sync
  » Overbridge Compatibility

(ELDIGITONE) ..................................................................................... 749.00

Uno Synth
Portable Monophonic Analog Synthesizer 

  »  True Analog Synthesizer
  »  Highly Portable: Battery  

or USB Powered
  » 2 x VCO with Noise Generator
  »  2-Pole Multimode Filter:  

LP, HP, BP » LFO and 2 x ENV Generators
  » Built-In Effects with Sync Delay » Sequencer and Arpeggiator
  » 1/8" Audio Input and Output » Includes 5-Pin DIN MIDI Adapters

(IKUNOSYNTHIN) ..................................................................Call or Log-On

Peak
8-Voice Polyphonic Synthesizer
  »  Digital/Analog Hybrid  
Synthesizer

  » 8-Voice Polyphony
  »  512 Memory Patches,  
256 Factory Presets

  »  5 Voice Modes and 3 x Oxford Oscillators » State-Variable OTA 
Filter per Voice » 2 x LFO, Ring Mod, Noise, 3 x Envelopes

  » Modulation Matrix: 16 Slots » Arpeggiator » Analog Distortion
(NOPEAK) .......................................................................................1,399.99

 4 x MIDI Tracks

Chorus, Delay, and Reverb Send Effects

MiniBrute 2S
Semi-Modular Analog Synthesizer/Sequencer

  » Advanced 3-Track Sequencer
  » Two VCOs with Waveform Mixer
  »  48-Point Patchbay
  »  Classic Steiner-Parker  
Multimode Filter

  »  16 Pressure and Velocity  
Sensitive Pads » MIDI, CV, USB Input/Output Connectivity

  » LFO 1&2 with Six Waveforms » Arpeggiator and Loop Function

(ARMINBRUTE2S).................................................................Call or Log-On

Neutron  Paraphonic Analog and 
Semi-Modular Synthesizer

  » Dual 3340 VCOs » Multimode Filter
  » Two ADSR Envelopes
  » BBD Analog Delay
  » Overdrive Circuit
  »  32-Input / 24-Output  
Patchbay Matrix

  » LFO with 5 Waveforms & MIDI Clock Sync » Onboard Noise Source
  » USB and 5-Pin DIN MIDI » Audio Input and Headphone Output

(BENEUTRONSYN) .............................................................................. 329.99

 Multimode Filter

vation Bass Station II

Monophonic and Paraphonic Modes
O and 2 x ENV Generators

SYNTH MODULES

California Residents   *See our website for Prop 65 warning

16 x Multicolor Performance Pads

Controller with 5 Modules
Includes Joué Board with 5 Magic Modules
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SYNTH KEYBOARDS

One  3-Part Polyphonic  
Analog Synthesizer (8-Voice)

  » 61-Note Fatar Keyboard with Vel & AT
  » 3 x VCO per Voice with Waveshape Mixing
  » Unison Mode - up to 24 Oscillators
  » Two Independent Filters » State-Variable Multimode & Ladder LP/HP » Assignable X/Y Pad
  » 3 x DAHDSR Envelopes per Voice » 4 x Assignable LFOs with Sync

(MOOGONE001)................................................................................................................................................ 5,999.00

DeepMind 6
True Analog 6-Voice Polyphonic Synthesizer

  » 37 Full-Size Keys with Vel and AT
  » Two Oscillators and Two LFOs per Voice
  » Three ADSR Envelope Generators per Voice
  »  Four FX Engines » 8-Channel Modulation  

Matrix Including FX » 19 Sources and  
130 Destinations » 32-Step Control Sequencer

(BEDEEPMIND6)...................................................................................................................................................549.99

3-Part Polyphonic teenage engineering OP-Z  Synthesizer and Multimedia 
Sequencer

  »  16-Track Sequencer » 16 Synthesis, Sampler  
& Control Tracks » Multi-Program Step  
Components » MIDI, CV, Trig Track Sequencing

  »  Modular Effects Architecture » Image and  
3D Graphic Sequencing » DMX Light Sequencing » Free iOS App with Screen Integration

  » Dual Domain Synthesis » Connect via USB or Wirelessly via Bluetooth
(TEOPZ) ...............................................................................................................................................................599.00

 JD-Xi
 Analog/Digital Synthesizer

  » Analog & Digital Sound Engines
  » Compact Footprint » 37 Mini Keys
  » Four-Track Pattern Sequencer
  » Vocoder & AutoPitch
  » Four Simultaneous Effects » USB for Audio/MIDI » Additional Sounds & Patterns Available

(ROJDXI)..............................................................................................................................................................499.99

MicroFreak
Hybrid Analog/Digital Synthesizer  
with Advanced Digital Oscillators

  »  Digital Oscillator with Multiple Modes » Integrates Mutable  
Instruments Plaits » State-Variable 12 dB Oberheim SEM Filter

  » 5 x 7 Modulation Matrix » Touch-Plate Keyboard with Poly AT
  » USB & 3.5mm MIDI In/Out » Arpeggiator & Step Sequencer » Clock I/O + CV/Gate/Pressure Outputs

(ARMF) ................................................................................................................................................................299.00

Minilogue XD
Polyphonic Analog Synthesizer

  » 4-Voice, Fully Programmable
  » 37-Note Keyboard (Slim-Key with Vel)
  » 500 Presets (200 Factory, 300 User)
  » Modes: Poly, Arp, Chord, Unison » Open Source: User Customization » Multi-Engine (Noise, VPM, User)
  » Arpeggiator & Sequencer (Step & Motion) » 32-Bit Digital FX (Mod, Verb, Delay)
  » OLED Display with Built-In Oscilloscope » Includes Power Adapter

(KOMINILOGUEX)................................................................................................................................... Call or Log-On

Krome EX 73
Music Workstation

  » 73-Key Semi-Weighted Keyboard
  » German D Grand Piano Patch
  » Three Types of Electric Piano Patches » Vintage Amp, Cabinet and Effect Modeling
  » 600 Preset Drum Patterns with Ambience » Onboard 16-Track Sequencer
  » Built-In Digital Effects » USB, SD Card, and MIDI Connectivity » Mac and Windows Compatible

(KOKROMEEX73) .............................................................................................................................................. 1,249.99

Sequential Prophet Rev2   8-Voice Polyphonic Analog Synthesizer 
  » Semi-Weighted, Velocity-Sensitive Keys
  » 2x Digital Control Oscillators per Voice
  » Analog Curtis 2-/4-Pole LPF per Voice
  » 4x LFOs » 3x Envelopes
  » Control Knobs for Hands-On Adjustment
  » Polyphonic 6-Note Step Sequencer » Gated 16x4 Step Sequencer per Layer
  » MIDI In, Out, Thru » CV / Expression, Sustain Inputs

(SEDSI2808) ....................................................................................................................................1,499.001,499.00

MS-101  Analog Synthesizer  
with Live Performance Kit

  » Recreation of the SH-101 » 32 Semi-Weighted Keys
  » Authentic 3340 Analog Oscillator
  » Pure Analog Signal Path (VCO, VCF, VCA)
  » 57 Knobs, Faders, and Switches » ADSR, LFO, Keyboard Tracking » Sequencer and Arpeggiator
  » MIDI In/Out/Thru (DIN) + USB MIDI » Includes Attachable Handgrip, Guitar Strap & Power Supply

(BEMS101RD) ......................................................................................................................................................329.99

Bass Station II
        Monophonic Analog Synthesizer

  » 25 Keys with Aftertouch » Saveable Patches
  » 2 Oscillators & Sub-Octave Oscillator
  » Classic & Acid-Style Filters » 2 Envelope Generators
  » 2 LFOs » Built-In Mixer » Analog Effects Section
  » 5-Pin DIN & USB MIDI I/O

*(NOBS2) ............................................................................................................................................. Call or Log-On

MicroBrute
Analog Synthesizer Creation Edition

  » "The Creation of Adam" Faceplate Design
  » 100% Analog Monophonic Synthesizer
  » 25-Note Mini Keyboard » Mixable Multi-Wave Oscillator
  » Steiner-Parker Multimode Filter » LFO with 3 Waveforms
  » ADSR Envelope Controls » USB MIDI In/Out » Modulation Matrix & Step Sequencer

(ARMBC) .............................................................................................................................................................299.00

Reface CP Mobile
Mini-Digital Combo Piano

 » SCM - Spectral Component 
Modeling + AWM2
 » 37 HQ Mini Keyboard
 » 128-Note Polyphony » 6 Electric Piano Models » Tremolo and Wah Effects
 » Chorus and Phaser Effects » Analog and Digital Delay Effects » Built-In Speakers
 » Librarian iOS App for Saving Presets

(YAREFACECP) .....................................................................................................................................................349.99

California Residents   *See our website for Prop 65 warning
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PX-S1000BK Privia
88-Key Digital Piano

  » Smart-Scaled, Hammer-Action Keyboard
  » Natural Piano with 17 Other Tones » Illuminated Touch Sensor Controls
  » Bluetooth Audio for Playing Songs » Chordana Play for Piano iOS/Android App
  » Stereo Speaker System, 2 x Headphone Out » USB Port with No Drivers Needed
  » Slim Design, Weighs Less than 25 Pounds » Includes AC Adapter or Use Battery Power

(CAPXS1000BK) ...................................................................................................................................................599.99

FP-30
Digital Piano (Black)

The black FP-30 from Roland provides the  
opportunity for the budget- and space-constrained  
student/performer to have access to the sound of a real piano in a light and portable form factor. The 88-key 
instrument delivers an authentic piano experience, both from the SuperNATURAL Piano engine and the weighted 
keyboard that inherits the touch, escapement, and Ivory Feel keys found in the company's high-end home pianos.
  » Additional Non-Piano Sounds » Drum Patterns » Internal Recording » Twin Piano Setting for Duets

(ROFP30BK) ........................................................................................................................................................699.99

EK-50  61-Key 
Arranger Keyboard  
with Built-In Speakers
  » 61 Velocity-Sensitive Keys
  » 280 Styles & over 700 Sounds
  » Easy-to-Read Backlit LCD Screen
  » Integrated 10W + 10W Amplifier » Built-In 4.7" Stereo Speakers » Song Recorder & Set List Mode
  » USB/MIDI Device & Host Connectivity » 4 x Stereo Effects Processors » 148 Effects Variations

(KOEK50) .............................................................................................................................................................399.99

Genos  76-Key 
Arranger Workstation Keyboard

  » 76-Note Keyboard with Aftertouch
  » 9" Color Touchscreen » Assignable Buttons
  » 1710 Instrument Voices & 216 Arpeggios
  » 550 Accompaniment Styles » C7 Grand Piano » Revo!Drum Voices
  » Vocal Harmony and Synth Vocoder » 16-Track MIDI Sequencer » 32-Bit Digital Audio Converter (DAC)

(YAGENOS) ....................................................................................................................................................... 5,499.99

Arius YDP-164  88-Key 
Digital Console Piano with Bench

 » 88 Graded Hammer GH3 Keys » Traditional Console-Style  
Design » Sampled from CFX Concert Grand
 » Damper Resonance & Half-Damper Control
 » 192-Note Polyphony » Audio/MIDI Recording &  
Playback via USB » Integrated 2-Track Song Recorder

 » Includes Bench, Music Book & AC Adapter
(YAYDP164B).................................................................................................................................................... 1,499.99

PSR-S670
Arranger Workstation Keyboard

  » 416 Voices » 230 Styles
  » 2 Live Controllers » Arpeggio » Effects
  » USB Audio Playback
  » Built-In Amplifier and Speakers

(YAPSRS670) .......................................................................................................................................................799.99

P-125
88-Note Digital Piano

  » GHS Weighted-Action Keys
  » Sampled from CFIIIS 9' Concert Grand
  » String Resonance » Damper Resonance DSP » Key-Off Samples Deliver Damper Sounds
  »  USB to Host Connectivity with MIDI » Sound Boost Adds EQ and Volume » Stereophonic Optimizer  

for Headphones » Split Mode and Duo Mode » Includes AC Adapter and Footswitch

(YAP125B) ...........................................................................................................................................................599.99

Pa1000  61-Key 
Pro Arranger with Speakers
A workstation with a range of styles covering  
music genres from all over the world. Combine  
this with powerful performance functionality 
and an intuitive user interface with rich sculpted sound.

 » 1750 Ready-to-Play Sounds » Stereo Grand Pianos » KAOSS FX » Defined Nuance Control
 » Built-In Amplifier and Speakers » TC Helicon Vocal Harmonizer » Dual Crossfade Sequencer

(KOPA1000) ..................................................................................................................................................... 1,999.99

WK-245
Workstation Keyboard

  » 76 Touch-Response Keys
  » 600 Built-In Tones
  » 180 Rhythms and Accompaniments
  » On-Board Sampling
  » Multi Track Recorder » Microphone and Audio Inputs » USB MIDI Port
  » Step-Up Lesson System » Built-In Amplifiers and Speakers » Battery or AC Power

(CAWK245) ..........................................................................................................................................................199.99

Harmony 61
Portable 61-Key Keyboard  
with Built-In Speakers

  » 61 Velocity-Sensitive Keys » 320 Built-In Sounds
  » Adjustable Touch Response
  » Layer and Split Modes » Song Mode with 100 Built-In Rhythms » Intuitive Backlit LCD Screen
  » Chord Dictionary with Notation » Includes Music Rest » Power Adapter

(ALHARMONY61) .................................................................................................................................................... 99.00

ES 110
Portable Digital Piano (Black)

The black ES 110 Portable Digital Piano  
is the latest 88-key addition to the highly respected series of portable digital pianos, combining an 
authentic keyboard action with grade-weighted keys and piano sound technologies.
  » 88 Grade-Weighted Keys » Advanced Harmonic-Imaging Technology » Acoustic Piano Key Weighting
  » Realistic Touch, Natural-Motion Action » Reverbs, Noises, and Resonance Effects » Built-In Lessons
  » Lightweight and Portable » Bluetooth Connectivity

(KAES110) ...........................................................................................................................................................699.00

Recital Pro
88-Key Digital Piano

The Alesis Recital Pro is an 88-key digital  
piano designed to provide a realistic playing  
experience and education-friendly features for  
beginning keyboardists and experienced pianists in rehearsals, at home, or on stage. It delivers natural response 
via 88 hammer-action keys with adjustable touch sensitivity. There are 12 voices including acoustic and electric 
pianos, organs, strings, basses, and more.

(ALRECITALPRO) ..................................................................................................................................................349.00
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GUITAR AMPLIFIERS & ACCESSORIES

Katana-Mini
7W 1x4" Battery-Powered Combo Amplifier 

  » For Electric Guitar
  » Rich Tone in a Small Enclosure
  » 3 Amp Tones Provided
  » 3-Band Tone Stack
  » Built-In Tape-Style Delay
  » Delay Can Act Like a Reverb
  » Lightweight at Just under 3 lb
  » 3.5mm AUX In for Jamming to Smartphones

(BOKTNMINI) ....................................................................................... 99.99

Micro Cube GX
Guitar Amplifier

  »  8 COSM Guitar Amp Tones
  » 8 DSP Effects Built In
  » Memory Button for Storing Settings
  » 3W of Output
  » i-Cube Link for iOS Connectivity
  » Built-In Chromatic Tuner
  » Battery or AC Powered
  » 1/8" Headphone/Record Output

(ROMCUBEGXR) ................................................................................. 159.99

HT-20RMKII
20W Tube Combo Amplifier

  » 1x 12" Celestion Seventy80 Speaker
  »  2-Channel Operation with 

Voice Controls
  »  Tone Stack with ISF Filter 

on OD Channel
  » Power Reduction from 20W to 2W
  » 3x 1/4" Speaker Outputs
  » FX Loop » Includes Footswitch

(BLHT20RMKII) .................................................................................. 599.99

FLY 3 Bass
3-Watt Mini Bass Guitar Amplifier

  » Can Be Used as Compact Portable Speaker
  » 3" Speaker
  » Clean and Overdrive Channels
  »  Compressor & Infinite Shape 

Feature
  » 1/4" Instrument Input
  » 1/8" MP3/Line Input

(BLFLY3BASS) .........................................74.99

Loudbox Mini
Bluetooth 60W Acoustic Combo Amplifier

  »  Speaker with 6.5" Woofer 
and 1" Tweeter

  » Bluetooth 4.0 Connectivity
  »  2 Channels Allow for Singing 

and Playing
  » 3-Band EQ on Each Channel
  » Phase Control & Chorus on Channel 1
  » Built-In Reverb » 1/4" Instrument & XLR Inputs

(FIPROLBT500) .................................................................................. 339.95

Phase Control & Chorus on Channel 1

JAM 96k  Guitar Interface  
for iOS and Mac with  

Lightning Cable
  » Up to 96 kHz/24-Bit Audio Resolution
  » Designed for Guitar and Bass
  » Circuit Design for Tube Tone Emulation
  » For iOS Devices & Mac Computers
  » Plug-and-Play Operation
  » Compatible with Any Core Audio App
  » Includes Lightning & USB Cables

(APJAM96KLO) ................................................................................... 129.00

Performance 2
Capo for Steel String Guitar (Silver)

  » Smaller and Lighter than Original Model
  »  Wraparound Rubber Protects  
the Finish on Your Guitar

  »  Clamps to Guitar Neck  
and Raises Pitch

  » Silicone Improves Tone & Protects Neck
  » Squeeze Design for Reduced Tuning Issues

(G7PERF26SSLV) ..................................................................Call or Log-On
Performance 2 Black (G7PRF26STBLK) ...........................Call or Log-On

Rok-It
Tripod Guitar Stand

  » Holds One Guitar or Bass
  » Heavy-Duty Metal Tube Construction
  » Padded Neck and Body Cradles
  » Neck Restraint
  » Black Powder Coated Finish
  » Rubber Feet

(GARIGTRSTD1) ...............................................8.99

Strum Buddy
Stick-On Guitar Amp

  » Amplifier for Electric Guitars
  » Mounts to Guitar via Suction Cup
  » 6W of Power
  » Distortion, Reverb & Chorus DSP Effects
  » 40mm Neodymium Speaker
  » Built-In Li-Ion Battery » 3.5-Hour Runtime on a Single Charge
  » Included USB Cable for Charging
  » Included 1/4" to 3.5mm Cable » Portable Practicing Solution

(FLSBSOGA) ......................................................................................... 69.99

VX50 GTV  50W Hybrid Modeling 
Combo Amplifier 

  »  Digitally Models Classic 
Amplifiers

  »  11 Amplifier Models 
and 8 Digital Effects

  » NuTube Vacuum Tube
  » 50W Output & 8" Speaker
  » 24-Bit / 44.1 kHz Digital Processing
  » Built-In Tuner & USB Audio Interface

(VOVX50GTV) ..................................................................................... 229.99

GS7462B Professional
Single A-Frame Guitar Stand
  »  Strong A-Frame Design » Holds Acoustic  
and Electric Guitars » Works with  
Desktop Mixers and Combo Amps

  » Velveteen Rubber Padding
  » Tilt-Back Angle: 10° » Folds Flat
  » Splayed Footprint for Stable Foundation
  » Nonslip Rubber End Caps » Heavy-Duty Tubing: 1 x 1"

(ONGS7462B).......................................................................Call or Log-On

UCG102 GUITAR LINK
Guitar to USB Interface

  »  Plug in your guitar and turn your PC or Mac  
computer into a guitar amp and recording system  
without the need for any other hardware.

  »  Connect the Guitar Link interface to 
the camera connection kit of your iOS  
device and enjoy jamming with guitar apps.

  » Stereo Headphone Output
  » Powered via USB—No Additional Power Supply Required

(BEUCG102) ......................................................................................... 29.99

BA-210V2
450W 2x10" Combo Bass Amplifier

  »  450W RMS at 4 Ohms  
or 283W RMS at 8 Ohms

  »  2x10" Speakers with  
Piezo HF Driver

  » -15 dB Pad on Input
  » 3-Band EQ with Bass, Mid, and Treble
  » Ultra Hi and Ultra Lo Selectors
  » Ampeg's Proprietary Scrambler Overdrive

(AMBA210V2)..................................................................................... 399.99

HD500
500W 2x10" Bass Combo Amplifier

  » 2x10" Cabinet
  » HyDrive Paper/Aluminum Drivers
  » Bass, Mid, Treble Controls
  » Variable-Shape Control
  » 1/4" Headphone Jack
  » 3.5mm Auxiliary Input
  » XLR DI Output
  » Lightweight at 35.3 lb

(HAHD25) .......................................................................................... 129.99 .........................................74.99

UCG102 GUITAR LINK
Guitar to USB Interface

our guitar and turn your PC or Mac  
computer into a guitar amp and recording system  

device and enjoy jamming with guitar apps.

Single A-Frame Guitar Stand
coustic  

vy-Duty Tubing: 1 x 1"

Amplification Origin20H
20W Guitar Amplifier Head

  »  For Live Stage or 
Recording Studio

  »  Classic, Rich, 
Harmonic Tones

  » 3x ECC83 Preamp Valves
  » 2x EL34 Power Amp Valves
  » All-Valve Amplifier Technology » Single 1/4" Instrument Jack
  » Effects Loop » Includes Footswitch Pedal

(MAORI20H)....................................................................................... 549.99

24-Bit / 44.1 kHz Digital Processing
Built-In Tuner & USB Audio Interface
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Surge Mesh Kit
Eight-Piece Electronic Drum Kit 
with Mesh Heads

  » Surge Drum Module
  » 1x 10" Dual-Zone Mesh Snare Pad
  » 3x 8" Dual-Zone Mesh Tom Pads
  » 8" Mesh Kick Pad Tower
  » 10" Hi-Hat, Crash, and Ride Cymbals
  » Kick and Hi-Hat Pedals
  » 4-Post Chrome Rack
  » Drum Key, Cable Snake, and Cable Wraps 

 

(ALSURGEMESHK) ................................................................................................................................. Call or Log-On

DTX402K
Electronic Drum Kit

  » DTX402 Drum Trigger Module: 10 Kits
  » 287 Drum/Perc & 128 Keyboard Sounds
  » KU100 Silent Kick Unit & Snare Pad
  » Hi-Hat Controller with Hi-Hat Pad
  » Large Crash & Ride Cymbals
  » 3 Tom Drum Pads
  » 10 Interactive Training Functions
  » 10 Play-Along Songs
  » 9-Channel Snake Cable Included
  » Includes Drum Key and Power Adapter

(YADTX402K) .........................................499.99

Eight-Piece Electronic Drum Kit
TD-4KP

V-Drums Portable Electronic Drum Kit

  » Portable V-Drum Kit with Eight Pads
  » Folding Design for Quick, Easy Transport
  » Wave-Expanded TD-4 Sound Module
  » Features 125 Instruments & 25 Kits
  » Tuning & Muffling for Kick, Snare & Toms
  » Coach Mode with Warm Ups & Tempo Check
  » Module Equipped with Quick Rec Function
  » Mix Input for Playing Along with Songs
  » Snare & Tom Pads Feature Rubber Surfaces
  » Includes FD-8 Hi-Hat Controller

(ROTD4KP) ........................................................................... 699.99

TD-17KVX-S
V-Drums Electronic Drum Kit

  » TD-17 Drum Sound Module with Bluetooth
  » 100 Drum Kits and 310 Instruments
  » 25 Ambience Effects, 30 Multi-Effects, EQ
  » 1 x PDX-12 Snare Pad
  » 3 x PDX-8 Tom Pads
  » 1 x VH-10 Hi-Hat   » 1 x KD-10 Kick Pad
  »  2 x CY-12 Crash Cymbals, 
1 x CY-13R Ride Cymbal

  » USB Port, MIDI, and SDHC SD Card Slot
  » MDS-4V Drum Rack & Hardware

(ROTD17KVXS) ................................................................................................................................................. 1,699.99

Model:Samples
Six-Track Sample Based Groovebox

  »  6 Tracks for Internal 
Audio or MIDI

  » 6 Velocity-Sensitive Pads
  »  1 Sample Playback Engine 

per Track
  » 1 Multimode Filter per Track
  » 1 Assignable LFO per Track   » Delay and Reverb Effects

(ELESMSM) ....................................................................................... 399.00

DTX-Multi12  Multi-Pad 
Electronic Percussion Instrument

  » 12-Zone Multi-Pad
  » Rich Percussion Sounds
  » Import WAV & AIFF Files via USB
  » 1277 MOTIF Voices
  » Powerful DSP Effects
  » Multi-Pattern Preset Patterns
  » Multi-Assignment Trigger Function

 (YADTXM12) ...................................................................................... 599.99

SamplePad Pro
8-Pad Percussion and Triggering Instrument

  » 8x Dual-Zone Rubber Pads
  » 2x External Pad Inputs
  »  Add New Sounds via 

SD Card Slot   » USB Port
  » 5-Pin DIN MIDI I/O
  » 1/8" AUX Input
  » 200 Built-In Sounds

(ALSAMPLEPADP) ................................................................Call or Log-On

PTED06  Electronic Tabletop 
Drum Machine

  » All-in-One Electronic Drum Kit
  » Compact Tabletop Design
  » Over 300 Built-In Sounds
  » 7 Pads & 2 Foot Controllers
  »  Tempo, EQ, Rhythm 

and Volume Adjustments
  » Sticks & Power Charger Included

(PYPTED06) ....................................................................................... 159.99

KTMP1 Electronic Drum &
Percussion Pad Sound Module

  » Four Velocity-Sensitive Pads
  » Playable via Sticks or by Hand
  » 50 Drum and Percussion Sounds
  »  Tune, Pan, Reverb,  

Sensitivity & Level
  » Includes Stand Mount

(KAKTMP1) ........................................................................................ 119.99119.99

SPD-SX  Sampling Pad

  » 9 Velocity Sensitive Drum Pads
  » Internal Memory: 2GB
  »  USB Flash Memory 
and Mass Storage

  »  USB MIDI/Audio and 
Standard MIDI I/O

  »  Two 1/4" Stereo/Mono Inputs
  » Two 1/4" Stereo Outputs & Headphone Out

(ROSPDSX) ........................................................................................ 699.99 

shown with 
optional 

accessories
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EFFECTS PEDALS

Pitchclip 2 
Clip-On Tuner

  »  Tuning Accuracy of +/- 0.1 Cents
  » 3D Tubular LED Visual Meter
  » Clips to Headstock of Guitar or Bass
  » Three Meter-Display Modes
  » Calibrate to Different Reference Pitches
  » Memory Backup Function » Auto Power-Off

(KOPC2) .............................................................................................. 15.99

VoiceLive Touch 2
Vocal Effects with Touch Interface

  »  Vocal Harmony, Pitch Correction, and FX
  » Mounts to Your Mic Stand
  »  Touch Pad & Slider 

or Real-Time Control
  » Mic and Guitar Inputs

(TCVLT2N).......................................................................................... 499.99

Fathom Reverb Pedal for 
Electric Guitars

  » 4 Reverb Algorithms
  » Hall, Plate, Lo-Fi & Octave Modes
  » Decay, Dampen & Mix Knobs
  » Program Knob for Changing Algorithms
  » 3-Way Modulation Switch
  » X Knob's Function Changes with Algorithm

(WAFRGP) ...................................................199.00

SansAmp
Bass Driver V2 DI Pedal

  »  Drive and DI Pedal for Bass Guitar
  »  Expanded Low and Mid  

Frequency Settings
  » Well Suited for 5- & 6-String Basses
  » Functions as Preamp, Stompbox, or DI Box
  » Power via 9V Battery or DC Adapter

(TEBSDRV2) ....................................................................................... 209.00

RC-202  Loop Station

  »  Tabletop Looping/ 
Multi-Effects Unit

  » 2x Stereo Loops, Hand Operable
  » XLR, 1/4" & 3.5mm Inputs
  » USB and MIDI Connections
  » Over 20 FX, 8 Simultaneously
  » 64 Phrase Memories in 8 Banks

(BORC202)......................................................................................... 299.99

FreqOut
Natural Feedback Creator Pedal

  »  Generates Feedback at Any Volume
  »  Works with Distorted or 

Clean Signals
  » Choose between 7 Harmonic Types
  » Onset Delay and Level/Balance Controls

(DIFREQOUTU) ................................................................................... 179.95

MS-50G  
MultiStomp Guitar Pedal 

  » 100 Effects and Amp Models for Guitars
  » 6 Effects Can Be Used Simultaneously
  » Delays, Distortions, Dynamics, and More
  » 32-Bit Floating Point Microchip for Verb
  » Onboard Emulations of Vintage Units
  » 50 User-Preset Slots

(ZOMS50G) ........................................................................................ 119.99

G1X  Four Guitar Effects 
Processor with Built-In Expression Pedal 

  » 100 Effects and Amp Models for Guitars
  » 6 Effects Can Be Used Simultaneously
  »  Delays, Distortions, 
Dynamics, and More

  »  32-Bit Floating Point 
Microchip for Verb

(ZOZG1XFOUR) ..................................................................................... 99.99

Rose Digital Delay
Pedal with Analog Circuitry

  » Digital Delay with Analog Circuitry
  » Based on Classic 1745 DDL
  » 5 Types of Modulation
  » 5 Factory Presets
  » Mix Knob, Low-Pass Filter & Feedback
  » Multiplier, Reverse Delay & Invert Phase

(EVROSE)...............................................349.00

Vow Press
Switchable Volume / Wah Pedal

  » 3-in-1: Volume, Wah, Volume/Wah Pedal
  » True Bypass    » Compact Size
  » Active Volume for Lossless Tone
  » Adjustable Control Range
  » 9 VDC Power Supply or 9V Battery

(HOTPVWPRESS) ................................................................................. 99.99

TS9
Tube Screamer

  » Overdrive, Level, and Tone Controls
  » Works with an AC Adapter or 9V Battery
  » LED Indicator 

(IBTS9) ................................................................................................ 99.99

Oceans 11  
Reverb Pedal for Electric Guitar

  » 11 Reverb Types in 1 Pedal
  » Hall, Spring, Plate & More
  » Esoteric Effects like Poly & Shimmer
  » Time, FX Level, Tone & Reverb Type Knobs
  » Mode Switch » Includes Power Supply
  » 3 Modes per Reverb Algorithm

(ELOCEANS11) ................................................................................... 147.80

Bass Mono Synth
Effects Pedals

  » 11 Synth Tones for Electric Bass
  » Wide Variety of Synth Sounds
  » Dry Knob, Synth Knob
  »  Control Operation with 

Your Dynamics
  » 1/4" EXP Input Controls Synth Parameters

(ELBASSMONOS) ............................................................................... 123.50

TO800  Vintage Tube 
Overdrive Pedal

  »  Vintage Overdrive, Smooth Sustain, 
and Screaming Fat Tone

  » Original 4558 IC plus MA150 Distortion Diodes
  » Dedicated Drive, Tone and Level Controls
  » Status LED for Effect On/Off and Battery Check
  » First-Class Electronic On/Off Switch for Noise-Free Operation

(BETO800) ........................................................................................... 24.99

RAT 2
Compact Guitar Distortion Pedal

  » Control Knobs for Filter, Distortion & Volume
  » Completely Analog Signal Pat
  » Heavy-Duty Steel Construction
  » Sloped Face for Easy Stomping
  »  Glow-in-the-Dark Graphics for Easy 

Adjustments While the Lights Are Off
(PRRAT2) .............................................69.99

Control Knobs for Filter, Distortion & Volume

2
Automatic String Tuner

  » Automatic Fine Tuning for Guitars
  » Works with Acoustic & Electric Guitars
  » Connects to & Automatically Winds Pegs
  » Helps Wind and Unwind Strings
  » Works with Banjos, Mandolins & Ukuleles
  » Included Roadie App for Android & iOS

(RORD200) ........................................................................................ 129.00

Micro Series Trelicopter
Optical Tremolo Pedal 

  » Classic Optical Tremolo
  » Speed Control
  » Depth Control
  » Bias Control
  » True Bypass Switching
  » On/Off LED Indicator

(MOMTR1U) .........................................................................Call or Log-On

TM

SN5X
Clip-On Guitar, Bass & Violin Tuner

  » Full Color Display
  » Rotates 360°
  » Tap Tempo Metronome
  » High-Sensitivity Vibration Sensor
  » Tailored for Guitar, Bass & Violin 

(SN5X) ...................................................................................................8.79

Well Suited for 5- & 6-String Basses

Switchable Volume / Wah Pedal

ower-Off

Onset Delay and Level/Balance Controls

 ................................................................................... 179.95

ocal Harmony, Pitch Correction, and FX

499.99

1/4" EXP Input Controls Synth Parameters

100 Effects and Amp Models for Guitars
6 Effects Can Be Used Simultaneously

 ..................................................................................... 99.99
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3000 Series
Fourth Generation
Wireless Mic System

  »  ATW-R3210 
True Diversity Receiver

  » ATW-T3201 Bodypack Transmitter
  » AT831cH Cardioid Lavalier Microphone

ATW-3211/831EE1 (AUATW3831EE1)............................................. 649.00
ATW-3212/C510EE1 (AUATWC510EE1) .......................................... 599.00

G4 EW-100 Series
  » EK 100 G4 Camera-Mountable Receiver  
  » SK 100 G4 Bodypack Transmitter
  » ME 2-II Omnidirectional Clip-On Lav Mic
  » 1680 Tunable Frequencies across 42 MHz
  » 3-Level Squelch to Block Interference
  »  20 Banks with 12-Channel 

Presets Each

Mic System with ME 2-II Lavalier Mic G (SEEW100G4MA1) ......... 599.00
ew 135P G4 Sys. with 835 Handheld Mic G (SEEW100G48A1) ...... 599.00

Series Digital/
Analog

Frequency
Range

Receiver
Format Range Encryption Max

Channels
Battery

Type
Battery

Life
Dante/

Ethernet
Rack

Mount
Audio
Output

Shure QLX-D Digital UHF Single  328’ (100m) Yes 22 Lithium-Ion, AA  10 hours Yes Yes XLR, 1/4”

Shure PGX-D Digital UHF Single 200’ (60m) No 5 AA 10 hours No No XLR, 1/4”

Shure GLX-D Digital 2.4GHz Single  200’ (60m) No 8 Lithium-Ion 16 hours No No XLR, 1/4”

Shure ULX-D Digital UHF Single, Dual, Quad 328’ (100m) Yes 60 AA 11 hours Yes Yes XLR    

Shure BLX Analog UHF Single, Dual 300’ (91m) No 12 AA 14 hours No No XLR, 1/4”

Shure SLX Analog UHF Single  328’ (100m) No 12 AA 8 hours No No XLR, 1/4”

Sennheiser Evolution D1 Digital 2.4GHz Single  Not Specified No 15 AA 6 hours Yes No XLR    

Sennheiser Evolution G4 Analog UHF Single  Not Specified No 32 AA 8 hours No No XLR, 1/4”

Sennheiser XSW Wireless Analog UHF Single  Not Specified No 12 AA 10 hours No No XLR, 1/4”

Audio-Technica System 10 PRO Digital 2.4GHz Single, Dual 200’ (60m) No 10 AA 7 hours Yes Rack Ears Included XLR, 1/4”

Audio-Technica 3000 Analog UHF Single  300’ (91m) No 10 AA 8 hours No Rack Ears Included XLR, 1/4”

Audio-Technica 2000 Analog UHF Single  300’ (91m) No 16 AA 9 hours Yes Rack Ears Included XLR, 1/4”

QLX-D
Digital Wireless

Offering networked control, AES-256  
encryption, and simplified setup  
and operation, QLX-D delivers  
outstanding digital wireless sound  
for mid-size events and installations.

Lavalier System (SHXD1483H50) ............................................... 1,053.00
Handheld System (SHD24SM58G50) ............................................. 999.00
Combo System (SHXD12485G50) ............................................... 1,439.00

XSW-D Vocal Set 
Digital Wireless Plug-On Mic System

  »  Plug-On Transmitter with Handheld Mic
  » Plug-On Receiver
  » Lightweight Miniature Housing
  » Rechargeable 5-Hour Batteries
  » Easy-to-Use, Plug & Record Operation
  » 5 Systems at Once Max, up to 250' Range

(SEWXSVSTR) .................................................................................... 349.95
XSW-D Lavalier Set (SEWXSLSTR) ................................................ 349.95

ULX-D
Digital Wireless

ULX-D Digital Wireless offers 
extremely efficient RF performance, 
networked control, Dante 
digital audio, and AES-256 
encryption for professional  
sound reinforcement.
Headset System (SHULXD4G50K) .............................................. 1,399.00
Combo System (SHUD12485H) ................................................... 1,899.00

System 10 PRO
This system operates in the 2.4GHz range  
(outside of TV bands). Its half-rack  
chassis can house 2 receiver units,  
allowing 4 channels to fit in a single rack space.  
Up to 5 chassis (10 receiver units) can be linked and used simultaneously.

Handheld System (AUATW1302) ................................................... 449.00
Lavalier System (AUATW1101L) ..................................................... 349.95
Combo System (AUATW1312L) ....................................................... 849.00

PGX-D
Digital Wireless

PGX-D Digital offers wireless  
audio that sounds like wired,  
rock-solid RF performance and  
simple setup and operation for  
small clubs and venues.

Lavalier System (SHPGXD1493) ..................................................... 399.00
Headset System (SHPGXD14PGA3) ................................................ 399.00
Handheld System (SHPGXD24SM58) ............................................. 379.00

BLX
Analog

The ideal entry-level 
wireless microphone 
system for small venues, 
BLX offers professional 
quality sound with simple setup and an intuitive interface.

Lavalier System (SHBLX14CVLH9) ................................................. 299.00
Handheld System (SHBLX288P58J) ............................................... 549.00
Headset System (SHBLX14PGJ10) ................................................. 299.00

GLX-D Advanced
Handheld Wireless System

  » 2.4GHz ISM Band
  » GLXD4R Wireless Receiver
  »  GLXD2 Handheld Transmitter
  » Includes Rechargeable Battery
  » Mic Clip » 2 Detachable Antennas

GLX-D Digital Wireless Receiver (SHGLXD4RZ2) ........................... 319.00
with SM 58 Microphone (SHGLXD24S572) ...................................... 499.00
Handheld and Lavalier Combo System (SHGLXD124R85) ............. 939.00

2 Detachable Antennas

Analog

G4 300 Series
Wireless Handheld 835  
Microphone Kit, Aw+

  » ew 300-500 G4 Wireless Receiver
  » SKM 300 G4 Handheld Transmitter, No Mic
  » MMD 835 Cardioid Dynamic Mic Capsule
  » Includes Two Rod Antennas

(SEEW300G4BAK) .............................................................................. 928.95
Wireless Lavalier ME 4 Microphone Bundle, AW+ (SEEW300G4CAK) .. 949.95
Wireless Handheld 845 Microphone Bundle, GW1 (SEEW300G4SWQ) . 948.95

 ..............................................

 ...................................................

System 10 PRO

allowing 4 channels to fit in a single rack space. 

ULX Series
Wireless Mic System

  »  Automatic Frequency Selection  
with Group Scan Function

  »  Up to 1440 Frequencies
  »  5-Segment Transmitted Audio  

Signal Strength Meter

Bodypack System (SHULXS14J1) ...................................................... 629.00 
Handheld System (SHULXS2458G3)................................................... 689.00
Combo System (SHULXS12485J) ....................................................... 989.00

XSW 1-835 Dual-Vocal Set
with Two 835 Handheld Microphones

  »  EM-XSW 1 Dual-Chan Receiver
  »  2 x SKM 835-XSW Handheld  

Transmitters
  » 2 x MZQ 1 Microphone Clips
  » Includes NT 12-5 CW Power Supply » 4 x AA Batteries
  » 80 Hz to 16 kHz Frequency Response

XSW 1-835 Dual-Vocal Set with Two 835 Mics (SEXSW1835) ..... 599.00 
XSW 1-825 Dual-Vocal Set with Two 825 Mics (SESXSW1825A) . 249.95

a-Mountable Receiver  

ME 2-II Omnidirectional Clip-On Lav Mic
1680 Tunable Frequencies across 42 MHz

Wireless Mic System

 ...............................................
 .............................................

 ...............................................

 .....................................................

 ................................................

Digital Wireless Plug-On Mic System

ransmitter with Handheld Mic

Easy-to-Use, Plug & Record Operation
5 Systems at Once Max, up to 250' Range
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Ultralink ULM202-USB
Dual Wireless Microphone System

  » 2x Handheld Microphones, 1x USB Receiver
  » 2.4 GHz License-Free Transmission
  » Automatic and Manual Pairing
  » Error Detect and Interference Rejection
  » Dual-Mode Analog/USB Audio Interface
  » Integrated Volume Controls on Microphone
  » Panic Mute Button » Low Battery Indicator

(BEULM202USB) ................................................................................ 149.99

AS-900N8 Any Spot Series
Wireless Personal Monitoring System

  » UHF Fixed Frequency
  » Single Rackmount Included
  »  150' Range » Includes Transmitter &  

Bodypack Receiver
  » 100mW Audio Output Level on Receiver
  » Level Display & Combo XLR/1/4" Inputs
  » Includes EB4 Earbuds

(GAAS900N8) .......................................................................Call or Log-On

A2003UHF
Directional Wide-Band Antenna

  »  450 to 960MHz 
Wide-Band UHF

  » Enhances Reception
  »  Mounts to Microphone  
Stands

  » Lightweight

(SEA2003UHF) ................................................................................... 279.95

Directional Wide-Band Antenna

PSM 300  Stereo Personal 
Monitor System with IEM

  » For Live Stage, Theater
  » 24-Bit Digital Audio
  » P3T Transmitter
  » P3RA Receiver
  » Includes SE215 In-Ear Monitors
  » Over 300' Coverage Range
  » One-Touch Scan and Sync Features

(SHP3TR215G20) ............................................................................... 799.00

ATW-A49
UHF LPDA Antennas (Pair)

  » LPDA (Log Periodic Dipole Array) Antenna
  »  Designed for Use with Audio-Technica UHF 

Wireless Systems » 440-900MHz Range
  » Directional Coverage Pattern
  » Beam-Width of 90 Degrees
  »  Ideal for Use in Theatrical and Musical 

Performances » Sold in Pairs

(AUATWA49) ...................................................................................... 329.00

UA874  Active 
Directional Antenna

  » Directs a Cardioid Pattern toward Target
  » Four-Position Gain Selector Switch
  » Low-Noise Signal Amplifier
  »  Makes Up for 

Coaxial Transmission Loss
  » Integrated Threaded Adapter
  » Mounts Easily to Mic Stands
  » 470-698 MHz

(SHUA874US) ..................................................................................... 306.75

R300-HD
Wireless UHF Microphone System

  » Frequency B and C
  »  Handheld Transmitter  

with PL22 Capsule
  » 32 Preset Channels
  » ClearScan Channel Selection
  » EZsync Remote Channel Syncing
  » Rugged Metal Construction

(ELR300HD) ....................................................................................... 299.00

XPD2  Handheld USB 
Digital Wireless Microphone System

  » For Broadcasting and Presentations
  » 2.4 GHz Frequency
  » Plug-and-Play for Mac and Windows
  » Works with iPad and Android Devices
  » USB Stick Receiver
  » HXD1 Handheld Transmitter with Q6 Mic
  » 100' Operating Range

(SASWXPD2HQ6) ................................................................................. 89.99

SE215  Sound-Isolating In-Ear 
Stereo Earphones (Black)

  » Compact and Lightweight
  » Single Dynamic MicroDriver per Side
  » Up to 37 dB of Noise Isolation
  » 22 Hz to 17.5 kHz Frequency Response
  » Fit Kit with Multiple Eartips
  » In-Line Remote and Microphone
  » Selectable Android/iOS Operation
  » Detachable 3.5mm Cable » Zippered Carrying Case Included

(SHSE215KUNI) ................................................................................... 99.00

G4 EW-IEM
Wireless Lavalier ME 4 Microphone Bundle

  » SK 300 G4-RC Bodypack Transmitter
  » EM 300-500 Wireless Receiver
  »  ME 4 Cardioid  

Lavalier Microphone
  » Includes Power Supply
  » GA3 Rackmount Kit
  » 2 x Rod Antennas
  » 2 x AA Batteries

(SEEW300G4CAK) .............................................................................. 949.95

UM Pro 30  Triple-Driver Stereo 
In-Ear Headphones with Replaceable Cable 

  » Three Balanced-Armature Drivers
  » Up and Over Cable Routing for Security
  » 20 Hz to 18 kHz Frequency Response
  » Sensitivity of 124 dB SPL
  » Braided Aramid-Reinforced Cable
  » Durable and Replaceable MMCX Cable
  » Includes Silicone and Foam Eartips
  » Includes Monitor Vault and Cleaning Tool

(WEUMPRO30) ................................................................................... 399.99

W80  Eight-Driver True-Fit 
Earphones with ALO Audio and 
High-Resolution Bluetooth Cables 

  » Reference-Level Audio
  » Eight Balanced-Armature Driver Design
  » Drivers: 2 x Low, 2 x Mid, 4 x High
  » 5 Hz to 22 kHz Frequency Response
  » Includes ALO Audio Reference 8 Cable
  » Includes Bluetooth 5.0 Cable » Apple and Android Compatible
  » Two Carrying Cases (Deluxe & Small)

(WEW80E) ......................................................................................1,499.99

EM 300-500 Wireless Receiver

Concert 288 All-in-One
Dual-Channel UHF Wireless System

  » CR288 Wireless Receiver
  »  Handheld Transmitter  

& Q6 Dynamic Mic
  » Beltpack Transmitter
  »  LM5 Lavalier Mic and  

HS5 Headset Mics
  »  300' Operating  

Range

(SASWC288ALLH) ................................................................Call or Log-On

CR288 Wireless Receiver
Handheld Transmitter 

Beltpack Transmitter
valier Mic and  

UHF-5800-10 PRO
4-Channel UHF Wireless Handheld Mic

  » Channels: 9E/9F/9G/9H
  »  913.3 to 925.8 MHz 

UHF Band
  »  4 x Handheld 

Transmitter Mics
  »  Module Replaceable  

Receiver » 4 x Discrete Outputs & 1 x Mixed Output
  » Includes Aluminum Carrying Case and Heavy-Duty Carry Bag for Mics

(VOUHF580010) ................................................................................. 449.00

ULWS-16-H
16-Channel UHF Wireless 

Handheld Microphone System 

  » For Live Sound, Stage & Public Address
  » Frequency-Agile, True Diversity Receiver
  » Wireless Handheld Microphone
  » Dynamic Capsule, Cardioid Polar Pattern
  » 16 Channels, 25 MHz Bandwidth
  » Up to 300' Operating Range

(POULWS16H) .................................................................................... 249.00
ULWS-216-H Dual with 2 Microphones (POULWS216H) ............... 499.00

16-Channel UHF Wireless 
Handheld Microphone System 

Frequency-Agile, True Diversity Receiver

Dynamic Capsule, Cardioid Polar Pattern

LIVE-WIRELESS & IN-EAR MONITORING SYSTEMS

Directs a Cardioid Pattern toward Target

High-Resolution Bluetooth Cables 
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ZLX Series
Two-Way Powered Loudspeakers

The ZLX series makes it easier than ever to own and experience  
premium pro audio. Its combination of streamlined industrial  
design, compact size, user-friendly operation and portability,  
and plentiful power have made it the go-to choice for monitors  
and mains in DJ/musician applications such as practice spaces  
and small clubs. It is also great for basic installations and 
portable multipurpose sound.

ELX200 Series
Two-Way Powered Loudspeakers

12" 2-way 1200W powered speaker designed to provide  
dependable amplification, flexible installation, and  
convenient control for sound engineers and performers.  
It features 1200W of Class-D amplification, which drives  
a 12” woofer and a 1” titanium high-frequency compression 
driver. It also has a frequency range of 51 Hz to 20 kHz.

EON600 Series
Powered Speakers

Completely rethinking how truly good an  
affordable self-contained, portable PA system  
can be, JBL engineers purposely designed and  
built the EON600 from the ground up featuring  
JBL’s advanced waveguide technology, JBL  
designed and manufactured transducers, and  
convenient, wireless remote control of its  
onboard DSP EQ parameters via Bluetooth.

SRX800 Series
Self-Powered Speakers

SRX800 breaks new ground, bringing together JBL’s 
premium transducers and enclosures, Crown’s Proprietary 
Front-End DriveCore Technology, user-configurable DSP, 
and full HiQnet Network control compatible with a variety 
of platforms. Each SRX800 Series component delivers a 
perfectly tuned system that is powerful, easy to use, and 
rugged enough for the most demanding applications. 

CP8
Compact Powered Loudspeaker

  »  For Live Stage, Theater, DJ Setups
  » 8" 800W Woofer    » 1.4" 200W Driver
  » 56 Hz to 20 kHz Frequency Response
  » Max SPL of 124 dB    » Class-D Power Amplifier
  » Combo XLR Inputs & 3.5mm Playback Input
  » One-Touch +25 dB Boost Switch on Input B
  » Contour Selection Switch    » Relatively Lightweight at 21 lb

JRX200 Series
Loudspeaker System

JRX200 delivers the performance and prestige JBL is known 
for being at an affordable price point. With performance, 
value, and popular price points, JBL built the JRX200 
speakers. This means JBL can apply efficient, high-volume 
production methods and purchase materials at the lowest 
cost. That's how JRX200 delivers unprecedented value.

F1 Model 812 
Array Loudspeaker

The first powered portable loudspeaker that lets you control  
its vertical coverage pattern. Simply choose among four  
different settings. Whether you’re playing at floor level,  
on a stage, or facing raked seats or bleachers, you can  
now adapt your PA to match the room.

(BOF1FALS) .........................................................................................................................................................899.00
F1 Powered Subwoofer (BOF1SW) ............................................................................................................... 1,199.00

K.2 Series
2-Way 2000-Watt Powered Speakers

  » 2000-Watt QSC Class-D Amplifier » Powerful, Lightweight & Versatile
  » Factory / User Presets with Recall » Stage Monitor, Dance Music, Instrument
  » Multifunction Digital Display » DSP: EQ, Delay, Frequency Contours
  »  Intrinsic Correction for Tuning & More » Strong ABS Enclosure,  
Tough Steel Grille » 35mm Pole Sockets with Tilt Capability

K8.2 8" (QSK82) ................................................................................................................................................649.99
K10.2 10" 2-Way 2000-Watt Powered Speaker (QSK102) ............................................................................699.99
K12.2 12" 2-Way 2000-Watt Powered Speaker (QSK122) ............................................................................799.99CP8 8” (QSCP8NA) .......................................... 399.99 CP12 12" (QSCP12NA) .................................... 499.99

12” (ELELX20012PU) ........................................ 599.00
ELX200-10P-US 10” (ELELX20010PU) ........... 549.00
ELX200-15P-US 15” (ELELX20015PU) ........... 699.00

12" Subwoofer (ELELX20012SU) .................... 649.00
18" Subwoofer (ELELX20018SU) .................... 799.00

EON610 10" (JBEON610)................................ 499.00
EON612 12” (JBEON612) ................................ 449.00

EON615 15” (JBEON615) ................................ 499.00
EON618S 18" Subwoofer (JBEON618S) ........ 799.00

SRX812P 12" (JBSRX812P) ........................1,299.00
SRX815P 15" (JBSRX815P) ........................1,399.00 SRX818SP 18" Subwoofer (JBSRX818SP) .1,599.00

JRX212 12" (JBJRX212)................................. 249.00
JRX215 15" (JBJRX215)................................. 299.00

JRX218S 18" Compact 
 Subwoofer (JBJRX218).............................. 499.00

PRX800W Series
Powered Speakers with Wi-Fi

The most advanced PA in its class. Wi-Fi technology  
and sophisticated DSP give you complete control  
over system tuning and performance via the free PRX  
Connect app. An efficient 1500-watt class-D amplifier  
and patented JBL Differential Drive technology provide  
best-in-class power and reduced weight. Designed to  
deliver legendary JBL sound for bands, DJs, and more.

PRX812W 12" (JBPRX812W) ......................... 749.00
PRX815W 15" (JBPRX815W) ......................... 849.00

Subwoofers
PRX815XLFW 15" (JBPRX815XLFW) ............. 999.00
PRX818XLFW 18" (JBPRX818XLFW) ..........1,099.00

KW Series 
1000W Active 2-Way Loudspeakers
  » 1.75" Compression Tweeter » 2 x 500W Class-D Amplifiers
  » XLR/TRS Combo and RCA Inputs » XLR Line and Mix Outputs
  » Integrated DSP with DEEP
  » Intrinsic Correction and GuardRail
  » Directivity Matched Transition Coverage
  » Pole Socket with Tilt-Direct » M10 Rigging Points

XLR Line and Mix Outputs

KW122 12” (QSKW122) .................................. 999.99
KW152 15” (QSKW152) ...............................1,299.99

KW153 15" 3-Way (QSKW153)...................1,499.99
KW181 18" Subwoofer (QSKW181) ...........1,499.99

ZLX-12P-US 12" (ELZLX12PUS) ..................... 399.00
ZLX-15P-US 15” (ELZLX15PUS) ..................... 499.00

ZLX-12BT 12" (ELZLX12BTPUS) ...................... 449.00
ZLX-15BT 15” (ELZLX15BTPUS) ...................... 549.00
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The Mackie SRM Series portable loudspeakers deliver 
professional sound quality. The 1000W SRM350 and SRM450 
feature modern tools like application-specific speaker 
modes and an automatic feedback destroyer, each with a 
single-button interface that gets you optimized performance 
in just seconds. And with the integrated 2-channel mixer, 
you can easily mix multiple sources.

Thump Series
Powered Loudspeaker

1300W 12" powered loudspeaker with a redesigned 
amplifier with Dynamic Bass Response, which provides 
chest-thumping low end for a variety of applications 
including rehearsal studios, small bars and coffee shops, 
small night clubs, karaoke events, weddings, houses of 
worship, fitness centers, and mobile DJs.

Art 3 Series Series
2-Way 800W Active Speaker

Part of the Art 3 Series MK4 line of speakers, the 
RCF ART 312-A MK4 is a lightweight (at 37 lb) and 
portable active speaker designed to deliver full-range 
sound with accurate high frequencies and controlled 
deep bass for live sound reinforcement, distributed 
sound systems in clubs, corporate events, or mobile 
DJ setups.

Truesonic 3 Series  2-Way 2000W 
Powered Loudspeaker

  » For Live Stage, Theater & DJ Setups
  » 10" Woofer, 1.4" High-Frequency Driver
  » 54 Hz to 20 kHz Frequency Response
  » 2000W Peak Class-D Amplification
  » XLR-1/4" Combo Inputs, XLR Link Output
  » LED Status Indicators, Contour Switch
  » Injection-Molded Polypropylene Enclosure

DXR Series
1100W 2-Way Active Loudspeaker

Providing clear audio and extremely high output levels 
in a durable design, this speaker is ideal for live sound 
that requires wide bandwidth audio reproduction. 
The cabinet has a rugged ABS construction with a 
bass reflex design. It delivers a combined peak 
output power of 1100W. The speaker can be placed on a floor or stage, and has useful mounting options.

DBR Series
2-Way Powered Loudspeaker

The portable, versatile DBR Series ensures high-resolution 
sound at any output level. Comprised of 10”, 12” and 15” 
models, each DBR loudseaker is housed in a newly designed, 
durable, lightweight cabinet optimized for FOH sound, floor 
monitoring, and even rigged applications. Whether you're 
powering your band’s live performance, DJ-ing a party, or MC-ing 
an event, be prepared for DBR Series speakers to take your performance to the next level.

DRM Series
Professional Powered Loudspeakers

DRM Series Professional Powered 1600W Loudspeakers deliver 
class-leading power via ultraefficient Class-D amplifiers with 
next-gen protection and Power Factor Correction technology 
for peak performance when you need it. Advanced Impulse DSP 
provides acoustic correction and time-alignment via precision- 
tuned FIR filters for crystal clear, punchy sound typically 
experienced only with massive touring systems.

DRM212 12" (MADRM212) ............................. 799.99 DRM215 15" (MADRM215) .............................899.99
DRM18S-P 2000W 18" Professional Passive Subwoofer (MADRM18SP) ....................................................649.99

SRM350 10"  (MASRM350V3) ...........................................................................................................................399.99
SRM450 12"  (MASRM450V3) ...........................................................................................................................499.99

DXR8: 8" (YADXR08) ......................................... 549.99
DXR10: 10" (YADXR10) ..................................... 599.99

DXR12: 12" (YADXR12) .......................Call or Log-On
DXR15: 15" (YADXR15) ..................................... 799.99

IQ-12: 12" (TUIQ12) ......................................... 750.00
IQ-10: 10" (TUIQ10) ...........................Call or Log-On

IQ-8: 8" (TUIQ8) ............................................... 625.00
IQ-15: 15" (TUIQ15) ...........................Call or Log-On

TS310  10"  (ALTS310XUS) ............................. 249.00 TS308  8"  (ALTS308XUS) ............................... 229.00

Thump12A:12” (MATHUMP12A) ..................... 299.99
12BST Boosted: 12” (MATHUMP12BST) ........ 399.99

Thump15A:15” (MATHUMP15A) ..................... 349.99
15BST Boosted: 15” (MATHUMP15BST) ........ 499.99

Art 312-A MK4: 12” (RCART312AMK4) ......... 599.00
Art 310-A MK4: 10” (RCART310AMK4) ......... 499.00 Art 315-A MK4: 15” (RCART315AMK4) ......... 649.00

SRM V3 Series
Powered Loudspeakers

DBR10: 10" (YADBR10) .......399.99 DBR12: 12" (YADBR12) .......499.99 DBR15: 15" (YADBR15) .......599.99

HX-5B Variable Dispersion  
Line Array Speaker (Black)

A 2-way compact speaker system that permits both constant directivity control 
over a wide frequency range and changes in directivity. Ideal for reproducing 
clear sound in spaces with long reverberation times or high background 
noises. Features include high power handling (600 watts continuous), 
lightweight polypropylene construction, plus speakON and screw terminal 
connectors. The HX-5B can be vertically or horizontally mounted with the 
built-in bracket or with optional wall-, ceiling-, and stand-mounted hardware.

HX-5B Black (TOHX5B) ....................................610.00 HX-5W White (TOHX5W) ..................................610.00

B200D Series
Active Loud Speakers

  »  High Power 550W 2-Way PA Sound Reinforcement Speaker System
  » For Live and Playback Applications
  »  Ultracompact and Lightweight System 
Delivers Excellent Sound Even at Extreme 
Sound Pressure Levels

B210D 10” (BEB210DB) .......................... 199.99
B210D 12” (BEB212DB) .......................... 249.99
B215D 15” (BEB215DB) ............Call or Log-On

IQ-12
2500W 12" 2-Way Speaker System

  » For Portable PA & Sound Reinforcement
  » ULTRANET Digital Audio Networking
  » Class-D Technology Power Amplifier
  » KLARK TEKNIK DSP Processing
  » Speaker Modelling    » LCD Display
  » Fiberglass-Reinforced Enclosure

PA SPEAKERS
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Pathfinder
Waterproof Rechargeable Speaker System

  » Rugged, Waterproof Construction
  » 100W Peak Output Power
  » Built-In Bluetooth Receiver
  » Built-In 75-Hour Rechargeable Battery
  » Microphone Input, Mic & Cable
  » AUX Input for MP3 Players, Smartphones
  » Built-In Digital AM/FM Radio
  » Telescoping Handle, Wheels, Side Handles

(IOPTHFNDRYEL) ................................................................................ 179.99

Escort 6000
Portable PA System

  » 600W Output
  » Portable Design
  » Digital Multi-Effects
  » Feedback Locating System
  » 2 Folding Speaker Stands
  »  Case with Luggage 

Wheels

(PEESCORT612U) ............................................................................... 999.99

EON208P  Personal PA System System 
with 8-Channel Mixer and Bluetooth

  »  Built-In Handle
  »  Clip-On Design
  »  Built-In Bluetooth 
Receiver

  »  Stream from 
Smartphones, Tablets, PCs

  » 300W of Class-D Amplification » 8" Woofer & 1" Neodymium Tweeter
  » AUX Inputs for Line Sources » Built-In EQ & DSP Limiting
  » 4 x Combo XLR-1/4" Inputs » Includes AKG Mic

(JBEON208P) ..................................................................................... 699.00

EON ONE  All-in-One  
Linear Array PA System

  » 380W of Power » 118 dB Maximum SPL
  » 10" Low Frequency Woofer
  » 6x 2" High Frequency Drivers
  » Six Channel Mixer with Bluetooth Audio
  » Two Channels of Mic/Line Inputs with EQ
  » Channels 3 & 4: Stereo 1/4" or RCA
  » Channels 5 & 6: 1/8" Stereo Input
  » Compact Design for Portability
  » Includes 2 Height Spacers

(JBEONONE) .................................................................999.00

MAUI 5 GO  Ultra-Portable  
Battery-Powered Column PA System

  » All-in-One, Portable PA System
  » For Crowds over 100 People
  » 30-Hour Rechargeable Battery » Built-In Bluetooth
  » Line Array Design for Extended Coverage
  » 8" Subwoofer
  » 200W RMS / 800W Peak Power
  » Mic / Line / Instrument Inputs
  » Lightweight and Easy to Transport
  » Four-Piece Design Assembles in Seconds

(LDSMAUI5GO) .................................................................899.99

Evox 8  Compact Two-Way 
PA Speaker With Bass System

  » 12" High Excursion Woofer
  » 8x Full-Range 2" Drivers
  » Peak 1000W (LF), 400W (HF)
  » 120° Horizontal Coverage
  » Balanced Line/Mic Level Input
  » Vertical Coverage Prevents Beaming
  » EQ Boost Switch » DSP Signal Processing
  » speakON 2-Pole Connector to Top Speaker
  » For Live Sound and PA Applications

(RCEVOX8) ...........................................................1,799.00

EVOLVE 50  
Portable 1000W Bluetooth-Enabled 
Subwoofer and Column Speaker Kit

  » EVOLVE 50 Column Speaker Array
  » EVOLVE 50 Active Subwoofer
  » Magnetically Locking Mounting Pole
  » 12" Subwoofer, Eight 3.5" Drivers
  » 1000W of Class-D Amplification
  » Custom Waveguides for Wide Coverage
  » Mic, Line, and AUX Inputs
  » Supports Bluetooth Audio and Control

(ELE50SBTBKIT) ......................................................1,599.00

iNSPIRE iP500 V2
Powered Column Loudspeaker 
with 8" Subwoofer

  » Full-Range Powered Speaker
  » 8" Low-Frequency Driver
  » Six 2" Neodymium HF Drivers
  » 600W Multichannel Class-D Amplifier
  » Spatial Sound Technology for 3D Sound
  » 100° Dispersion » Bluetooth Audio Streaming
  » Digital Mixer with DSP
  » Free iOS Control App » Includes Carrying Bag

(TUIP500V2) ..................................................................... 549.99

L1  Compact Line  
Array PA Speaker and Mixer System

  »  Sleek Line Array Speaker
  » Integrated Mixer & Amplifier Base
  » Compact Speaker with Full Tone
  » Direct & Off-Axis Audio Balance
  » Lightweight Easy Setup
  » Microphone and Line Inputs
  » Adjustable Speaker Positioning 

 

(BOL1) ..........................................................................999.00

Audio Commander   
Prof. Mobile PA System with Two Wireless Mics 

  »  Built-In Handle and Wheels
  » Built-In Bluetooth Receiver
  » Two Integrated UHF Wireless Receivers
  » 200W (RMS) Class-D Amplifier
  » 12" Woofer » 3-Band EQ
  » Compression Driver Tweeter
  » Inputs: 2 x XLR/1/4", 1/8", and RCA
  » Integrated Rechargeable Battery
  » Includes Two Wireless Microphones

(DEAUDIOCOMMA).............................................................................. 699.00

STAGEPAS 600BT   
Portable PA System with Bluetooth

  »  680W Power Output » Detachable  
10-Channel Mixer » 2 x Two-Way Bass  
Reflex Speakers » All-in-One Portable  
PA System

  » Fast and Easy Setup
  » Phantom Power
  » Single Knob Master EQ
  » Built-In Feedback Suppressor

(YASTGPAS600B) ................................................................................ 899.99
STAGEPAS 400BT (400W) (YASTGPAS400B) ................................... 699.99

Built-In 75-Hour Rechargeable Battery

 Input for MP3 Players, Smartphones

Telescoping Handle, Wheels, Side Handles

Eurolive B205D  Active PA  
and Monitor Speaker System

  » 150 Watts
  » Mic Stand Mountable
  » Mic and Line Inputs
  » 3-Band EQ
  » +48V Phantom Power
  » XLR Thru Connection 

(BEB205D) ......................................................................................... 199.99

PA-5150
5" 150W Portable PA System

  » Rugged and Portable
  » 150W of Power
  »  Built-In Effects and 3-Band  

Equalizer
  » Integrated 3-Channel Mixer
  »  Includes Mic Stand Mounting  

Adapter » Mic Boom Adapter
  » AC Power Cord

(POPA5150) ....................................................................................... 179.99

SRM150
5" Compact Active PA System
  »  This is a combination of Mackie's  

mixer and SRM active  
loudspeaker in an attractive,  
tiny PA system which is not  
only portable but also powerful.

  »  Built-in, three-channel mixer  
has two combo XLR/line inputs,  
a stereo channel for CD/MP3,  
and a powerful three-band active EQ.

(MASRM150) ..................................................................................... 249.99

This is a combination of Mackie's 

Feedback Locating System
2 Folding Speaker Stands

Passport CONFERENCE
Self-Contained Portable Audio System (175W)
  »  For Small- to Medium-Sized  

Audiences
  »  Detachable Speakers with  

5.25" Woofers
  » 5-Channel Powered Mixer
  » 3 XLR Inputs
  » Headphone Output

(FEPC175W) .........399.99Passport 
EVENT Portable System (375W) (FEPE375W) ............................... 699.99
Passport VENUE - Portable System (600W) (FEPE600W) ........... 999.99

Detachable 
2 x Two-Way Bass 2 x Two-Way Bass 2 x T

All-in-One Portable 

Built-In Feedback Suppressor
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PWMA200
Wireless Portable Amplifier 

  » Wireless Rechargeable Amplifier
  »  Lavalier Mic with  

Bodypack Transmitter
  » Bonus Wired Microphone
  »  All-in-One Design for Easy  

Carrying and Portable Use
  » FM Radio Function
  » Works on Both AC & DC

(PYPWMA200)...................................................................................... 79.95

Wireless Rechargeable Amplifier

PMP50  Professional Piezo 
Dynamic Megaphone 

  »  Powerful Piezo Driver and  
Large Bell Diameter

  » Handheld Mic
  » 50W of Power
  » 2 Modes for Talk and Siren
  » For Indoor/Outdoor Use
  » Variable Volume Control
  »  Ergonomic Pistol Grip and  
Lightweight Chassis

(PYPMP50) .......................................................................................... 32.97

PA-15W Waistband Amp.
with Head-Worn Microphone,  

TF Card Slot & USB Port

This portable unit clips on your waistband  
for hands-free public speaking. Use it 
indoors or outdoors, at meetings, school 
programs, sporting events, field trips,  
assemblies, and more. It has an included 
rechargeable lithium-ion battery.

(HAPA15W) .......................................................................................... 69.96

ER-520W 
10-Watt Handgrip Megaphone

  »  Lightweight 10-Watt handgrip  
Megaphone with Whistle and  
over 800' Voice Projection Range

  »  Antibacterial Treatment for  
Mouthpiece and Handle

  » Durable ABS Resin Construction
  » Polyimide Diaphragm
  » Long-Lasting 10-Hour Operating Life from 8 AA Batteries (Voice)

(TOER520W) ........................................................................................ 62.00

with Head-Worn Microphone, 

69.96

VP3450 GoSpeak Duet  Ultra-Portable 
Wireless Personal PA System

  » 2x GoSpeak Duet Speakers
  » Handheld Wireless Microphone
  »  Lavalier Microphone 

and Transmitter
  » 2x Charging AC Adapters
  »  2x USB to Micro-USB 

Charging Cables
  » 2x USB/AC Plugs

(SMVP3450) ...................................................................................... 258.98

AN-Mini
Portable Speaker Monitor

  » Compact, Lightweight, and Portable
  » Powerful 4.5" Neodymium Driver
  » Built-In 30W Amplifier
  »  Dual Mic Inputs - One 1/4"  

and One 3.5mm Powered
  »  Mini Line Input for Connecting a 

CD Player, MP3 Player, or Instrument
  » Operates via AC Power or 10 AA Batteries

(ANANMINIBK) ................................................................................... 224.00

Lite-BP MiniVox Lite
Portable PA System

  » Battery Operated
  » Weighs under 3 Pounds
  » Neodymium Driver
  » Mic/Line Inputs
  » Soft Carrying Case
  » Wired Mic
  » Recharge Kit

(ANLITEBPB) ...................................................................................... 366.00

Weighs under 3 Pounds
Neodymium Driver
Mic/Line Inputs
Soft Carrying Case

ER-1000
Personal Public Address System

  » 6-Watt & 10-Watt Modes
  » Cover over 240' Distance in 6W Mode
  » Lightweight Waistband Design
  » Head-Worn Microphone
  » AUX Input
  » Easily Cover over 240'
  » Power: 6 AA Batteries

(TOER1000WR) .................................................................................. 223.00

MM-6S  Mighty Bull Horn 
Megaphone

  » Extremely Lightweight
  »  For Use Both Indoors 

and Outdoors
  » Built-In Siren
  »  Built-In Switch-Selectable  

Electronic Siren Alarm
  »  Reach the Masses up to a Half  

Mile Away with Crystal Clarity
(HAMM6S) ........................................................................................... 70.88

Dispatch
Mobile PA System with Bluetooth

  » 20W Peak Output
  » 5" Woofer » 1" Tweeter
  » Bluetooth: A2DP
  » Water Resistant: IPX4
  » Rechargeable Battery
  » Battery Life: 50 Hours
  » Recharge Time: 5.5 Hours
  » Includes Strap, Microphone, AUX Cable
  » Charging Adapter Included

(DEDISPATCH) ...................................................................................... 99.00

PMP57LIA
50W Megaphone with Siren, 

MP3 Player, and Remote Microphone

  »  1200-Yard Range » 50W of Output Power
  »  Siren Mode » Detachable  

Microphone with Coiled Cable
  » Built-In MP3 Player
  »  Plays Files from SD Cards  

and USB Drives » 3.5mm AUX Input Jack
  » Ergonomic Pistol Grip » Metal and ABS Construction

(PYPMP57LIA)...................................................................................... 63.00

MP-25 Megaphone with Siren,
MP3 Player & Microphone

  » 1500-Yard Audible Range
  » 25W of Output
  » Built-In Siren & Whistle
  » Built-In MP3 Player
  » Plays Files from SD Cards & USB
  »  Detachable Microphone with Coiled Cable
  » 3.5mm AUX Input » Includes Shoulder Strap

(POMP25) ............................................................................................ 59.95

ophone with Coiled Cable

S602MR Mity-Meg Plus
Megaphone with Detachable Microphone

  » Effective Range: 1760 yd / One Mile
  » Interchangeable Power Source
  » 25W of Output
  » Built-In Siren & Whistle
  » Battery Indicator Lights
  »  Weatherproof, Durable  

ABS Construction

(AMS602MR) ..................................................................................... 151.19

Interchangeable Power Source

HPA40
40W Handheld PA System

  » Convenient Battery and Shoulder Strap Compartment
  » Ultracompact » "Wireless Ready"
  » 5" Full-Range Loudspeaker
  » 8-Hour Rechargeable Battery
  » AC & Battery Operated 
  » Mic and Auxiliary Inputs
  »  Includes Microphone, Cable,  

Charger, and Mic Stand Adapter

(BEHPA40) ...........................................................................Call or Log-On

50W of Output Power

 Input Jack

PERSONAL PA SYSTEMS & MEGAPHONES

Handheld Wireless Microphone

PWMA50  Waistband
Portable PA System (Black)

  » Small Super Powerful Voice Amplifier
  »  Used by Teachers, Coaches, Tour  
Guides, Presenters, US Army

  » Projection Range up to 1/2 Mile
  » Includes Headset Microphone
  »  Built-In Rechargeable Lithium Batteries
  » AUX Input for MP3 Player or iPod » Charging Time: 6 Hours

(PYPWMA50B) ..................................................................................... 34.00
White (PYPWMA50W) ......................................................................... 28.84

Small Super Powerful Voice Amplifier
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XLS Series
DriveCore Stereo Power Amplifiers

  » Lightweight Rackmount Design
  » DriveCore Technology
  » XLR, 1/4”, and RCA Inputs
  » speakON and Binding Post Outputs
  » Integrated PureBand Crossover System
  » Individual Level Controls » Forced-Air Cooling Fans » LED Indicators

XLi 800
Stereo Power Amplifier

  » 300W per Channel at 4 Ohms
  » 200W per Channel at 8 Ohms
  » 600W at 8 Ohms Bridged Mono
  » Stereo/Parallel/Bridge-Mono Mode
  » User Selectable Input Sensitivity » Balanced RCA and XLR Inputs
  » Binding Post and speakON Outputs » Forced Air Cooling » LED Indicators
  » Short, No-Load, On/Off Thump Protection

(CRXLI800) ..........................................................................................................................................................269.00

CSMA 1120
Commercial Series Mixer/Amplifier

  » For Commercial and Industrial Use
  » 120W into 8- or 4-Ohm Loads
  » 15W per Channel
  » 4 Input Channels, 1 Output Channel
  » Usable with 70 & 100V Systems
  » Mic/Line & RCA Inputs
  » Hi-Z & 27V Phantom Power Switches
  » Sleep Mode & Auxiliary Output » Voice-Activated Ducking & Priority Mute

(JBCSMA1120) .....................................................................................................................................................599.00

PTA1000
250W Stereo Power Amplifier

  » Rackmount Design
  » Stereo and Bridged Modes
  » XLR and 1/4” Inputs
  » Dual-Speed Cooling Fans
  » speakON and Binding Post Outputs
  » Protection Circuitry » Selectable Operating Voltage
  » Individual Level Control Knobs and LED Indicators for Power, Signal, Clipping, Protection, and Volume

(PYPTA1000) .......................................................................................................................................................... 94.12

Pro-LITE Series
Power Amplifier

  » Automatic Clip Limiting
  »  2 Front-Panel Attenuators,  

Crossover Select Switch 
  » Inputs: Dual Combination 1/4” XLR
  » Outputs: Three speakON Connectors 
  » Temperature-Dependent Variable Speed Fan

SLA-4
Studio Linear Power Amplifier

  » 1RU Design » Multiple Operating Modes » Toroidal Transformer
  » 1/4" and Euroblock Inputs » Binding Post Outputs » Silent Cooling System

(ARSLA4) .............................................................................................................................................................409.00

GX Series
8-Ohm Power Amplifier

  » XLR, 1/4” , and Phono Inputs
  » speakON Combo Outputs
  » QSC GuardRail Protection
  » Ideal for Driving Subwoofers
  » Optimized for 4- and 8-Ohm Speakers » Subwoofer/Satellite Crossover Built In

GX3 300 Watt (QSGX3) ......................................................................................................................................349.99
GX5 500 Watt (QSGX5) ......................................................................................................................................449.99
GX7 725 Watt (QSGX7) ......................................................................................................................................649.99

PX8
Stereo Power Amplifier (800W at 8 Ohms)

  » 800W per Channel at 8 Ohms
  » Efficient Class-D Amplifier
  » Custom LSI Chip with PLL Technology
  » Digital Routing of Inputs & Outputs
  » XLR, 1/4", speakON & Binding Post
  » PEQ, Crossover, Filters, Delay
  » D-Contour Multiband Dynamic Processing

(YAPX8) ...............................................................................................................................................................699.99

NX4-6000
Lightweight 4-Channel 6000W Class-D Power Amplifier

  » 4x 440W at 8 Ohms (Peak)
  » High-Density Class-D Technology
  » Lightweight at 13.4 lb
  » Stereo and Bridged Modes
  » SmartSense Impedance Compensation
  » Stereo Crossover with Selectable Modes » 20 Hz to 20 kHz Frequency Response
  » Balanced XLR-1/4" Combo Inputs » Twist-Lock Output Connectors

(BENX46000) .......................................................................................................................................................499.99

XLi 1500 (CRXLI1500) .......................Call or Log-On XLi 2500 (CRXLI2500) ..................................... 449.00

Servo Series
Power Amplifier

  » 1/4" and RCA Input Connectors
  » 5-Way Binding Post and 1/4" Outputs
  » Dual Rack Space Design
  » 10-Segment, 3-Color Level LED Meters
  » Dual Variable Speed Cooling Fans
  » 4-Stage Power Protection Circuitry

SA120 60W/Channel (SASA120) .............. Call or Log-On SA200 100W/Channel (SASA200) ............ Call or Log-On
SA600 300W/Channel (SASA600) ..........................................................................................................................329.99

XLS 1002 350W/Channel (CRXLS1002)......... 339.00
XLS 1502 535W/Channel (CRXLS1502)......... 439.00

XLS 2002 375W/Channel (CRXLS2002)......... 549.00
XLS 2502 775W/Channel (CRXLS2502)......... 649.00 

Pro-LITE 3.0 830W (CRPL30A) ...................... 699.99
Pro-LITE 5.0 5000W (CRPL50A) .................1,075.00 Pro-LITE 7.5 7500W (CRPL75A) ................1,245.00
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ProFX16v2
Sound Reinforcement Mixer with Built-In FX

  » 16 Input Channels
  »  10 Low-Noise Mackie  
Vita Mic Preamps

  »  USB Recording to  
Computer (Mac & PC)

  » Dual 7-Band Graphic EQ
  » 16 FX Including Reverb, Delay & Chorus
  » Monitor & FX Sends, Stereo & FX Returns

(MAPROFX16V2) ................................................................................ 499.99

Dual 7-Band Graphic EQ
16 FX Including Reverb, Delay & Chorus
Monitor & FX Sends, Stereo & FX Returns

ProFX12v2
Sound Reinforcement Mixer with Built-In FX

  »  12 Input Channels » 6 Low-Noise  
Mackie Vita Mic Preamps

  » USB Recording to Computer 
  »  16 FX Including Reverb,  

Delay & Chorus
  » Per Channel  3-Band EQ
  » Monitor & FX Sends, Stereo & FX Returns » Hi-Z Input

(MAPROFX12V2) ................................................................................ 279.99

w-Noise  

Signature 12 MTK
12-Input Multi-Track Mixer with Effects

  »  12-Input Analog Mixer
  » 8 Ghost Mic Preamps
  »  Sapphyre British EQ  

per Channel
  » 14-In/12-Out USB Recording
  » Lexicon Effects Engine
  » Switchable Hi-Z Inputs
  » HPF & 48V on Mic Channels

(SOS12MTKME) ................................................................................. 499.00

14-In/12-Out USB Recording

PMP6000
20-Channel Powered Mixer

  » 1600 Watts
  » 12-Mono Line / Mic Channels
  » 4 Stereo Line Channels
  » 24-Bit Effects Processor
  » 7-Band Graphic EQ
  » Ultracompact Design
  » FBQ Feedback Detection

(BEPMP6000) ......................................................................Call or Log-On

12-Mono Line / Mic Channels

EMX-5
12-Input Powered Mixer

  » Integrated 1260 W Power Amplifier
  » 8 Mono Mic/Line Inputs
  » Four Stereo Inputs
  » Hi-Z Input on Channel 4
  »  Two AUX Sends  

with Dedicated Outputs
  » 3-Band EQ on Each Channel
  » Master EQ for Music Playback or Speech

(YAEMX5) ........................................................................................... 599.99

XR S   8-Channel Powered Mixer 
with Bluetooth (1000W)

  »  8-Channel Mixer » 1500W  
Peak / 1000W RMS Power

  »  Includes Onboard  
Digital Effects

  » Feedback Locating System
  »  Input Pads » For Use in Small- to  
Medium-Sized Venues » Bluetooth Connectivity for Playback

  » Outs for Subwoofers & Monitor Sends » Analog Recording

(PEXRS) ............................................................................................ 699.99

Integrated 1260 W Power Amplifier

or Use in Small- to  

PMX840BT Bluetooth 8-Channel 
800-Watt Powered Mixer w/MP3 

  »  USB 2.0 Port for MP3s with LCD Display
  »  Built-In Effects with  
Level Controls

  »  800 Watts of Power, 
8 Channels

  »  Plays MP3 & WMA Files 
from USB Devices

  » Stereo RCA Inputs & Outputs
(PYPMX840BT) ................................................................................... 127.20

Europower PMP500MP3  8-Channel
Powered Rackmount Mixer

  »  Built-In Amplifier: 2x 250W
  »  4 Mic/Line and 2 Stereo Ch.
  » +48V Phantom Power
  » 2-Band EQ per Channel
  » Music/Speech Switch for EQ
  » Auto Limiter Amplifier Protection
  »  Voice-Over-Priority Function » Studio-Grade  

Stereo Reverb » Wireless Ready » Mic Stand Adapter Included

(BEPMP500MP3) ............................................................................... 229.99

X Air XR12 12-Input Digital Mixer
for Tablets with Wi-Fi & USB Recorder

  »  Built-In Wi-Fi Module
  »  IOS, Android, Mac, PC, 

Linux Control
  »  Midas-Designed  

Mic Preamps
  » XLR Outputs »  X32 FX Rack with 4 Stereo FX Slots
  » USB Connectivity for Storage » Records Audio via USB

(BEXR12) ........................................................................................... 299.99
X Air XR16 16-Input Digital Mixer (BEXR16) ................................ 399.99
X Air XR18 18-Input Digital Mixer (BEXR18) ................................ 499.99

DFR22
Audio Processor

  » Digital Feedback Reducer, in Both Mono and Stereo Processors
  »  Automatic Gain Control  » 10- and 30-Band Graphic Equalizers
  » 3- to 10-Band Parametric Equalizers with Cut and Shelf Filters
  » Two-Way Crossover and Splitter  » Subwoofer Control
  » Gate/Downward Expander  » Mono and Stereo Compressor/Limiter

(SHDFR22) ........................................................................................ 625.00

DriveRack VENU360
3x6 Speaker Management System

  » dbx Compression & Limiting 
  » Advanced Feedback Suppression » Driver Alignment Delays
  » 31-Band Graphic EQ »  12-Band Parametric EQ 
  » Subharmonic Synthesis » Backline Delay » Noise Gate
  » Android, iOS, Mac & Windows Control

(DBVENU360) ..................................................................................... 869.00

DriveRack 260
Loudspeaker Management System

  » EQ, Filtering, Polarity, and Delay » Gain and Crossover Control
  »  Compression and PeakStopPlus Limiters » Graphic and Parametric 
Equalization » Feedback Elimination » Pink Noise Generator and 
Full-Time RTA » 2.7 Seconds of Alignment and Zone  
Delay » Built-In Subharmonic Synthesizer » Security Lockout

(DB260) ............................................................................................. 639.00

SHARK FBQ100
Automatic Feedback Destroyer

  » Delay Line, Noise Gate, and Compressor
  » Integrated Mic Preamp
  »  Destroys up to  

8 Frequencies
  » Balanced XLR and 1/4” I/O
  » Narrow FBQ Filters
  » Subsonic Filter

(BEFBQ100) ......................................................................................... 99.99

DriveRack PA2 Complete
Speaker Management System

  » Crossover for 2- or 3-Way Systems
  » Loudspeaker Management » Mac, PC, iOS & Android Control
  » AutoEQ Automatic Room EQ Function » Driver-Alignment Delay
  » Automatic Feedback Suppression » dbx Compression & Limiting
  » 8-Band Parametric EQ & Graphic EQ » Subharmonic Synthesis

(DBPA2)............................................................................................. 439.00

Auto Limiter Amplifier Protection
» Studio-Grade  

Europower PMP550M 5-Channel
Powered Rackmount Mixer

  »  2x 250W Built-In  
Class-D Amplifier

  »  7-Band Master  
Graphic EQ

  » 5 Mic & Line Inputs
  » 2-Band EQ per Channel
  » Feedback Detection Klark Teknik FX with 25 Presets
  » Wireless Ready » Rackmount Brackets Included

(BEPMP550M) ................................................................................... 199.99

2-Band EQ per Channel

SOUND REINFORCEMENT MIXERS & SYSTEM PROCESSORS
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MultiMix 10 Wireless 
Rackmount 10-Channel Mixer with Bluetooth
  »  One-Button Pairing for Bluetooth Input
  »  Four XLR Mic 
Inputs with 
Phantom Power

  »  2 Stereo Channels  
with 1/4" TRS Inputs

  » Front-Panel Stereo Mix Output » Stereo AUX Return
  » 60mm Faders on Each Channel » Pre- and Post-Fader AUX Sends

(ALMM10W).........................................................................Call or Log-On

MX41B
4-Channel Passive Mixer with Level Control

  »  Miniature Audio Mixer  
with 4 Stereo RCA Inputs  
and Stereo RCA Output

  »  Operate without the Need  
for Battery or External Power

  »  Level Control Dials for Each  
Channel Are Located on the Front

(ROMX41B) ..........................................................................Call or Log-On

MX622 
6-Channel Rackmount Mixer

  » 3 Mic/Line & 3 Stereo Line Inputs
  » Effects Loop with Stereo Return
  » 6-Channel Mixer in 1 Rack Space
  » Clip Indication LED Lights
  » Effects Loop with Independent Level Control

(ARMX622) ..........................................................................Call or Log-On

ZED14
14-Channel Recording and Live Sound 
Mixer with USB Connection

  »  USB Connection for  
Mac and PC

  » 14 Input Channels
  » 3-Band EQ Section
  » Four AUX Sends
  » Mono and Stereo Channels

(ALZED14).......................................................................................... 439.00
ZED-6FX Compact Analog Mixer (ALZED6FX) ................................ 199.00

RM82
8-Channel Mic and Line Mixer

  » 8 XLR Mic Inputs and Eight 1/4” Phone Line Inputs 
  » Line Inputs Function as Channel Inserts or Direct Outputs
  » Front Panel Features Level Tone, Trim and Master Level Controls 
  » Inserts Allow Loop Routing to External Processing Gear 
  » Microphone or Line-Level Output

(RORM82) ......................................................................................... 200.73

MultiMix 4 USB FX
4-Channel Mixer and  
USB Audio Interface
  »  XLR Mic & 1/4" Line Inputs
  » 1/4" Hi-Z Input
  » Stereo 1/4" Outputs
  » 16-Bit/48 kHz Resolution USB Interface
  » 15 Integrated DSP Effects
  » 2-Band Channel EQ » Multicolor LED Metering

(ALMULTIMIX4U) .................................................................................. 90.95
MultiMix 8 USB FX 8-Channel Mixer (ALMM8USBFX) .................. 129.99

MG10XU 
10-Input Mixer with Built-In FX and USB

  » "D-PRE" Mic Preamps with 48V Phantom
  » 2-In/2-Out USB up to 24-Bit / 192kHz
  » 4x Mic/Line Combo Inputs
  » 6x 1/4" Line Inputs
  » Built-In FX with 24 Presets
  » TRS Monitor Outs

(YAMG10XU) ...................................................................................... 199.99
MG10 10-Input (YAMG10) ..154.99MG06 6-Input (YAMG06) ...... 99.99

eamps with 48V Phantom
2-In/2-Out USB up to 24-Bit / 192kHz

199.99

SM10
10-Channel Rackmount Line Mixer

  » 1RU Metal Chassis » 1/4" and XLR Connectivity
  » Balance Controls » Mic Preamps with 48V Phantom Power
  » Each Channel has a Switchable Input Level
  » Headphone and Monitor Outputs
  » 6-Segment LED Meter » Internal Power Supply

(SASM10) .......................................................................................... 199.99

MM-242
4-/8-Channel Mono/Stereo Mini Mixer 

  » Compact Design
  » Heavy-Duty Steel Construction
  » Mono/Stereo Mode Selector
  » 8 x 1/4" Line Inputs
  » 2 x 1/4" A/B Outputs
  »  Individual and Master 

Volume Controls » Peak LEDs
  » Battery or External Power Options

(NAMM242) ......................................................................................... 27.64

RX1602
Rack-Mountable Line Mixer

  »  16-Channel Rack-Mountable Line Mixer with Balance and Level  
Control and +4/-10 Switching per Channel

  »  Delivers Quiet, Transparent Sonic Character Suitable for 
Professionals, While Delivering a Comprehensive Feature Set for 
Non-Professional Environments

(BERX1602) ....................................................................................... 149.99

eak LEDs

1642VLZ4

VLZ4 Series
12-, 14- & 16-Channel Mixers

  » The 1202 and 1402-VLZ3 Have 12 or 14 Balanced Line Inputs 
  » The 16-Channel Mixers Offer 16 Switchable Line Inputs 
  »  Super Quiet XDR2 (Extended Dynamic Range)  
Mic Preamps Deliver Studio-Grade Sound

  » All Except the 1202-VLZ3 Have 60mm Tapered Faders 
  » AUX Sends, Level, Pan and PFL Solo on Each Channel
  »  3-Band Active EQ (80Hz, 2.5kHz, 12kHz),  
Control Room/Phones Source Matrix

1604VLZ4 16-Channel 4-Bus Compact Mixer (MA1604VLZ4) ...... 999.99 
1642VLZ4 16-Channel 4-Bus Compact Mixer (MA1642VLZ4)  ..... 749.99
1202VLZ4 12-Channel Compact Mixer (MA1202VLZ4) ................. 299.99
1402VLZ4 14-Channel Compact Mixer (MA1402VLZ4) ................. 429.99

Q802USB

XENYX QX Series
Premium USB Audio Mixers

  » Premium Ultralow Noise, High Headroom Analog Mixers 
  » State-of-the-Art Xenyx Mic Preamps 
  » Studio-Grade Compressors with Easy One-Knob Functionality
  »  Neoclassic British 3-Band EQs
  » 2 State-of-the-Art Xenyx Mic Preamps
  » Built-In Stereo USB/Audio Interface

Q802USB 8-Input 2-Bus Mixer (BEQ802USB) ................................. 89.99
QX1202USB 10-Input 2-Bus Mixer (BEQX1002USB) ..................... 119.99
QX1202USB Premium 12-Input 2-Bus Mixer (BEQX1202USB) ... 129.99

EPM-12
Audio Console

  »  12 Mono & 2 Stereo  
Input Channels

  »  12x GB30 Microphone  
Preamplifiers

  » Compact Mobile Enclosure
  » Recording and Live Sound Audio Console

(SOEPM12) ........................................................................................ 369.00
EPM-8 8 Mono + 2 Stereo Audio Console (SOEPM8) ................... 279.00
PM-6 6 Mono + 2 Stereo Audio Console (SOEPM6) ..................... 249.00

EPM-12

Compact Mobile Enclosure

16-Bit/48 kHz Resolution USB Interface
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StudioLive AR8 USB
8-Channel Hybrid Performance  
and Recording Mixer

  » 2 Mono and 2 Stereo Channels
  » 8x4 24-Bit/96 kHz USB Interface
  » 4 Class-A Microphone Preamps
  » Two Instrument Inputs » 3-Band EQ
  » Wireless Bluetooth Streaming

(PRSLMAR8) ......................................399.95
AR12 USB 14-Channel (PRSLMAR12) ............................................ 499.95
AR16 USB 18-Channel (PRSLMAR16) ............................................ 599.95

StudioLive 16.0.2 USB
USB Performance & Recording Digital Mixer
  » 16 Total Input Channels
  » 18-Input & 16-Output USB Interface
  » 8 Mono Mic & Line Input Channels
  » 4 Stereo Line Channel Inputs
  » Compact Size
  » Twelve Class-A XMAX Mic Preamps
  » Two 2-Bit Digital Effects Processors
  » Full Dynamics Processing
  » iPad, iPhone, or Laptop Remote Control » Mac & Windows OS

(PRSL1602USB) ................................................................................. 999.00

UI Series   40-Input Digital 
Mixing Console and 32-In/32-Out USB Interface
  »  32 Mic Inputs » 8 XLR/1/4"  

Combi-Jacks for Instruments
  » DSP from Lexicon, dbx & BSS
  » 31 Output Busses with DSP & GEQ
  » 4-Band Parametric EQ on Ea. Channel
  » 8 VCAs + 8 Mute Groups
  » 26 Motorized Faders » 4 Customizable Fader Layers
  » 5" Touchscreen Display » 32x32 USB Audio Interface for Recording

(SO5056170)...................................................................................2,659.00

Ui24R  24-Channel 
Digital Mixer / Multi-Track USB Recorder

  »  Control via Tablet, 
Computer, or Smartphone

  »  Dual-Band Wi-Fi
  »  iOS, Android, Windows, 

Mac OS, and Linux
  » Remote-Controlled Studer Mic Preamps

Ui24R 24-Channel Digital Mixer / USB Recorder (SOUI24R)....1,099.00
Ui12 16-Input Remote-Controlled Digital Mixer (SOUI12) .......... 339.00
Ui16 16-Input Remote-Controlled Digital Mixer (SOUI16) .......... 449.00

StudioLive 16 Series III
Digital Mixer - Digital Console/Recorder

  » 17 Touch-Sensitive Motorized Faders
  » 16 Channels: 8 Mic and 8 Mic/Line
  » 16 FlexMixes: AUX, Subgroup, or Matrix
  » Comprehensive Updated Fat Channel
  » Four 32-Bit Stereo DSP FX Processors
  » Includes StudioLive AI Software Library
  » Mac, Windows & iPad Compatible
  » Full-Color Touchscreen

(PRSL16S3) ....................................................................................1,999.95

DL1608 
iPad-Controlled Digital  
Live Sound Mixer 

  » With Lightning Connector
  » Extensive DSP Built In
  » Integrated iPad Dock on Faceplate
  » iPad Mixing with Master Fader App
  » 16 Onyx Microphone Preamps
  » Optional Wireless iPad Operation
  » Snapshot Mix Total Recall » Support for Multiple iPads

(MADL1608LIGH) ................................................................................ 649.99

TouchMix-8  Compact Digital 
Mixer with Touchscreen

  » 12 Inputs » 8 Mic Preamps
  » Color Touchscreen
  »  Wireless Control via  

iPad App »  DSP Processing
  » Assignable Pitch Correction
  » USB Wi-Fi Adapter Included » Carrying Case Included

(QSTM8) ............................................................................................ 999.99
TouchMix-16 Compact Digital Mixer (QSTM16) ........................1,439.99
TouchMix-30 Pro 32-Ch., Compact Digital Mixer (QSTM30) ...2,099.99

8 Mic Preamps

DSP Processing

SQ-5
48-Channel / 36-Bus Digital Mixer

  » T16 Microphone Preamps
  » 7" Capacitive Touchscreen
  » 96 kHz FPGA Processing
  »  Eight Stereo FX Engines 
with Returns

  » 32 x 32 USB Audio Interface
  » AES Output    » 12 Stereo Mixes + LR

(ALAHSQ5) ......................................................................................2,999.00
SQ-6 with 24 Microphone Preamps (ALAHSQ6) .........................3,899.00

32 x 32 USB Audio Interface

TF Series
Digital Mixing Console

  » Touchscreen & 17 Motorized Faders
  »  16 Analog XLR/TRS Combo  

Mic/Line Inputs
  » RCA Pin Stereo Line Inputs
  » 16 Analog XLR Outputs
  » 2x2 Recording via USB Storage Device

(YATF1) ...........................................................................................1,999.99
TF3 Digital Mixing Console (YATF3) ............................................2,499.99
TF5 Digital Mixing Console (YATF5) ............................................2,999.99

Digital Mixing Console

Touchscreen & 17 Motorized Faders

2x2 Recording via USB Storage Device

31 Output Busses with DSP & GEQ
4-Band Parametric EQ on Ea. Channel

Qu-Series
Rack-Mountable Digital Mixer
  »  Chrome Knobs & Faders +  

Updated Firmware
  » Touchscreen Interface
  » Motorized 100mm Faders
  »  16x Mic/Line Inputs 

and 3x Stereo Inputs

(ALAHQU16C) ..................................................................................1,899.00
Qu-24C 30-In/24-Out Digital Mixer (ALAHQU24C) .....................2,599.00
Qu-32C 38-In/28-Out Digital Mixing Console (ALAHQU32C) ....3,399.00

ome Knobs & Faders +  

iPad-Controlled Digital 

ated iPad Dock on Faceplate
iPad Mixing with Master Fader App

Optional Wireless iPad Operation

DL16S  16-Channel 
Wireless Digital Live Sound Mixer

  »  Complete Wireless 
Control, Built-In Wi-Fi

  »  16 Mic Inputs with Onyx+ 
Recallable Pres

  » 8 Fully-Assignable XLR Outputs
  » 4-Band EQ, HPF & Dynamics on Each Input
  » 13 Output Busses with EQ & Alignment Delay
  » 31-Band Graphic EQ on Output Busses

(MADL16S) ........................................................................................ 769.99

M32R
Digital Mixing Console

  » 16 Midas PRO Microphone Preamplifiers
  » 40-Bit Float Point Internal Processing
  »  17 Midas PRO Motorized  

100 mm Faders
  » 8 Digital FX Engines
  » 25 Time-Aligned Mix Buses
  » Durable Aluminum & High-Impact Steel

(MIM32R) .......................................................................................2,495.00
M32C 40-Input Digital Rack Mixer (MIM32C) .............................. 800.00

MR12  12-Input Digital 
Mixer for iPad/Android Tablets with Wi-Fi 
and USB Recorder

  » Integrated Wi-Fi Module
  »  iOS, Android, Mac,  
Windows, Linux Control

  »  Midas Microphone Preamps
  » XLR Outputs » M32 FX Rack with 4 Stereo FX Slots
  » USB Connectivity for Storage » Records Audio via USB

(MIMR12) .......................................................................................... 450.00
MR18 18-Input Digital Mixer (MIMR18) ........................................ 880.00

16 Midas PRO Microphone Preamplifiers
40-Bit Float Point Internal Processing

O Motorized  

25 Time-Aligned Mix Buses
able Aluminum & High-Impact Steel

Mixer for iPad/Android Tablets with Wi-Fi 

DIGITAL MIXERS

X32 40-Channel,
25-Bus Digital Mixing Console

  »  Programmable MIDAS- 
Designed Mic Preamps

  » 6-Band Parametric EQs
  » Digital Snake Ready
  »  32x32 FireWire/USB 
Audio Interface Card

  » 40-Bit Floating-Point DSP » 7” Color TFT Display
  » Motorized Faders » Virtual FX

(BEX32) ..........................................................................................2,299.99

» 7” Color TFT Display

8 Fully-Assignable XLR Outputs

LiveTrak L-12  12-Channel 
Digital Mixer & Multi-Track Recorder

  » Built-In 14-Track SD Recorder
  »  USB Audio Interface  

(iOS Compatible)
  » 8 Mono Inputs + 2 Stereo Inputs
  » Channels 1-2 Offer Hi-Z Inputs
  » Phantom Power and -26 dB Pad » Eight Channels of Compression
  » Channel Strip with 3-Band EQ
  » Low-Cut Filter & 16 Digital Effects » 5 Headphone Outputs

(ZOZL12) ............................................................................................ 599.99

8 Mono Inputs + 2 Stereo Inputs
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SL-1210GR
Direct Drive Turntable System

  » Precision Coreless Direct Drive Motor
  » Eliminates Cogging
  »  Highly Rigid Platter  

with Low Vibration
  »  S-Shaped Tonearm  

with Counter Weight
  » No-Click Pitch Control
  » 33 1/3, 45, & 78 rpm Speeds » Cable Terminals: Phono & GND

(TESL1210GR) .................................................................................1,699.99

SL-1200MK7
Direct Drive Turntable System

  » Precision Coreless Direct Drive Motor
  » Eliminates Cogging
  » Reverse-Play Function
  »  Highly Rigid Platter 

with Low Vibration
  »  S-Shaped Tonearm with 

Counter Weight
  » No-Click Pitch Control + Pitch Reset

(TESL1200MK7) ................................................................................. 999.99

AT-LP120XUSB
       Stereo Turntable

  »  Plays 33 1/3, 45, 78 rpm 
Vinyl Records

  » Fully Manual Operation
  »  Built-In Switchable 
Phono Preamp

  » USB Output to Computer
  » Die-Cast Aluminum Platter

(AULP120XUSBB) ............................................................................... 249.00

M6
4-Channel USB DJ Mixer

  » 4-Channel Club-Style Mixer
  » LED Metering
  » 3-Band EQ per Channel
  »  Replaceable Crossfader  
with Slope Control

  » Class-Compliant USB Audio Interface
  » Microphone Channel with Dedicated EQ
  » Mac and Windows Compatible

(NUM6USBBLACK) ............................................................................. 169.00

4-Channel USB DJ Mixer

Class-Compliant USB Audio Interface
Microphone Channel with Dedicated EQ

indows Compatible

CDJ-2000NXS2  
High-Resolution Pro DJ Multi-Player
  » 24-Bit/96 kHz Compatibility
  » 7" Full-Color LCD Touchscreen
  » 8 Hot Cues
  »  Stream Audio over Wi-Fi  
from Smartphones

  » SD Card Slot & USB-A for Portable Media
  » CD/DVD Audio Player
  » Pro DJ Link LAN Connection

(PIDJ2000NXS2) ..................................................................Call or Log-On

CDJ-900 Nexus  
Professional Multi-Player
  » Full-Color LCD Screen
  » Wi-Fi and USB Connectivity
  » MP3, AAC, WAV, AIFF Compatibility
  » Beat Divide » Quantize
  » Slip Mode » MIDI/HID Control
  » Active Loop and Beat Loop
  » Includes Pioneer rekordbox Software
  » Professional-Quality DAC Processor

(PICDJ900NXS) ....................................................................Call or Log-On

DJM-S9  Professional 
2-Channel Battle Mixer for Serato DJ 

  » Two USB Serato-Certified Soundcards
  » 24-Bit / 48 kHz   » Filter FX
  » 16 Performance Pads
  » Magvel Fader Pro Crossfader
  » Automatic Beat Sync of Effects and Music
  » Sound Color and Beat Effects
  » Selectable Performance Effects
  » 3-Band EQ per Channel

(PIDJMS9) ......................................................................................1,699.00

DJM-900NXS2  
4-Channel Digital Pro DJ Mixer
  » 4 Phono Inputs and 4 Line Inputs
  » 4-Input / 4-Output USB Soundcard
  » 4-In / 1-Out Digital Coaxial
  » Sound Color, Beat & Frequency Effects
  » Independent Send / Return for External FX
  » Pro DJ Link Support » 96 kHz / 24-Bit
  » 3-Band Isolator EQ per Channel
  » Two Headphone Outputs 1/4" & 1/8" » Three USB Ports

(PIDJM900NXS2) ............................................................................2,199.00

PLX-1000  
Professional Turntable
  » User-Friendly Control Layout
  »  High-Torque Direct Drive  
Motor System

  »  Tempo Control with Variable  
Width Levels

  » Built to Reduce Vibration » Rubber Encased Tonearm
  » Adjustable Pitch Range: ±8%, ±16%, ±50%
  » Die-Cast Zinc Chassis » Detachable Audio and Power Cables

(PIPLX1000) ...................................................................................... 699.00

DJ Twelve
12" Vinyl Motorized DJ Control System

  » Traditional Turntable Layout
  »  Strip Search with 8 
Hot-Cue Triggers

  » High-Torque Motor
  » High Resolution: 3600 Ticks
  » 33 1/3 & 45 rpm Platter Speeds
  » Connects via USB to Seventy-Two Mixer
  » Pitch: 8/16/50%   » Motor-Off Switch for Wind-Down Effects

(RATWELVE) ....................................................................................... 799.00

Seventy-Two  2-Channel 
Performance Mixer with Touchscreen for 
Serato DJ Pro
  » 3 x MAG Contactless Faders
  » Reverse, Contour, and Cut-In
  »  4.3" Touchscreen » Dual FLEX FX  
Engines + Stacked Serato FX

  »  Dual Aluminum FX Paddles » Dual USB for  
DJ Handoffs » 2 x Rane Twelve USB Inputs

  » 2 x USB Cables » Includes Serato DVS, Control Vinyl & CDs

(RA2DPMTS) ...................................................................................1,899.00

MP2015  Rotary DJ Mixer

  » Premium Performance Audio Converters
  » Dual USB Ports for Easy Changeovers
  » 3-Band EQ for Each Channel
  » 3-Band Isolator for Master Bus
  »  Resonant Sweep Filters 
for Each Channel

  » Submix Channel with Filter, EQ, and Gain
  » Class-Compliant Mac OS X
  » High Performance ASIO Driver for Windows

(RAMP2015) ...................................................................................2,899.00

SC5000 Prime Professional DJ Media 
Player with 7" Multi-Touch Display

  » Dual-Deck Playback Engine
  » Separate Audio Outputs for Each Layer
  » Self-Contained Software Librarian
  » Three USB and One SD Card Reader
  » Digital Audio Outputs: 24-Bit/96 kHz
  » 7" High-Definition Multi-Touch Display
  » Eight Multifunction Trigger Pads
  » Plays FLAC, ALAC, WAV, MP3, and More

(DESC5000PRIM) ............................................................................... 999.00

VL12 Prime Professional Direct Drive 
Turntable with True Quartz Lock

  »  High-Torque: 5 kgf/cm
  » Isolated Direct Drive Motor System
  » Built-In RGB Platter Light
  » Isolation Feet Eliminate Feedback
  » S-Shaped Tonearm for Accurate Tracking
  » Adjustable Pitch Range: ±8, 16, 50%
  » 100mm Pitch Fader » Detachable Audio and Power Cables
  » Includes 45 rpm Adapter

(DEVL12PRIME) ................................................................................. 899.00

ect Drive Motor System

S-Shaped Tonearm for Accurate Tracking
djustable Pitch Range: ±8, 16, 50%

XONE:23
2+2 Channel DJ Mixer

  »  Xone Filter with Resonance Control
  » 3-Band Total Kill EQ
  » VCA Faders
  » Illuminated Switches
  » Crossfader Curve Selector
  » Balanced XLR Microphone Input
  »  9-Segment Signal Level Monitoring » Balanced XLR Master 

Outputs » Dedicated Monitor Output » External FX Loop

(ALXONE23) ....................................................................................... 369.00

one Filter with Resonance Control

SD Card Slot & USB-A for Portable Media

Sound Color, Beat & Frequency Effects
Independent Send / Return for External FX

96 kHz / 24-Bit

Professional Turntable

Connects via USB to Seventy-Two Mixer

Separate Audio Outputs for Each Layer

7" High-Definition Multi-Touch Display

Dual USB for 
2 x Rane Twelve USB Inputs

emium Performance Audio Converters
Dual USB Ports for Easy Changeovers

Submix Channel with Filter, EQ, and Gain

onearm with 

No-Click Pitch Control + Pitch Reset
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Mixtrack Pro 3 DJ Controller
for Serato DJ with Integrated Sound Card

  » All-in-One Serato Controller
  »  Integrated Audio  

Interface
  »  16x Multifunction  

Performance Pads
  »  Touch Strips for  

Dynamic FX Control
  » Dual 5” Hyper-Responsive Jog Wheels

(NUMIXTRAKPR3) .............................................................................. 199.00

TRAKTOR KONTROL Z1
DJ Mixing Interface

  » Two-Channel Tactile Mixer
  » 24-Bit/96kHz Converters
  » Low-Latency Headphone Cue
  »  Filter, Gain, 3-Band EQ, and  

Level Faders
  » Plug-and-Play with Mac/PC, iPad, iPhone
  » Includes TRAKTOR LE 2 Software

(NATRKNTRLZ1) ................................................................................. 219.00

Plug-and-Play with Mac/PC, iPad, iPhone

DDJ-SB3  
Portable 2-Channel Serato DJ Lite Controller
  » Serato  DJ Lite Software Included
  » Serato Flip Function
  »  Large Aluminum-Plated  
Jog Wheels

  »  Eight Performance  
Pads per Deck » iZotope-Powered Effects

  »  2-Channel Mixer » Deck Control: 4 Decks » Slip Mode for Smooth 
Transitions » Needle Search Pad » Adjustable Crossfader Curve

(PIDDJSB3) ........................................................................................ 249.00

DDJ-SX3  
Serato DJ Controller
  » Serato DJ Software Included
  »  3 Microphone Inputs  
with Effects

  » Large, Low-Latency Jog Wheels
  » Eight Performance Pads per Deck
  » Dual USB Ports + Two Headphone Outputs
  »  4-Channel Mixer with Sound Color FX » Slip Mode for Smoother 

Transitions » Needle Search Pad » Adjustable Crossfader Curve

(PIDDJSX3) .....................................................................................1,099.00

DDJ-WeGO4  
Digital DJ Controller
  » For Mac, PC, iPad, iPhone
  »  Jog Wheels Control  
Simultaneous Effects

  » Built-In Audio Interface
  » Pulse Control Multicolor LEDs
  » USB Bus Powered » Charges Connected iOS Devices
  » iPad/iPhone Stand » Includes rekordbox DJ Software
  » Includes Virtual DJ LE » USB and Power Cords Included

(PIDDJWEGO4K) ...................................................................Call or Log-On

DDJ-400  
Portable 2-Channel rekordbox DJ Controller
  » rekordbox DJ Software Included
  »  Mirrors NXS2 for Club  
Standard Layout

  » Aluminum-Plated Jog Wheels
  » Eight Performance Pads per Deck
  »  Sound Color and Beat FX » 2-Channel  

Bus-Powered Mixer » Integrated Sound Card
  » Hot Cue, Beat Loop, Beat Jump, Sampler » Includes USB Cable

(PIDDJ400) ..........................................................................Call or Log-On

MIXON 4
DJ Controller for Serato DJ

  »  24-Channel Hybrid  
DJ Controller

  »  Plug-and-Play for Serato DJ  
and djay Pro

  » 16 Color-Coded RGB Drum Pads
  » Slip and Loop Modes » Macro FX: Dynamic Effect Combo Control
  » Harmonic Mixing Capable » Large Aluminum Jog Wheels with LEDs
  » USB 2.0 Audio Interface » Compatible with Mac, PC, iOS, Android

(REMIXON4) ...................................................................................... 849.99

MC6000MK2 Professional
Digital Mixer and Controller

  »  4-Channel/8-Source  
Real-Time Matrix

  » Dual-Deck Functionality
  » Built-In 24-Bit Audio Interface
  » 8 Assign Keys for Effect Control
  » 14-Bit 100mm Long Pitch Slider
  » 105mm Touch-Sensitive Jog Wheels

(DEMC6000MK2) ................................................................................ 699.00

MC4000 Professional
2-Channel DJ Controller for Serato

  »  Professional  
2-Deck Controller

  » Two Microphone Inputs
  » Hot-Cue and Sample Pads
  » Touch-Sensitive Jog Wheels
  » 24-Bit/44.1 kHz Audio Interface
  » Echo and Ducking Effect for Microphones

(DEMC4000) ...................................................................................... 399.00

Party Mix 
DJ Controller with Built-In Light Show

  » Party DJ Control System
  » RCA Audio Outputs
  » Plug-and-Play
  » Sync Button
  »  Effects and  

Multiple Pad Modes
  » Looping and Sampling Capabilities
  » Includes Virtual DJ LE Software

(NUPARTYMIX) ..................................................................................... 99.00

Party DJ Control System

Looping and Sampling Capabilities
Includes Virtual DJ LE Software

DJ-808
4-Channel DJ Controller for Serato DJ

  » Includes 606, 707, 808 & 909 Sounds
  » TR-S Sequencer Controls Serato Sampler
  » Built-In VT Voice Transformer
  » 16 Velocity-Sensitive RGB Pads
  » Large, Low-Latency Platters
  » 24-Bit / 96 kHz
  » Professional Standalone Mixer
  » Includes Serato DJ and Pitch 'n Time

(RODJ808) ......................................................................................1,299.99

DJ-505
2-Channel, 4-Deck DJ Controller for Serato DJ
  » Two Channels, Two Low-Latency Platters
  » Deck Select for up to Four Decks
  »  8 x Dedicated Pad Controls  

for Serato DJ
  »  Serato Sampler and  

16-Step Sequencer
  » Built-In 24-Bit/48 kHz Audio
  »  Phono/Line RCA Inputs 
  » +1XLR, RCA, and 1/4" Outputs » MIDI Output and USB Port

(RODJ505) ......................................................................................... 599.99

16 Velocity-Sensitive RGB Pads

Professional Standalone Mixer
Includes Serato DJ and Pitch 'n Time

wo Channels, Two Low-Latency Platters
Deck Select for up to Four Decks

14-Bit 100mm Long Pitch Slider

Two Microphone Inputs
Hot-Cue and Sample Pads
Touch-Sensitive Jog Wheels
24-Bit/44.1 kHz Audio Interface

Serato  DJ Lite Software Included

iZotope-Powered Effects

ato DJ Software Included

Large, Low-Latency Jog Wheels
Eight Performance Pads per Deck
Dual USB Ports + Two Headphone Outputs

Digital DJ Controller

Pulse Control Multicolor LEDs

Xone:K2
Professional DJ MIDI Controller

  »  4-Channel 48kHz Internal Soundcard
  »  52 Hardware Controls
  » 171 MIDI Commands across 3 Layers
  » Configurable Layering System
  » USB Bus Powered
  » Headphone Output on Front
  »  X:LINK Interface to 

Xone:DB or More K2s
(ALXONEK2) ....................................................................................... 299.00

171 MIDI Commands across 3 Layers
Configurable Layering System

Software Included

Aluminum-Plated Jog Wheels
Eight Performance Pads per Deck

2-Channel 
Integrated Sound Card

DJ CONTROLLERS & INTERFACES

X1800 Prime  Professional 4-Channel 
DJ Club Mixer with Smart Hub

  » Four Phono/Line Inputs + Digital Inputs
  » Expressive EQ Mode: Classic or Isolation
  » Dual USB Audio Connections
  » BPM FX and Sweep FX
  »  Engine Connect for Beat-Grid 
Locked FX

  »  24-Bit/96 kHz
  » MIDI Output for Effects and Instruments

(DEX1800PRIME) ................................................................................999.00

SC5000 Prime  Professional DJ Media 
Player with 7" Multi-Touch Display

  » Dual-Deck Playback Engine
  » Separate Audio Outputs for Each Layer
  » Self-Contained Software Librarian
  » Three USB and One SD Card Reader
  »  Digital Audio Outputs: 
24-Bit/96 kHz

  » LAN Network Capable
  » 7" High-Definition Multi-Touch Display

(DESC5000PRIM) ................................................................................999.00

Separate Audio Outputs for Each Layer

Three USB and One SD Card Reader

7" High-Definition Multi-Touch Display



315www.BandH.com

PRO AUDIODJ CONTROLLERS & INTERFACES DJ HEADPHONES & CARTRIDGES

AT-HS1
        Universal Turntable Headshell

  »  Universal 1/2"  
Tonearm Mount

  »  Fits 4-Pin Turntable  
Cartridges

  »  Color-Coded 
Lead Wires

(AUATHS1) ........................................................................................... 25.24

Concorde MKII MIX
Twin Cartridges with Case

  »  Great Performance   » Durable
  » High-Quality Sound
  » Spherical Stylus
  » Reasonable Output
  » Improved Tracking Ability
  »  Includes Two Protection 

Guards, a Dust Brush, and a Flight Case

(ORCCPROSS) ...................................................................................... 99.99

Concorde MKII MIX
Single Cartridge

  »  Great Performance   » Durable
  » Transparent Sound Reproduction
  » High-Quality Sound
  » Spherical Stylus
  » Reasonable Output
  » Improved Tracking Ability
  » Includes Protection Guard

(ORMIXCCSNGL) ..................................................................................99.99

Omega
Elliptical Headshell-Mounted Cartridge
with Stylus

  »  Includes Cartridge  
and Stylus

  » Elliptical Cartridge
  » Headshell Mounted
  »  Archiving with  
USB Turntables

(OROMEGA) ......................................................................................... 36.99

DJ Headshell
for OM Series Cartridges (Black)

Ortofon Headshell will accomodate most 
DJ cartridges but is particularly 
useful for mounting the Ortofon 
OM series cartridges onto 
turntables. Black finish that 
complements their Nightclub, Nightclub II, 
and Pro S model cartridges.

(ORSH4BLACK) .................................................................................... 28.99

ZEROSTAT 3
Antistatic Gun

  » Reduces Static on Surfaces
  » For Removing Dust from Electronics
  » For Removing Dust from Vinyl and CDs
  » Squeezing Trigger Releases Positive Ions
  » Releasing Trigger Releases Negative Ions
  » No Batteries Required
  » No Refills Required   » No Radioactive Parts

(ZEZEROSTATAS) ..................................................................................71.00

Durable

Guards, a Dust Brush, and a Flight Case

VM520EB/H
Headshell and Cartridge Combo Kit with 
VM520EB and AT-HS10BK

  » Includes VM520EB Cartridge
  » Includes AT-HS10BK Headshell
  »  VM Dual Magnet for 

Matched Left & Right
  » Increased Channel Separation » Freq. Response: 20 Hz to 23 kHz
  » Lightweight Aluminum Headshell » Gold-Plated Lead Wires
  » Reduces Vibration » Precise Stylus Placement with Lift

(AUVM520EBH) .................................................................................. 159.00

AT85EP
Elliptical Phonograph Cartridge for 
P-Mount Turntables

  » 0.3 x 0.7 mil Elliptical Cartridge
  » Fits P-Mount Turntables
  »  Bonded Round Shank  

Construction
  » Aluminum Pipe Cantilever
  » 20 dB of Channel Separation
  » 20 Hz to 20 kHz Frequency Response

(AUAT85EP) ......................................................................................... 39.00

RHP-10
Mono DJ Headphone

  »  Professional  
One-Ear Assembly

  » Neodymium Driver: 50mm
  » Ergonomically Padded Handle
  » Water-Resistant Earpad » Swivel-Mounted Earcup
  » Detachable Cable » Max SPL: 109 dB
  » Artificial Leather Case

(RERHP10MONO) ................................................................................. 69.99

HPX2000 
High-Definition DJ Headphones

  » High-Definition Bass & Transparent Highs
  » Single-Sided, Oxygen-Free Copper Wire
  » Rugged, yet Comfortable Design
  » Rotating, Reversible Earcups
  » 40mm Cobalt Drivers
  » High Dynamic Range
  » Includes Adapter

(BEHPX2000) ............................................. 19.99

AT-VM95E
Dual Moving Magnet Cartridge

  » Low Distortion & High Channel Separation
  » Elliptical Stylus
  » High Output: 4.0 mV
  » Low-Resonance Housing
  »  Includes Threaded Inserts 
for Mounting

  » Interchangeable with Any AT-VMN95 Styli

(AUATVM95E)....................................................................................... 49.00

Low Distortion & High Channel Separation

Mono DJ Headphone

Neodymium Driver: 50mm

HDJ-X10  
Professional DJ Headphones
  » 50mm Dome-Type Drivers
  » Closed, Dynamic Earpads
  » 90° Rotatable Housing
  » Adjustable Headband
  » Folding Design
  »  2x Mini-XLR Cables: 

Coiled & Straight

Black (PIHDJX10K) ..........Log-On White (PIHDJX10S) ......... Log-On
HDJ-X7 Prof. Over-Ear DJ Headphones (Silver) (PIHDJX7S) ........ Log-On

HD8  
DJ Headphones
  » Designed for DJ Applications
  » Swiveling Earcups » 3 Wearing Positions
  » Based on HD 25 Headphones
  » Durable Design
  » Metal-Crafted Reinforcement Parts
  » Straight & Coiled Cables » 1/4" Adapter
  » Includes 2 Pairs of Ear Cushions
  » Includes Protective Case

(SEHD8DJ) ......................................................................................... 299.95

HDJ-X10 
Professional DJ Headphones

TMA-2
DJ Preset Modular Headphone

  »  For DJs and Live Performance
  »  Superb Audio Quality 
and Aesthetic Appeal

  » Dynamic 40mm Drivers
  »  Angled Stereo Plug 
for Secure Connection

  » 1/4" to 1/8" Adapter
  » Punchy, Intense, and Bass Focused

(AIDJPB) .......................................199.00

HD 25
Monitor Headphones

  »  Lightweight and Durable Design,  
Ideal for Professional Use

  »  Adjustable, Padded Headband  
Fits Virtually any Head Size

  »  Closed-Back Earcups and  
Thick On-Ear Cushions

(SEHD25MH) ...................................................................................... 149.95
HD 25 Light (SEHD25LH) .................................................................. 129.95
HD 25 Plus (SEHD25PH) .................................................................. 199.95

149.95

VM520EB and AT-HS10BK

Ortofon Headshell will accomodate most 
For Removing Dust from Electronics
For Removing Dust from Vinyl and CDs
Squeezing Trigger Releases Positive Ions
Releasing Trigger Releases Negative Ions
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For all DJ Lighting  
& Effects
 SCAN THIS
or visit BandH.com/w15333

Par 20
Aluminum Light Fixture (Black)

  » Black Aluminum Exterior
  » Standard Household Base
  »  Octagonal Gel Frame with  

Easy Secure Gel Frame  
Spring Clip 

  »  Includes AC Cord  
and 3.5" Hanging Yoke

(ODLSPAR20B) ..................................................................................... 19.03

PAR38
Spot with Lamp

  » 150W PAR Can
  »  Great Light for Mobile DJs, Live 

Performances & Installations
  » Supplied for Use with 120VAC
  »  Includes the Fixture, a Lamp,  

Power Cord & Gel Frame
  » Compact (7x7x6”) and Lightweight (2 lb)

(AMPAR38BL) ...................................................................................... 23.65

Compact (7x7x6”) and Lightweight (2 lb)

Mega Bar RGBA
42" Linear Fixture

  » Multicolored » Electronic Dimming: 0-100%
  » 6 Operating Modes » Built-In Microphone
  » 3-Pin DMX Connection » Power Cord Daisy Chain

Black  (AMMBRGBA) .......................................................................... 159.99
White  (AMMBRGBAW) ....................................................................... 199.00

Electro Swarm
LED Effect Light

  » Six Sound-Activated LEDs
  » Master/Slave Configuration
  » Stepper Motor
  » No Duty Cycle
  » Daisy-Chainable

(ELECTROSWARM) ...............................................................Call or Log-On

Rogue R3 Spot
LED Moving Head

  »  With Powercon Power Cord, 2-Omega  
Brackets, Control 3, and 5-Pin DMX

  »  Intense 300 W LED Light Engine  
for Punchy, Bold Beams

  » Zoom Angle of 13 to 37° 
  » Perfect Gobo Morphing
  »  Two Color Wheels with 7 Colors, Split  
Color Ability, and Continuous Variable Speed Scrolling

(CHROGUER3SPT) ...........................................................................2,649.99

UV LED BAR20
IR Backlight with UC IR Remote Control

  » 20 x 1W UV LEDs
  » 10° Vertical Beam Angle
  »  40° Horizontal Beam  

Angle » 50,000-Hour  
Long-Life LEDs

  » Three DMX Channel Modes
  »  Four Operating Modes » UV Strobe Effect
  » Electronic Dimming: 0-100% » Includes UC IR Remote

(AMLEDBAR20IR) ............................................................................... 319.99

Pocket Pro
Compact LED Moving Head

  » Bright White 25W LED Source
  » Compact and Lightweight (at 7.3 lb)
  » Gobo Wheel with 7 Replaceable Gobos
  » Kit of 4 Additional Gobos Included
  » Pan and Tilt Inversion Mode
  » Separate Color Wheel with 7 Colors
  »  4 Internal Show Modes + 

Sound Activation
(AMPOCKETPRO)................................................................................ 319.99

SlimPAR 56
LED PAR Can Lighting Effect

  » Slim 2.2” Profile
  » 108 Red, Green & Blue LEDs
  » 3- or 7-Channel DMX-512 Modes
  » Color Mixing with or without DMX
  »  Built-In Automated and  
Sound Activated Programs

  » Pulse Effect with Adjustable Speed

(CHSLIMPAR56) ................................................................................... 84.99

SlimPAR Pro QZ12
USB RGBA LED Wash Light

  » RGBA LED PAR for Bright Color Washes
  » Motorized Zoom: 10 to 50° Angle
  » 3 x DMX Channel Modes
  » D-Fi USB for Wireless Control
  » Built-In Automated Programs
  » 0-100% Dimming with Selectable Curves
  » Double-Bracket Yoke / Floor Stand
  » Universal Auto-Sensing Power Supply

(CHSLIMPRPRQZ) .............................................................................. 599.99

Prof. Colorado Panel Q40
with IP Powerkon Power Cord, 

Wash Filter, Omega Bracket

  »  Rugged RGBW LED Wash for  
Indoor/Outdoor Events

  » Superior Edge-to-Edge Color Mixing
  »  At Home in Any Weather Conditions  
with IP-Rated Power & DMX Connections

  » Included Magnetic Flood Filter for Wide Area Wash

(CHCLRDPNLQ40) ...........................................................................1,999.99

COLORstrip DMX
LED Linear Wash Light

  »  38" LED Source
  » 4-Channel DMX-512 LED Linear Wash Light
  » Blackout, Static or Constant On, Dimmer and Strobe Modes
  » Ideal for Backgrounds, Footlights, Wall

(CHCOLORSTRIP) ............................................................................... 169.99

LB-Par Hex
RGBAW+UV LED Light

  » 6-Color Mixing » 6 or 11 DMX Channels
  »  Automated and Sound-Activated  

Programs » Strobe Effects
  »  16-/32-Bit User Selectable  

Dimming Modes
  » 4-Button LED Control Panel
  » 3-Pin XLR In and Out
  » Dual Mounting Bracket Included

(BLPARQAUDHEX) ................. Call or Log-OnCall or Log-On

 » Multicolored » Electronic Dimming: 0-100%

Mega Hex Par
Compact RGBAW+UV LED Wash Light

  »  Low-Profile PAR for Wash/Uplighting
  » 5 x 6W RGBAW+UV LEDs, 25° Beam Angle
  » UV Glow, Variable Color Temperatures
  » DMX & AC Connectors Oriented Sideways
  » 5 x DMX Channel Modes
  » 5 x Operational Modes
  » 0-100% Dimming » Includes Adjustable Scissor Yoke
  » Includes UC IR Wireless Remote and Airstream IR App Transmitter

(AMMEGAHEXPAR) ...............................................................Call or Log-On

Mega Flash DMX
800W Strobe (120VAC)

  »  Bright 800-Watt Lamp ZB-800
  »  Adjustable Flash Rate  

and Intensity Rate
  » 1 to 15 Flashes/Second
  » Thermostat Protection
  » Large Coverage Area
  » Easy Lamp Replacement
  » Built-In Adjustable Hanging Yoke

(AMMFDMX) ........................................................................Call or Log-On

Three DMX Channel Modes

5 x 6W RGBAW+UV LEDs, 25° Beam Angle

C Connectors Oriented Sideways

Watt Lamp ZB-800

with IP-Rated Power & DMX Connections

DJ LIGHTING

DJ EZLink Strip Q6 BT
Wireless RGBA Linear Wash 

LED with Bluetoot

  »  RGBA Color Mixing, 
6 x 3W Quad LEDs

  »  Battery Runs 20 Hours 
(Single Color)

  » Bluetooth 4.2
  » 0 to 100% Dimming
  » 33° Beam Angle, 60° Field Angle

(CHEZLSTRQ6BT) ............................................................................... 239.99
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Fog Fury 2000   
1100W Fog Machine

  » High-Output Fogger
  » Anti-Clogging Technology
  » 8 Minute Warm-Up Time
  »  Yoke for Truss  
Mounting

  »  LED Heating  
Indicator

(AMFOGFUR2000) .............................................................................. 149.99

Hurricane 1200
Portable Fog Machine

  » Compact and Lightweight
  » Output: 18,000 cfm
  »  Heat-Up Time: 
2 Minutes

  »  Tank Capacity: 
0.26 Gallons

  » Wired 15' Controller
  » Optional Wireless Remote

(CHH1200) ...........................................................................Call or Log-On

HZ-500   
Hazer
  » Flightcase Design
  » Outputs 3000 ft³/Minute
  » Tank Capacity of 0.6 gal
  »  Low Fluid Consumption 
of 1.1 mL/Minute

  » Silent Operation
  » DMX-Compatible, 1 DMX Channel
  » Quickly Fills Larger Spaces with Fine, Translucent Haze

(ANHZ500) ......................................................................................1,680.00

Funfetti Shot
Confetti Launcher

  » For Entertainment Venues
  »  Works with Most  

Confetti Types
  »  Includes Wireless Transmitter  

& Receiver
  » Double Bracketed Yoke
  » DMX Compatible 

(CHFUNFETTSHT) ............................................................................... 349.99

Aqua
LED Lighting Fixture

  »  Bright Simulating Water Effect  
Powered by a 10W LED  
Light Source

  »  Can Be Projected onto a Wall,  
Ceiling, or on the Dance Floor

  » Offers 5 Colors + White
  » Safety Hook Ring for Securing Fixture
  » No Duty Cycle Required

(ELAQUALED) .......................................................................Call or Log-On

Gobo Projector IR

  » Bright 10W White LED
  »  Projects Custom Gobo  
Images on Surfaces

  »  Static or Slow Rotating  
Gobo Images

  » Optional IR Remote
  » Includes 4 Color Gels
  » Includes 4 Replaceable Gobos » Easy Gobo Replacement

(AMGOBPRJCTR)................................................................................ 179.99

Bubbletron
High-Powered Bubble Machine

  » Compact and Easy to Operate
  »  Front Load Fluid Intake 
& Dispenser

  »  Produces Hundreds of 
Bubbles per Minute

  » Large High Velocity Fan
  » Bubbles Shoot Rapidly into the Air
  » Wired On/Off Remote Switch

(AMBUBBLETRON) ............................................................................. 109.99

V-Hazer
Fog Machine

  » Professional Fog/Haze Machine
  »  Continuous Haze Output: 

0.9L/Hour
  » Fast Haze Speed
  »  Even Dispersion and 

Long Hang Time
  » DMX Controllable  » Holds 4-Liter Fluid Bottles
  » Dual-Stage Thermal Monitoring  » Link up to 4 Machines

(ROVH) ...........................................................................................1,329.05

EZ Gobo LED
Gobo Projector

  » Battery-Powered LED Gobo Projector
  » Projects a Custom Image Anywhere
  » Manual Zoom for Short or Long Throw
  » Includes 10 Wedding-Ready Gobos
  »  Magnetic Base Affixes to Most Metal  

Surfaces, No Need for Clamps
  » Scissor Clip with Eye Loop 

(CHEZGOBO) ...................................................................................... 189.99

Micro 3D II
Laser

  »  DJ and Nightclub Lighting Effect
  » 200 Green & Red Laser Beams
  » Auto or Sound Active Modes
  » Built-In Programs
  » Fan Cooled
  » UC Laser IR Remote Included
  » Airstream IR Transmitter Included
  » Includes Dual Hanging Bracket

(AMMICRO3DII) .................................................................................... 94.99

Scorpion Dual-Beam
Laser Fixture

  » For Events with Fog or Haze Effects
  » 32 Built-In Patterns
  »  Programmable Pan, Tilt, 

and Zoom Effects
  » Scan Speed Adjustment
  » Manual or Sound-Activated Mode
  » Wireless Control with Included IR Remote
  » Hanging Bracket with Mounting Hardware

(CHSCORPIONDL) ............................................................................... 159.99

Kinta FX  LED Derby, Laser 
and SMD Strobe Fixture

  » RGBW LED Derby Effect
  » Red and Green Laser Beams & Patterns
  » White SMD LED Strobe Lights
  » Coverage Angle of 118°
  »  Sound-Activated and Automated  
Programs  » Laser Rotation FX

  » DMX or Standalone Operation
  » 2x DMX Channel Modes  » Hanging Bracket

(CHKINTAFX) ...................................................................................... 159.99

AF-3
Antari Fan

  » 4 x Control Options
  » Low Power Consumption
  » DMX and Local Control
  » Metal Housing
  »  Adjustable Mounting  

/ Floor Bracket

(ELAF3) ............................................................................................. 412.00

Antari Fan

DMX-Compatible, 1 DMX Channel

Professional Fog/Haze Machine

Safety Hook Ring for Securing Fixture

VF Flurry
Snow Machine

  »  Spray Distance:  
6.5 - 16.4'

  » 33.8oz Fluid Tank
  » Low Fluid Sensor
  » Wired Remote
  »  Uses Water-Based 

Fluid

(AMVFFLURRY) .................................................................................. 129.99

M-1212
12" Glass Mirror Ball

  »  With 100s of Reflective  
Mini Panels

  »  Brilliantly Reflects White 
or Colored Light

  » Motor Loop on Top
  »  For Clubs, Weddings, 

and Private Events

(AMM1212) .......................................................................................... 29.95
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PDIC51RD 5.25" In-Wall/
In-Ceiling 150W 2-Way Stereo 

Speakers (Pair, White)
  » Mounts Flush on Walls or Ceilings
  » For In-Wall, In-Ceiling Systems
  » 150W Peak Power
  » 80 Hz to 20 kHz Frequency Response
  » 2 x 5.25" Speakers
  » Convenient Speaker Terminals
  » Stain-Resistant Grilles

(PYPDIC51RD) ...................................................................................... 29.65

To view a full listing of all 
Installation Sound
 SCAN THIS
or visit BandH.com/w15329

PTA4  Mini 2 x 120-Watt 
Stereo Power Amplifier

  »  2 x 120 -Watt 10% 
RMS Speaker Output

  »  Blue LED Output 
Level Display

  » Power on LED Indicator » 3.5mm AUx CD/MP3 Input Jack
  » 1/4" Phone Jack » Master Volume Control
  » Balance Control » Bass and Treble Tone Controls
  » Switchable AUX1/AUX2/CD and RCA Input

(PYPTA4) ............................................................................................. 63.26

DN-333XAB 
Bluetooth-Enabled Mixer Amplifier (2 RU)

  »  Six-Source Mixer » Bluetooth-Enabled » 120W Class-D 
Amplifier » XLR and 1/4" Mic Inputs, RCA Line Inputs

  » 1/8" (3.5mm) Stereo AUX Input » RCA and Euroblock Outputs
  » Input and Output Level Controls » Bass and Treble Controls
  » Built-In Limiter » Multiple LED Indicators

(DEDN333XAB) ................................................................................... 299.00

135MA
35W Commercial Mixer/Amplifier

  » 3 Inputs, 1 Output 
  »  Phoenix and RCA 

inputs
  » Telephone Output
  »  VOX or Switch  

Priority Muting
  »  Bass and Treble Controls

(CR135MA) ........................................................................................ 199.00
160MA 60W Commercial Mixer/Amplifier (CR160MA) ................. 319.00

C100 Classic Series
Public Address Amplifier (100W)

  » Output for Tape Recorder or Booster Amp
  »  Thermal Protection  
and Electronic  
Shutdown

  » 4 Inputs
  » AUX Muting
  » Telephone Input

(BOC100) ........................................................................................... 359.00

Thermal Protection 

SPT15A
Reentrant Horn Loudspeaker  
7.5W 25/70V

  »  Weatherproof,  
All-Metal Construction

  »  Built-In Rotary  
Impendace Selector

  » Easy to Install and Maintain

(BOSPT15A) ......................................................................................... 89.95

FP6020-II
20" Dome and Dual Parabolic 
Replacement Speaker Kit

  »  FP6020-II Sound 
Focusing Speaker

  »  20" Dome for 
Sound-Focusing Speaker

  »  Twin 1" Concave Aluminum 
High-Excursion Drivers In Individually Sealed Compartments 

(SOFP602020DK) ............................................................................... 516.95

SD72W
Dual-Cone Ceiling Speaker 

with Baffle (White)

  »  Dual-Cone Speaker
  »  4W 70.7/25V  

Transformer
  » CRS Baffle 

(ATSD72W) .......................................................................................... 27.99

Control 24CTM  Two-Way Vented Ceiling 
Speaker in Low Ceiling Venues - Pair 

  » 30-Watt Power Capability
  »  8W Multi-Tap Transformer for  
70V and 100V Systems

  »  4 1/2" Woofer, Injection-Molded  
Graphite Cone with Butyl Rubber Surround

  » Extremely Wide 150° Coverage
  » Shallow 4" Depth
  » 1/2" Polycarbonate Tweeter for Extended Response

Pair (JBC24CTM) ................................................................................ 148.00

EVID-6.2T
2-Way 300-Watt Installation Speaker

  »  Rugged Surface-Mount Weather-Resistant  
Installation Monitor in Black Finish

  » Equipped with 70V/100V Transformer
  »  Dual 6" Woofers with 
Magnetic Shielding

  » Use with Video and Computer Monitors
  » 1" Coherent Coverage Waveguide Horn Tweeter
  » Titanium Dome Tweeter with Neodymium Magnets

(ELE62) ............................................................................................. 449.00

CE500A 
Multipurpose Speaker

  » 80W Internal Amplifier
  » 5.5" Woofer and 0.5" Tweeter
  » Integrated Limiter
  » XLR Mic/Line Input
  » XLR Link/Output Connector
  » RCA Line Input
  » Mounting Hardware Included

(BECE500ABK) ................................................................................... 129.99

Reentrant Horn Loudspeaker 
Replacement Speaker Kit

SCM268
4-Channel Microphone Mixer 

  »  For Sound Reinforcement » Rack-Mountable
  » Compact Design » 4 XLR Mic Inputs » 4 RCA Inputs
  » XLR Output » AUX RCA Phono Output
  » Supplies 12V Phantom Power » Low Noise Floor

(SHSCM268) ...................................................................................... 267.98

IA1200
Integrated Amplifier with USB & SD Inputs

  »  RCA, USB, SD, 
AUX Inputs

  »  Push-Button 
and RCA Outputs

  » 1200W Peak Power » SD Card Size up to 32GB
  » Play MP3 Files » iPod Playback through USB Input
  » Record from AUX / RCA Inputs » Repeat / Random Playback
  »  Bass, Treble & Balance Controls

(TEIA1200) ...........................................................................Call or Log-On

and RCA Outputs

ugged Surface-Mount Weather-Resistant 

1" Coherent Coverage Waveguide Horn Tweeter

Graphite Cone with Butyl Rubber Surround

INSTALLATION SOUND

Control 1 Pro
Professional Compact Loudspeaker

  » Compact Two-Way Speaker System 
  »  Magnetically Shielded for Safe 

Use near Computer Monitors 
  » Full Frequency Response
  » 5” Woofer & 0.75” Tweeter
  » Sonicguard Protection Circuitry
  » Perfect for Video Editing or DAW Use

Pair - White (JBC1PROW) ................................................................ 164.00

LCT 81C/T  2 x 2' Low-Profile Lay-In 
Ceiling Tile Loudspeaker (Pair)

  » High Efficiency 8"Dual-Cone Driver
  » Perforated Metal Grille
  »  20 Watts at 8Ω  
(Low Impedance) 
Direct Setting

  »  10-Watt Multi-Tap 
at 70V/100V

  » Very Low Profile at Just 4.1" Deep » 96 dB Sensitivity
(JBLCT81CT) ...................................................................................... 208.00

Perforated Metal Grille
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For In-Line Problem Solvers 
& Accessories

SCAN THIS
or visit BandH.com/w15336

Cloudlifter CL-1
Mic Activator

  »  Mic Input » Improves Signal- 
to-Noise Ratio » Use with  
Passive Dynamic & Ribbon Mics

  » +25 dB of Clean, Transparent Gain
  » Requires Only Phantom Power to Operate
  » Ideal for Long Cable Runs » Use with Low-Output Mics

(CLCL1) ............................................................................................. 149.00

TM

IMA-1030 Switchable
In-Line Attenuator

  » Provides -10, -20, or -30 dB of Attenuation
  »  For Use with All Low-Impedance &  
Phantom-Powered Condenser Mics

  » XLR Female to XLR Male
  » Shielded Metal Case to Prevent Interference

(PEIMA1030).....................................................................24.99

IMP 2
Single-Channel Direct Box

  » Passive Design
  » Designed for Both PA & Studio Use
  » 1/4” Parallel Wired In / Out Jacks
  »  Uses Whirlwind’s TRHL-M Transformer 
with Metal Shield

  » Ground Lift Switches Help Eliminate Hum & Buzz » Rugged Build
(WHIMP2)............................................................................Call or Log-On

SP1X2  1x2 Mic Splitter
  »  Provides One Direct and Transformer 
Isolated Outputs from a Mic 
Level Input

  »  Transformer Isolated Output  
Features a Ground Lift Switch

  » Operating Level: -0.5dB to +4dB 
  » Frequency Response: 20Hz-20kHz ± 0.63dB

(WHSP1X2) ..........................................................................Call or Log-On

Patch Box II  Analog Stereo Output 
Multiplier and Signal Converter

  » Balanced 1/4" Inputs
  » XLR, 1/4", and RCA Outputs
  » Passive Design
  »  Pair of Balanced Stereo Inputs 

That Feed 12 Stereo Outputs
  » Balanced to Unbalanced Conversion

(HEPB2) ............................................................................................ 135.00

Micmute PT
Push-to-Talk Switch (Pedal)

  » Convenient Pedal Design
  » Metal Housing

(WHMICMUTEPT) .................................................................Call or Log-On

QBOX Audio Line 
Tester/Cable Tester/Test Tone Generator 
  »  Send a Tone or the Signal from  

the Built-In Condenser Mic
  »  Confirm Incoming Signals  

at Mic Level
  » Built-In Amplifier
  » XLR or 1/4" Outputs

(WHQB) ..........................................Call or Log-On

Push-to-Talk Switch (Pedal)
PB223 Mic Power II

Dual 48V Phantom Power Supply

  »  Input Connectors:  
2x 3-Pin XLR Female

  »  Output Connectors:  
2x 3-Pin XLR Male

(ROPB223) .......................................................................................... 56.00

DI400P  Ultra-DI Passive 
Direct Injection Box

  »  Allows for Connecting a Electric Guitar  
or Bass Directly into a Mixer  
without Losing Tone

  »  Converts Any Unbalanced Line-Level  
Signal to Balanced Mic-Level Output

  » Ultracompact, All-Metal, and Road-Suitable Housing
(BEDI400P) .......................................................................................... 19.99

CT-100
Cable Tester

  »  Features 3 Modes: 
Cable and Installed Cable 
Test plus Test Tone Mode

  »  Accepts All Standard Connectors: 
XLR, TRS (1/4", 1/8", TT), RCA, and MIDI

  » Super Easy Operation with Intuitive LED Display
(BECT100) ............................................................................................29.99

SDI-APC3  Stereo Multimedia 
Active Direct Box

  »  Connect Instruments to Mic Inputs; 
PC, Tablet, DJ Mixer to XLR Ins

  »  Convert High Impedance 
to Low Impedance

  » Isolated Transformers & Aluminum Housing
  » Active Circuitry for Low-Level Signals

(KOPDI40) ............................................................................................24.99

CBT-MF Multifunction Cable 
Tester with Dual Chassis

  » Tests 11 Connector Types
  »  Detachable Chassis for 
Long Cable Runs

  » Integrated Test Tone Generator
  » Simple & Convenient Operation
  » XLR, TRS, Speakon, RJ45, RCA, BNC & More

(KOCBT12) ........................................................................................... 49.95

MicMute MM11 PRO
Microphone Mute Switch

  »  Switchable Push-to-Talk or  
Push-to-Mute Function

  » Passes Phantom Power
  » Lowers the Mic Signal about 60 dB
  » 0.09" (0.23 cm) Steel Chassis
  » 2 Balanced XLR Jacks, a Single Female Input

(ROMM11PRO)..................................................................................... 44.00

DSM-1X
Digital SPL Meter
  » Easy-to-Read 4-Digit LCD Display
  » 4 Ranges Measuring between 30 and 130 dB
  » 32 to 8000 Hz Response
  » Max, Min, and Instantaneous Data Hold
  » Automatic Out-of-Range Detection
  » Internal Battery Tester

(NADSM1X)............................................................... 74.99

LSP-1 Laptop SoundPort
3.5mm Stereo Mini Male  
to 3-Pin XLR Male  
In-Line Adapter
  »  Volume Control of Outgoing  
Stereo Signal

  »  3.5mm Male Input and  
XLR Male Output

(DSLSP1) ............................................................................................. 80.00

3.5mm Stereo Mini Male 

CM-130 Check Mate
SPL Meter

  » Lightweight, Miniature with 0.1dB Resolution
  » Built-in Electret Condenser Microphone with Windscreen
  »  Large Backlit Level Range Display with Low, Medium,  
and High Level Readouts » AC Signal Output

(GACM130) .......................................................................59.99
CM-140 Check Mate (GACM140)................................129.99 

HE-2-XLR
Dual-Channel Hum Eliminator

  » Eliminates AC Hum
  » Breaks Ground Loops
  » 1/4" TRS and XLR Connectors
  » Audiophile Quality Components 
  »  Converts Automatically between  

Balanced and Unbalanced Lines 

(EBHE2XLR) ......................................................................................... 93.00

NA3MM   XLR Male to  
XLR Male Adapter

  »  Die-Cast Exterior Housing  
Protects Terminations

  »  Latch Lock Connectors 
Prevent Cables from Being 
Accidentally Disconnected

  » Compact Space-Saving Design
(NENA3MM) ............................................................................................9.22

Shielded Metal Case to Prevent Interference

.....................................................................24.99 9.22

Cloudlifter CL-1

Requires Only Phantom Power to Operate

Direct Injection Box
ws for Connecting a Electric Guitar  

erts Any Unbalanced Line-Level  

Tester with Dual Chassis

Integrated Test Tone Generator
Simple & Convenient Operation XLR, TRS (1/4", 1/8", TT), RCA, and MIDI

Isolated Transformers & Aluminum Housing
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PROFESSIONAL AUDIO CABLES

DIGITAL AUDIO CONNECTORS

Connector AES/EBU (3-Pin XLR Connector) S/PDIF RCA (RCA or JIS F05 Connector) TOSLINK (JIS F05 Connector) TOSLINK Mini (3.5 mm Connector) ADAT Optical (JIS F05 Connector)
Cable 2-Conductor + Ground Coaxial or Fiber Optic Fiber Optic Fiber Optic Fiber Optic
Signal Stereo Stereo Stereo Stereo 8-Channel

Basic 
Application

Standard connection for professional 
digital audio. Two-channel or left / right

Typically used in professional and 
consumer level audio devices. 

Two-channel or left / right

Based on S/PDIF protocol utilizing optical 
fiber cable for digital audio. 
Two-channel or left / right

Based on S/PDIF protocol utilizing optical fiber 
connector for digital audio. Used on compact 

devices. Two-channel or left / right

Typically used in professional audio 
applications for transfering or receiving 

8 channels of audio

UNBALANCED AUDIO CONNECTORS

Connector 1/4” TS 1/8” TS RCA Sub-Mini
Cable 1-Conductor + Ground 1-Conductor + Ground 1-Conductor + Ground 1-Conductor + Ground
Signal Unbalanced Unbalanced Unbalanced Unbalanced

Basic 
Application

Unbalanced signal, typically used for instruments 
such as guitars, bass, and synthsizers

Unbalanced signal, typically used in smaller modular 
sythesizer formats such as eurorack

Unbalanced signals, typically used in professional DJ 
equipment and consumer home audio Typcially used in compact electronic devices

SPEAKER CABLE CONNECTORS

Connector speakON 1/4” TS Banana
Cable 2-, 4-, 8-Conductor 2-Conductor 2-Conductor
Signal Unbalanced Unbalanced Unbalanced

Basic 
Application

Standard pro audio speaker cable.  NL-2 is typical single speaker 
input. NL-4 is typically used for bi-amped speakers. NL-8 is 

typically used for tri-amped 3-way speakers.
Single speaker cable Audiophile and prosumer 

single speaker cable

BALANCED AUDIO CONNECTORS

Connector XLR 3-Pin 1/4” TRS 1/8” TRS 1/8” TRRS TT or Bantam DB25
Cable 2-Conductor + Ground 2-Conductor + Ground 2-Conductor + Ground 3-Conductor + Ground 2-Conductor + Ground 8x 2-Conductor + Ground
Signal Balanced Balanced Balanced Balanced Balanced Balanced

Basic 
Application

Balanced microphone and 
line-level signals

Balanced line-level signals or 
unbalanced stereo signals

Balanced line-level signals or 
unbalanced stereo signals

Typically used for cell phones. 
Balanced stereo signal 

with a microphone

Balanced line or mic level, typically 
used with pro audio patchbays for 

recording or broadcast studios

Balanced line or microphone level, 
typically used in pro audio 

for multichannel audio equipment

Choosing Audio Cables
Whether you are looking to run cable in your professional studio or simply to get 
your home theater set up, B&H’s cable selection runs the gamut to cater to your 
needs. With cabling solutions including 3-pin XLRs, 1/4” TRS and instrument, 
1/8” stereo, DB25 connectors, RCA, speakON, and a variety of digital audio cables such 
as AES/EBU, TOSLINK, and more, B&H has your audio cabling needs covered. To find 
the exact cable you need, log on to: www.BandH.com/CableFinder/ProAudio.

SCAN
THIS

CODE

To view a full listing 
of all Pro Audio Cables

or visit our website
BandH.com/w15337

www.BandH.c
om/CableFinder/

ProAudio




